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About This Book

Use of Warning, Caution, Information, and Tip Icons
This publication includes Warning, Caution, and Information where appropriate 
to point out safety related or other important information. It also includes Tip to 
point out useful hints to the reader. The corresponding symbols should be 
interpreted as follows:

Although Warning hazards are related to personal injury, and Caution hazards are 
associated with equipment or property damage, it should be understood that 
operation of damaged equipment could, under certain operational conditions, result 
in degraded process performance leading to personal injury or death. Therefore, 
comply fully with all Warning and Caution notices.

Electrical warning icon indicates the presence of a hazard which could result in 
electrical shock.

Warning icon indicates the presence of a hazard which could result in personal 
injury.

Caution icon indicates important information or warning related to the concept 
discussed in the text. It might indicate the presence of a hazard which could 
result in corruption of software or damage to equipment/property.

Information icon alerts the reader to pertinent facts and conditions.

Tip icon indicates advice on, for example, how to design your project or how to 
use a certain function



Typographic Conventions   About This Book
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Typographic Conventions
All text entries, shortcuts, prompts, system messages, menu items, screen elements 
etc. comply with the Microsoft Windows conventions.

Document Conventions
The following conventions are used for the presentation of material:

• The words in names of screen elements (for example, the title in the title bar of 
a window, the label for a field of a dialog box) are initially capitalized.

• Capital letters are used for the name of a keyboard key if it is labeled on the 
keyboard. For example, press the ENTER key.

• Lowercase letters are used for the name of a keyboard key that is not labeled on 
the keyboard. For example, the space bar, comma key, and so on.

• Press CTRL+C indicates that you must hold down the CTRL key while 
pressing the C key (to copy a selected object in this case).

• Press ESC E C indicates that you press and release each key in sequence (to 
copy a selected object in this case).

• The names of push and toggle buttons are boldfaced. For example, click OK.

• The names of menus and menu items are boldfaced. For example, the File 
menu.

– The following convention is used for menu operations: MenuName > 
MenuItem > CascadedMenuItem. For example: select File > New > Type.

– The Start menu name always refers to the Start menu on the Windows 
Task Bar.

• System prompts/messages are shown in the Courier font, and user 
responses/input are in the boldfaced Courier font. For example, if you enter a 
value out of range, the following message is displayed:

Entered value is not valid.The value must be 0to30. 



  About This Book Terminology
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You may be told to enter the string TIC132 in a field. The string is shown as follows 
in the procedure:

 TIC132

Variables are shown using lowercase letters.

sequence name

Terminology
You will find a complete and comprehensive glossary at the end of the Engineering 
Manual System Configuration. This glossary contains terms and abbreviations 
that are unique to ABB or have a usage or definition that is different from standard 
industry usage. Please make yourself familiar with this glossary.

Related Documentation
The following list gives an overview of the documentation relating to the Freelance 
system.

Title Number

Mounting and Installation Instructions, Control IT, AC 800F 3BDD012501Rxxxx

Mounting and Installation Instructions, Control IT, AC 700F 2PAA103858Rxxxx

Mounting and Installation Instructions, Rack-System 3BDD012603Rxxxx

DigiVis, Operators Manual, Operator Station, Conventional Design 3BDD012600Rxxxx

DigiVis, Operators Manual, Operator Station, New Design 3BDD011932Rxxxx

DigiBrowse, Operators Manual 3BDD012601Rxxxx

New Features History 3BDD011933Rxxxx

Engineering Manual, System Configuration 3BDD012503Rxxxx

Engineering Manual, DigiVis Operator Station Configuration 3BDD012518Rxxxx

Engineering Manual, Process Station - AC 800F 3BDD012505Rxxxx
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Engineering Manual, Process Station - AC 700F 2PAA103857Rxxxx 

Engineering Manual, Process-Station - Rack System 3BDD012520Rxxxx

Engineering Manual, S700 Modules 2PAA105800Rxxxx

Engineering Manual, OPC server F 3BDD012511Rxxxx

Engineering Manual, Trend Server 3BDD012527Rxxxx

Engineering Manual, IEC 61131-3 Programming 3BDD012504Rxxxx

Engineering Manual, Integration Process Portal B 3BDD012521Rxxxx

Engineering Manual, User Access 3BDD012513Rxxxx

Engineering Reference Manual, Functions and Function Blocks 3BDD012514Rxxxx

Engineering Reference Manual, Communication and Fieldbusses 3BDD012515Rxxxx

Engineering Reference Manual, Protronic Remote Control 3BDD012506Rxxxx

Engineering Reference Manual, DDE32 3BDD012507Rxxxx

Engineering Reference Manual, IEC 60870-5 Telecontrol Library 3BDD012509Rxxxx

Engineering Reference Manual, Interbus Blocks 3BDD012510Rxxxx

Engineering Reference Manual, Coupling Sartorius Scales 3BDD012512Rxxxx

Engineering Reference Manual, DMS / API 3BDD012508Rxxxx

Engineering Manual, Freelance Bulk Data Manager 2PAA105801Rxxxx

Title Number
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Section 1  Licensing

Introduction
The licensing for Freelance V9.2 SP1 is based on the existing I/O based licensing 
model. 

Control Builder F
Control Builder F is the programming tool for AC 800F, AC 700F and the classic 
rack-based controllers like DCP02 and DCP10. The engineering of the operating 
console is part of Control Builder F.

The following Control Builder F packages are available:

• Control Builder F Standard

• Control Builder F Professional

All Control Builder F versions support the following functions:

• Configuration and commissioning of user programs

• IEC 61131-3 programming (FBD, IL, LD, ST, SFC)

• Graphical hardware configuration

• Integral fieldbus configuration for Profibus and FOUNDATION Fieldbus 

• IEC 61131-3 data types and user-defined (structured) data types 

• Project-wide variables and function block lists 

Freelance system 9.2 supports usage of unlimited number of OPC signals when 
connected to third party OPC server. 

Third party OPC integration is free from version 9.2. 



Control Builder F Standard Section 1  Licensing
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• Online cross-reference

• Efficient plausibility check

• Extensive online help 

Additionally, online test functions (debugging functions) and graphical 
documentation of the entire user program are supported. 

Besides the programs, all hardware components are displayed in graphical form and 
are submitted to a plausibility check together with the allocated software. 

Control Builder F Standard

Control Builder F Standard supports:

• Tag names of max. 16 characters

• User-defined function blocks (runtime license)

Control Builder F Professional

Control Builder F Professional supports all functions of Control Builder F Standard 
and additionally provides the following features:

• Access protection (Security Lock)

• Creation of user-defined function blocks (engineering license)

• FDT/DTM support

• Tag Type Library

Contrary to DigiTool, Control Builder F alone is not enough for creating 
programs as function block licenses are not included in its scope of delivery. 
Additional controller software licenses have to be ordered for this purpose.



Section 1  Licensing Freelance Process Stations
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Freelance Process Stations
With V6.2 and higher, a control software license is needed for every process station. 
Control IT offers two license types. They are different in terms of their functionality 
and of the number of supported I/Os. The license types are:

• Basic control software license

• Advanced software license

The license functionality can be adapted to the customer's needs for every controller, 
and the number of I/Os can be extended in steps of 50.

A control software license allows you to:

• enable specific function block libraries for a controller

• enable in Control Builder F a specific number of I/O signals (I/O components) 
which may be used in the controller/process station configuration. 

Basic Control Software License

The Basic control software license includes the following:

• IEC 61131-3, digital and analog value processing

• Controllers (without self-tuning)

• Integration of Profibus

• Integration of FOUNDATION Fieldbus (not supported for AC 700F)

• DigiVis 

• Basic IOs

• Serial Package Modbus Master, Modbus Slave 

• Serial Package Sartorius scales interface (not supported for AC 700F)

• Serial Package Protronic coupling (not supported for AC 700F)

Note that all controllers/process stations within a system must use the same 
control software license type. Mixing basic and advanced control software 
licenses within one system is not supported. 



Advanced Control Software License Section 1  Licensing
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• Tune (PID self-tuning)

• Sequence of Events (not supported for AC 700F)

Options for the Basic Control Software License

The standard Basic control software license can be extended with the following 
options:

• Batch Function Block Package (PLI, FPX)

• Interbus (only for upgrade of existing Interbus couplings)

• Telecontrol Library (IEC 60870-5-101)

• Maestro-UX Coupling

Advanced Control Software License 

The Advanced control software license provides Process Portal A support. It 
includes all features of Basic control software Base license and additionally 
contains the following functionalities:

• 800xA Operation, Process Portal A Support 

• Serial Package Modbus Master, Modbus Slave

• Serial Package Sartorius Scale interface (not supported for AC 700F)

• Protronic Coupling (not supported for AC 700F)

• Tune (Self tune PID)

• Sequence of Events (only Rack I/O)

• Advanced I/Os

Options for the Advanced Control Software License

The Advanced license already includes the majority of additionally available Basic 
license options. In addition, the following options are provided:

• Batch Function Block Package (PLI, FPX)

When you extend your Basic license to an Advanced one at a later time, you can 
continue to use the existing options for the Basic license. Additionally, all options 
of the Advanced license are available.



Section 1  Licensing Additional Control Software Options
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• Interbus (only for upgrade of existing Interbus couplings)

• Telecontrol Library (IEC 60870-5-101)

• Maestro UX Coupling

Additional Control Software Options

The following control software options are available for Basic and Advanced 
licenses 

• Open Communication Package (DDE, OPC)

• Trend server

• Application Programming Interface (API)

Licensing Used I/Os
Besides the Control Builder F engineering program all controllers/process stations 
with the respective number of used I/Os and the options must be licensed.   

 DDE is supported with Freelance Systems running on Windows XP and not 
supported with Freelance Systems running on Windows 7.

Freelance 9.2 SP1 is compatible for Windows 7 operating system. 

The Control Builder F adds up and displays all I/O components used in a project. 
The Control Builder F accepts CSV files from version 8.x onwards. See 
Engineering Manual, System Configuration, License indicator. 

Note that all blocks that might act as I/O consumers must have been installed in 
order to allow for correct determination of the required I/O licenses. For example, 
it is necessary to install FDT and required DTMs, if DTMs are to be used in the 
project.
As a rule, only a project without any errors in plausability check indicates the 
actually required number of I/O licenses.

If the number of I/Os used in a project exceeds the number of licensed I/Os, it 
will not be possible for the project to pass the plausibility check. As a result, you 
cannot download the software configuration into the process station.



Licensing Used I/Os Section 1  Licensing
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The number of I/Os relevant for licensing is determined by counting only those I/Os 
that are in use, that is: 

• the I/O components used in a program, or

• the I/O components provided through a gateway (OPC and DDE server) but not 
a program.

The input/output variable definition depends on the respective bus/fieldbus: 

• Rack I/O (CAN bus): 
Every channel used in a program or gateway independent from the data type is 
considered as an I/O. 

• Profibus: 
All I/O components agreed on the controller and used in a program or gateway 
are considered as I/Os. 

• Foundation Fieldbus:
Every I/O component that is transferred between the linking device and the 
controller/process station and that is used in a program or gateway is 
considered as an I/O. 

• Modbus:
All Boolean data (coils) or registers used by the transmit and receive function 
blocks are considered as an I/O. 

The following data are not considered as I/Os:

• send/receive function blocks

• diagnostic data (DP, PA)

• alarms (FF)

• parameters (PA, FF)

All used I/Os in an open project can be displayed in the hardware manager:

Hardware structure > Show all used I/Os 

If the same variable is used in both ways, only one of them is considered as 
variable that has to be licensed, that is. how often a variable is used is not relevant 
for determining the number of required I/O licenses. 



Section 1  Licensing Base License
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• global variables

Base License

These kinds of base licenses are available:

• Control Builder F

• DigiVis

• DigiBrowse

• Combined Workplace Expands an Engineering workplace to a combined 
workplace (Control Builder F + DigiVis)

Optional Licenses

Additional options for DigiVis 

• WEB display runtime

Web display functionality is used to load the local web browser. Calling the 
web display from DigiVis will activate the link to the configured web site.

• Dual monitor support

Windows Dual-view feature support is provided for DigiVis station. Graphic 
card which supports this feature and the appropriate device driver should be 
installed on the PC.

• Control Aspect Display (read only) of Control Builder F function block 
diagrams in DigiVis

• Extended Diagnostic

Only those controllers/process stations provided with an Advanced control 
software license can communicate I/Os to Process Portal A.



Upgrading Previous Software Versions Section 1  Licensing
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Upgrading Previous Software Versions
• The change-over from Versions V5.x or V6.x to Version 9.x is handled as a 

step-up. In each Industrial IT software delivery a 12-months Automation 
Sentinel agreement is included.

• During the runtime of this agreement the user gets all service packs and 
upgrades automatically and free of charge. No distinction will be made 
between new major and minor releases. 

.

Software Management Program Automation Sentinel for Freelance 

The Automation Sentinel Program allows you to keep your installation always up 
to date and benefit from new features and improvements directly and without any 
delay. A twelve (12) month Sentinel agreement starting with the date of shipment 
from the factory is included with each new Freelance system software purchase. 
This twelve(12) month agreement will automatically be extended to an additional 
six (6) months if the customer contact information is provided as indicated in the 
Automation Sentinel Product Guide. In addition to this, the base subscription now 
includes a limited number of technical support hours. 

When stepping from a version < 6.2 to a version > 6.2 (transition to new 
licensing), the customer decides which Control Builder F license, which control 
software licenses and how many I/Os he needs.

A step-up requires a control software license for every existing process station 
license. 

If DigiTool was licensed for five process stations, one Control Builder F license 
and five control software licenses have to be ordered for upgrading the system. If, 
for example, DigiTool was used with the user-defined function blocks, a Control 
Builder F Professional license is required to define new function blocks. With the 
Control Builder F license Standard existing function blocks can be used.

The appropriate control software license is needed for all controllers/process 
stations. If Operate IT Process Portal B is to be used on the operator level, then 
the Advanced control software is required for the controllers/process stations!

Always indicate the number of the existing hard key when ordering a software 
step-up. 
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Also included with the Sentinel subscription is a Solution Bank Sentinel 
subscription, which will provide customers with access to software downloads and 
product documentation.

Renewal of Subscription:

Before the subscription agreement expires a Sentinel renewal needs to be ordered to 
continue receiving updates to the existing software and maintain the option of 
evolution in the future. These renewals are valid for a period of 12 months and run 
consecutively from the previous subscription.
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Section 2  Freelance Installation

General Notes

Freelance Support

For technical assistance, please contact your local service 
organization.

http://www.abb.com/contacts/

or 

http://solutionsbank.abb.com/CallCenters/Home.asp

http://www.abb.com/contacts/
http://solutionsbank.abb.com/CallCenters/Home.asp
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Recommended PC Equipment

Control Builder F

DigiVis

Hard disk for installation 500 MB free disk space

Hard disk for operation 10 GB free disk space

Operating system Microsoft Windows XP Prof. SP3, 32bit

Windows 7 Professional, 32 bit

CPU Speed > 2 GHz

RAM 3 GB

Ethernet card with supp. Interface BNC/AUI/TP

Hard disk for installation 500 MB free disk space

Hard disk for operation > 2 GB free disk space

Recommended for archiving > 80 GB (depending on configuration)

Operating system Microsoft Windows XP Prof. SP3, 32bit, en

Windows 7 Professional, 32 bit, en

Speed > 2 GHz

RAM 3 GB

Graphics card for dual monitor Matrox Millenium P690

Nvidia NVS295

Multi-display Fiber-Optic Remote 
Graphics Unit

Matrox Extio F1400

Ethernet card with supp. Interface BNC/AUI/TP
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OPC Server F

The above-mentioned specifications for PC equipment are recommendations only. 
They were selected to ensure a fluent workflow and to have good response times. 
Depending on the size of your project you might experience a fluent behavior with a 
less powerful PC as well.

Hard disk for installation 500 MB free disk space

Hard disk for operation > 2 GB free disk space

Operating system Microsoft Windows XP Prof. SP3, 32bit

Windows 7 Professional, 32bit

Microsoft Windows 2003 Server SP2, 32bit

Microsoft Windows 2008 Server, 32bit

Speed > 2 GHz

RAM 3 GB

Ethernet card with supp. Interface BNC/AUI/TP

E

For a proper and error-free operation of Freelance it is recommended that the 
Freelance applications are the only ones installed on the PC.

It is recommended to install and operate OPC Server and Trend Server on 
separate PCs always.

The Freelance software V9.2 SP1 is released for the usage on a 32 Bit Windows 
operation system. 64 Bit Windows operating systems are not supported.

The Freelance setup program will show a warning, if a 64 Bit operating system is 
detected.
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Mixed systems with Windows XP and Windows 7 

It is possible to combine PCs with Windows XP and PCs with Windows 7 operating 
system in a Freelance system. With this, an update from Windows XP to Windows 7 
must not be done in one step but can be done one after the other.

Product Options

In case of license extension, you will receive a new authorization code that you 
should enter as follows:

Options and Add-on Modules

There are two different grades of license for the Control Builder F software, 
Standard and Professional, and they offer different features. To use the process 
stations, each station also requires control software (either the Basic or Advanced 
version). The Control Software can be used in both the Basic and Advanced grade. 
Other software packages can be used as add-on modules.

You can find a more detailed description in Section 1, Licensing.

Hardkey

Freelance products are protected by means of USB/parallel port hardkey and an 
associated authorization code, which activates only those products for which official 
orders have been processed.

Exception:

If using mixed systems with Windows XP and Windows 7 operating systems for 
a Freelance system, make sure that the same Windows operating system is used 
for the PC of the Extended Diagnostic DigiVis station and the PC with the 
Control Builder F.

For Freelance a hardkey is required to enable the functions and features of 
Control Builder F and/or DigiVis that were ordered.

> Start > Programs > ABB Industrial IT > Freelance V9.2 > Configure
Select the tree item:
> General settings > Authorization Key Installation
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The following versions of the Hardkey are available:

• Control Builder F

• DigiVis

• Combination (Control Builder F and DigiVis)

If the Freelance software is started without the USB/parallel port hardkey, it will run 
as a demo version for 100 days. 

In case of a hardkey failure, the software will enter an emergency mode which, just 
like the demo mode expires, after 100 days. As long as the hardkey is replaced 
within these 100 days, the rights conferred by the license will remain in effect.

Similarly, if the hardkey is unplugged after startup the software will go into 
emergency mode.

First Installation of the Freelance Software

Checklist for Installation

Do you have a current authorization key file (only required for 
Production Mode)?
If not please contact your local ABB sales office.
See Authorization Key Installation on page 68.

Is the USB/parallel port hardkey installed at the USB/LPT port?

Has the Windows operating system been fully installed, including 
the Service Pack?
See Windows Operating System Installation on page 28.

Windows 7 only:
Is the User Account Control disabled? 
See Manually disabling the User Account Control on page 29.

The system will launch in demo mode if there is no hardkey installed on the PC 
during installation.
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Is the Windows Firewall configured?
See Windows Firewall on page 29.

Is the automatic update of the Windows operating system disabled?
See Disable Automatic Updates on page 31.

Have the Power Options been checked? 
See Configure Power Options on page 31.

Is the Screen saver deactivated?
See Disable Screen Saver on page 32.

DigiVis operator stations only:
Is the theme and screen resolution set?
See For Installation of DigiVis: Setting the Theme and Screen 
Resolution on page 32.

DigiVis operator stations only:
Is the Windows Task Bar Configuration appropriate?
See For Installation of DigiVis: Additional Steps to disallow 
Operating System Access on page 35.

Is TCP/IP protocol installed as network protocol?
Have the IP addresses been entered?
Has the file “hosts” been correctly edited?
See Network and IP Address Settings on page 36.

Is an administrative user with password ready to be used as 
operator?
See User Account Configuration on page 40.

Is the Antivirus Program disabled before executing the Freelance 
setup?
Are the directory exclusions for the virus scanner configured?
See Configure the Antivirus Program on page 40.

Windows Operating System Installation

Check to be sure that the Windows operating system and the required Service Pack 
for Windows are installed.
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For detailed information on required service packs please refer to the release notes, 
which are available on the setup CD. The Service Packs are available free of charge 
from Microsoft Corporation (also on the internet at http://www.microsoft.com).

Manually disabling the User Account Control

When the Freelance setup is started, it will detect the current User Account Control 
setting and request the user to disable it. A reboot will be necessary in this case. For 
more details, see User Account Control Settings in Windows 7 on page 48.

Windows Firewall

The Windows OS comes with an integrated firewall. A firewall can block the 
communication between applications.

Windows XP

In Windows XP it is recommended to disable the firewall to ensure the proper 
operation of Freelance.

The User Account Control settings can be changed manually in this Windows 
dialog:

> Start > Control Panel > User Accounts and Family Safety
> User Accounts > Change User Account control settings

The recommended setting is “Never notify”.

Reboot the computer.

> Start > Control Panel > Windows Firewall > General

Select Off (not recommended) to disable the firewall.
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tb200.bmp

Windows 7

For Wirdows 7 the firewall configuration is handled by the Freelance setup. The 
firewall is configured to allow the Freelance applications to communicate properly. 
There is no specific configuration by the user necessary.

During the installation process the setup will add several Freelance programs to the 
firewall exclusion list. To verify the entries made, you can open the Windows 
Advance Firewall configuration:

> Start > Control Panel > System and Security > Windows Firewall

Select Advanced settings

The Windows Firewall with Advanced Security configuration is shown.

Select Inbound Rules

When the setup has finished there are several new entries that start with 
“Freelance”.
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Disable Automatic Updates 

The automatic update of the Windows operating system must be disabled.

Windows XP

Windows 7

Configure Power Options

The Windows power management may shut down the PC to save energy or put it to 
sleep. This must be avoided. It must be ensured that the energy saving mechanisms 
are configured in a way that the computer is always on.

Windows XP

Typically the preconfigured setting is Home/Office Desk, which is OK.

Windows updates should be done manually from time to time due to security 
considerations. The updates must be synchronized with the system administrator 
and the internal company security policies.

Automatic updates may reboot the PC automatically. It is highly recommended to 
disable them.

> Start > Control Panel > Performance and Maintenance > System

Select the tab Automatic updates and activate Turn off Automatic Updates

Press OK

> Start > Control Panel > System and Security > Windows Update

Select Change settings

Select Never check for updates from the list.

Press OK

> Start > Control Panel > Performance and Maintenance > Power Options > 
Power Schemes

Ensure that System standby is set to Never

Ensure that Turn off hard disks is set to Never
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Windows 7

By default the Balanced power plan is active in Windows 7. This means that the 
computer goes into sleep after 30 minutes of inactivity.

Change the power plan to “High performance”.

Disable Screen Saver 

The screen saver needs to be disabled in the Windows operating system settings.

Screen Saver in Windows XP

Screen Saver in Windows 7

For Installation of DigiVis: Setting the Theme and Screen Resolution

The DigiVis software supports two different user interfaces. Which one is selected 
depends on theWindows screen resolution.

> Start > Control Panel > System and Security > Power Options

If not expanded, expand show addtional plans

Select the High Performance power plan.

> Start > Control Panel > Appearance and Themes > Display

The Display Properties are displayed.

Select tab Screen Saver

In the Screen Saver list, select (None)

Press OK

> Start > Control Panel > Appearance and Personalization >Personalization

Click Screen Saver in the lower right corner.

In the Screen Saver list, select (None)

Press OK
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When the DigiVis program starts, the currently configured monitor screen 
resolution is checked and, depending on this setting, DigiVis is started with the 
conventional-design or new-design user interface.

The conventional-design GUI is in principle the display as known from the earlier 
versions. For all resolutions with a minimum of 1024 pixel in the vertical direction, 
DigiVis starts with the new-design GUI. On screens with a resolution of less than 
1024 pixel in vertical direction, DigiVis starts with the conventional-design user 
interface.

DigiVis supports the use of two monitors, even with different screen resolution.

Settings for the New-Design DigiVis User Interface

The standard resolution for the new-design user interface is 1280 x 1024 pixels. 
Under Windows XP select the “Windows XP” theme. Under Windows 7 select the 
“Windows 7 Basic” theme.
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Windows XP New

Windows 7 New

Settings for the Conventional-Design DigiVis User Interface

For the conventional-design user interface, a resolution of 1024 x 768 pixels is 
recommended. Under Windows XP select the “Windows Classic” theme. Under 
Windows 7 select the “Windows 7 Basic” theme.

> Start > Control Panel > Appearance and Themes > Display

Applearance:

> Tab Themes > Select Windows XP as theme.

Resolution:

> Tab Settings > Select resolution 1280 x 1024 pixels

> Start > Control Panel > Appearance and Personalization

Appearance:

> Personalization > Select Windows 7 Basic as theme

Resolution:

> Display > Click Adjust resolution > Select resolution 1280 x 1024 pixels
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Windows XP Conventional

Windows 7 Conventional

For Installation of DigiVis: Additional Steps to disallow Operating System Access

Operator stations shall be configured to disallow operating system access. Freelance 
and especially DigiVis is designed to support this.

Windows XP

There are additional steps necessary to disallow Operating System access:

The task bar property “Keep the task bar on top of other windows” must be disabled:

Background Information

When you start DigiVis in Production Mode the Windows Start button is disabled. 
There is no minimize button in DigiVis. This behavior has been implemented 
because of security concerns. The DigiVis user cannot switch to other applications. 

> Start > Control Panel > Appearance and Themes > Display

Appearance:

> Tab Themes > Select Windows Classic as theme

Resolution:

> Tab Settings > Select resolution 1024 x 768 pixels

> Start > Control Panel > Appearance and Personalization

Appearance:

> Personalization > Select Windows 7 Basic as theme.

Resolution:

> Display > Click Adjust resolution > Select resolution 1024 x 768 pixels

> Right click the taskbar

> Properties

Disable “Keep the task bar on top of other windows”
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Only those applications that have been started before the start of DigiVis can be 
reached by the DigiVis user by pressing the ALT+TAB keys.

The Windows operating system can be reached from the DigiVis menu (Tools / 
System / Operating system) after entering a password. With this action the Windows 
start button is enabled and is displayed with text. This is not a security problem, as 
long as the task bar is in the background of DigiVis. DigiVis is not able to suppress 
the task bar in all cases. If the task bar is configured “Keep the task bar on top of 
other windows” it is shown in front of DigiVis. Therefore, the task bar property 
“Keep the task bar on top of other windows” must be disabled to make sure that the 
DigiVis user has no access to other applications.

Network and IP Address Settings

The Network protocol used by Freelance is TCP/IP. No other protocol is required. 
A proper operation with other network protocols is not guaranteed.

IP addresses and/or host names can be used for addressing the stations and resources 
in a project.

For the PCs connected over a Local Area Network (LAN), the use of IP addresses 
from 172.16.1.20 up to 172.16.1.255 are recommended.
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IP Address Settings

Enter an IP address and Subnet mask for the Network Adapter:

IP address: 172.16.x.x e.g. 172.16.1.20

Subnet mask: 255.255.240.0

Subnet Mask for Time Synchronization 

Besides the Windows PCs the process stations need a valid network configuration 
too.

There is a coding switch on the rear panel of the CPU module with which the 
resource ID of the process station is set. For the AC 800F the coding switch is 
located on the Ethernet module. The resource ID is normally used as part of the IP 
address.

If the coding switch is not set to zero and set to a value from 1 to F, then the subnet 
mask and the IP address are assigned as 255.255.240.0 and 172.16.1.x respectively, 
(where x = 1,...,15 as determined by the coding switch setting 1,...,F). If the coding 
switch of a process station or an AC 800F is set to 0 (zero), then the IP address and 
subnet mask can be assigned as required.

This means that in order to permit time synchronization, all stations must be located 
in the same subnet. The subnet masks 255.255.240.0 and IP addresses 172.16.x.y 

Windows XP

> Start > Control Panel > Network and Internet Connections > Network 
Connections

> Right-click a network adapter and select Properties

> Select Internet Protocol TCP/IP and click Properties

Windows 7

> Start > Control Panel > Click Network and Internet

> Click Network and Sharing Center > Click Change adapter settings

> Right-click a network adapter and select Properties

> Select Internet Protocol Version 4 (TCP/IPv4) and click Properties



Network and IP Address Settings Section 2  Freelance Installation

38 3BDD012560R0503_Getting_Started

 

E
n

g
lis

h
D

eu
ts

ch

with x = 0... 15 and y = 0... 255 must also be configured for the freely configurable 
stations (PCs or components with coding switch set to 0).

Stations which are connected over a router do not participate in either normal time 
synchronization or in lateral communication. The function “Ext. time server” (see 
Engineering Manual, System Configuration, Project Tree) can be used to 
implement time synchronization for external process stations. 

Parameters for DNS Server and WINS 

No parameters need to be set for DNS or WINS, if the software is running as a 
standalone system. The default network settings of the Windows XP/ Windows 7 
installation can be used unchanged to operate a Freelance system. The TCP/IP 
protocol must be used on all PCs.

Usage of Host Names

When configuring a project, symbolic names can be used for the computers and 
process stations instead of IP addresses. With the aid of the hosts file, the system 
can translate these names into physical addresses. This file must first be edited 
according to the requirements.

When Windows is installed an example file is created on the computer:

<Windows directory>\system32\drivers\etc\hosts

Edit this file according to your requirements. A value must be entered for each 
computer and each process station that is to be configured using not an IP address 
but a name. (The names may be up to 14 characters in length):

<IP address> <name>

If other subnet masks than 255.255.240.0 are used, make shure that they are 
contiguous. The equivalent bit pattern must start and then continue with 1 values. 
It may change to zeroes once and must then end with zeroes.

Valid Example:
11111111 11111111 11110000 00000000 = 255.255.240.0
Invalid Example:
11111111 11111111 11111001 00000000 = 255.255.249.0

Note: In the Windows XP / 7 entry masks you cannot enter invalid values.
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Example:

172.16.1.1 station1
172.16.1.123 opc_gwy

Network Configuration Check

To check the network configuration between a Windows PC and a controller station 
or between two Windows PCs one can utilize the ping command. 

Administrative rights are necessary to edit the hosts file.

In Windows 7 start the text editor as Administrator or disable the User Access 
Control for editing.

> Start > Run.. > Enter cmd > Press [Enter]

A windows console window opens (prompt).

Now enter the ping command to check, if a connection to the address or host 
name can be established.

Eg: Enter ping 172.16.1.20 to check the connection to the station with the IP 
address 172.16.1.20.

If the connection is ok, the pinged station or computer will reply and a time value 
how long the sent package took to return is printed out. If the connection is not 
ok, a request timed out message is displayed.

If the DNS name resolution is used, this can also be tested with the ping 
command. Eg: Enter ping opc_gwy.
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Windows 7 Firewall Settings to Use the Ping Command

To check the connection to a Windows 7 computer, the firewall rules on the 
Windows 7 target machine need to be adjusted. By default, the Windows 7 firewall 
blocks incoming ping requests. 

User Account Configuration

For the installation a user with administrative rights is needed.

Later on the creation of DigiVis users is supported via the Configure tool (See 
General Settings on page 66).

Windows XP

Under Windows XP it is possible to limit the rights of the DigiVis users. This can be 
achieved by changing the account type of the DigiVis user from Computer 
Administrator to Limited. The Limited user is member of the Windows Users 
user group only.

Windows7

All users using Freelance applications under Windows 7 need administrative rights. 
They should be member of the Windows Administrators user group.

Configure the Antivirus Program

Certain antivirus programs on a Freelance PC can cause problems in Control 
Builder F, e.g. when a project is created, and in DigiVis, e.g. when a project is 
loaded into DigiVis.

Open the configuration of the advanced Windows 7 Firewall on the target 
machine (not the machine where the ping is entered):

> Start > Control Panel > System and Security > Administrative Tools
> Windows Firewall with Advanced Security. 

Enable the inbound firewall rules named File and Printer Sharing (Echo 
Request - ICMPv4-In) to allow ping requests to this computer.”

To avoid access problems, exclude these directories from virus scanning:

1. the <Freelance_Installation_Folder>\proj directory and
2. the Temp-directory of the logged in user.
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Upgrade an Existing Version to the New Version
Upgrading means changing from a Freelance version to a newer version. In this 
process, existing project configurations can be taken over without any problem, if 
the upgrade is within a main version (e.g. from V8.1 to V8.2) or also from one main 
version to the following one (e.g. from V8 to V9). If the required upgrade involves 
skipping one or more main versions (e.g. from V6 to V9), contact your local ABB 
Service Organization.

Notes to Follow Before Performing an Upgrade

Checklist 

You should check that all the project files have been exported from 
the “old” Control Builder F or DigiTool version.

The Temp-directory depends on the logged in Windows user. The typical location 
of the Temp-directory of the user “Freelancer” is

Windows XP:

"C:\Documents and Settings\Freelancer\Local Settings\Temp"

Windows 7:

"C:\Users\Freelancer\AppData\Local\Temp”.

You may need to exclude the Temp-directories for all users working with 
Freelance.

Antivirus programs can affect the installation procedure of the Freelance 
software. Because of that it is recommended to disable Antivirus programs like 
McAfee Antivirus before the setup is executed and enable them after the setup 
has finished.

If the Control Builder F project is created in Windows XP and opened in 
Windows 7, the timezone setting will be lost.

To set time zone
Open the CBF project on the Windows 7 system
CBF Project tree > Right-click on CONF node > Click Header > Timezone
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Check that the function block parameters in the project files are 
documented.

Back up Project Files from Older Versions

Existing projects from a former version must be exported (create *.CSV file) using 
your old Control Builder F / DigiTool version, before starting the setup of the new 
software version.

Before the export of the project data, you must make shure that all parameters, 
which have been changed either from the operator station or during commissioning 
mode, are stored in the project file using the CORRECT option. Each parameter 
modified with a’ WRITE’ command is set while the loading of the process station 
on its original value. With the function Load/Parameters it is possible to save all 
modified parameters:

Document Function Block Parameters

It is recommended that you document the parameters of the function blocks in the 
projects. In the event of incompatible changes to the function block library which 
cannot be handled automatically by the system, it may be necessary to re-enter 
parameters.

Export the Project

Save the project in a *.CSV file:

> Start Control Builder F 
> Open project 
> Switch to Commissioning mode
> Load > Parameters > Only different > Correct parameters

> Export project file (*.CSV format)
> Exit Control Builder F
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See also Engineering Manual, System Configuration, Project Manager, 
Exporting a project.

Upgrade from V9.1 to V9.2 SP1

If Freelance V9.1 is already installed on the system and the user runs the setup then 
the “upgrade screen” is displayed

Setup Upgrade 91 to 92SP1.bmp

In projects created with version 3.3 and earlier the same name could be used for 
function blocks (tags) and variables. As of version 4.1, conflicts between the 
names of tags and variable names are no longer allowed and will be corrected 
instead!

With import of a project all conflicting names are removed automatically by 
suffixing the current variable names with ..._var. In the variable list, changed 
variable names can easily be selected with the search function. The cross-
reference function allows you to easily detect changed variable names and to 
modify them, if necessary.

If a Freelance version prior to V9.1 is found on the system, then the setup 
displays a warning. This prior version must first be uninstalled before V9.2 SP1 
can be installed on the System.
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Click Next.

Setup Ready to Upgrade.bmp

Click Install. The existing V9.1 features will be upgraded to V9.2 SP1.

Upgrade from V9.2 to V9.2 SP1

If Freelance V9.2 is already installed on the System and the user runs the setup then 
the “upgrade screen” is displayed.

The upgrade option reinstalls only those features that are installed using V9.1. If 
during an upgrade from V9.1, the setup finds that OPC Gateway or Trend Server 
is already installed, then the setup installs OPC tunnel and if Control Builder F is 
found installed then the setup installs the Bulk Data Manager.

To add new features after the upgrade has finished, run the setup again. The setup 
goes into the Maintenance mode.

If a Freelance version prior to V9.1 is found on the system, then the setup 
displays a warning. This prior version must first be uninstalled before V9.2 can 
be installed on the System.
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Setup Upgrade 92 to 92SP1.bmp

Click Next.

In the next screen click Install. The existing V9.2 features will be upgraded to V9.2 
SP1.

Uninstall Before a New Installation

If the previously described upgrade scenarios do not apply, it may be necessary to 
uninstall the software.

Freelance versions lower than 9.1 can be unistalled via the Windows Add or 
Remove Programs control panel:

To add new features after the upgrade has finished, run the setup again. The setup 
goes into the Maintenance mode then.

Ensure that the software that is uninstalled is not needed anymore before 
uninstalling it. E.g. for exporting old projects.

> Start > Control Panel > Add or Remove Programs
> Select the program to uninstall. E.g. Control Builder F / Freelance V8.1
> Click on the Remove button
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Since version 9.1 the Freelance software setup contains a remove option (See 
Remove option on page 65):

After an uninstallation the new software can be installed as given in the following 
steps.

Start Setup
To install the Freelance software, insert the Freelance Software CD in the CD drive. 
The CD autoplay dialog starts automatically, if the Autoplay function is enabled in 
Windows. If this function is disabled then start the dialog manually.

First select the language for the software in the Language screen.

> Insert the installation CD of the installed Freelance version
> Start the Windows Explorer
> Select the CDROM drive 
> Open file Autoplay.exe. E.g. E:\Autoplay
> Select the installed language
> Click Freelance software
> Click OK for Warning message
> Select Remove and proceed until the software is uninstalled.

It is recommended that the third party software such as OPC tunnel, S-800 DTM, 
S900 DTM, FDT shared components, FDT Base container, CBF Viewer etc. that 
are installed by the Freelance Setup are uninstalled using the Remove option.

> Start the Windows Explorer
> Select the CDROM drive 
> Open file Autoplay.exe. E.g. E:\Autoplay
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After the language selection, the Content screen is displayed. It shows the different 
content packages available on the CD.

tb499.bmp

Release Notes This option opens the document “Release Notes” for reading, which 
lists the new features of this version.

Freelance Software This option starts the Freelance Software Installation. It allows 
the selection of the Freelance software packages that can be 
installed.

Back Go back to the language selection.

Read the Release Notes and then proceed with the selection of Freelance Software 
to start the software installation as described in the next chapter.

You will need a PDF-Reader like the Adobe Acrobat Reader to open the 
document.
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Install Freelance Software

General notes on operation in the setup procedure

Buttons in the Dialog Boxes:

Next Continue the installation with the next dialog box. 

Back Returns to previous window. 

Installation Preconditions

User Account Control Settings in Windows 7

The User Account Control (UAC) is a new feature in Windows 7. The instructions 
to disable the User Account Control are applicable for Windows 7 only. To ensure 

The installation can be aborted at any time by clicking Cancel.

In case you are a user of earlier versions of Control Builder F or DigiTool:

Before you continue be sure you have exported all your current Control Builder F 
or DigiTool projects with your currently installed Control Builder F or DigiTool 
program. If you have any doubts cancel this setup now and export all of your 
projects with your currently installed Control Builder F or DigiTool version.

We also strongly recommend that you document the parameters of the function 
blocks currently used in your projects. You may have to reenter them in case of 
incompatible changes made to the function block library that can not be treated 
by the built-in update utilities.

See also Upgrade an Existing Version to the New Version on page 41.

In Windows operating systems, before starting the setup, it is recommended to 
disable virus scan programs like McAfee Antivirus.

If a previous version of the Freelance software already exists on the system then 
the setup displays a warning asking for it to be removed from your System.

See Uninstall Before a New Installation on page 45 for detailed instructions.
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the proper operation of Freelance, it is highly recommended to disable the UAC 
feature in the Windows 7 environment.

UAC handling by the Freelance Setup

The Freelance setup detects, if the UAC configuration is not appropriate and shows 
this warning:

UAC1.bmp

Click Disable UAC to disable the UAC. The setup will disable the UAC and restart 
the PC. Ensure that you have no unsaved work and click Yes to restart the computer.

UAC2.bmp

After the restart, setup will continue with the Freelance Installation.

Verifying the User Account Control settings

The UAC setting can be verified, after the installation of Freelance:

> Start > Control Panel > User Accounts and Family Safety
> User Accounts > Change User Account control settings 

The slider bar must be in the Never Notify position.
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Welcome Screen

The Welcome Screen reminds the user about important steps to do before the 
software is installed.

Once you have clicked Next the License agreement screen is displayed.

License Agreement

tb500.bmp

Select I accept the terms of the license agreement to accept the license.

On clicking Next the “Setup type” screen is displayed.
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Selecting a Setup type

Choose the desired Setup type. 

tb500_1.bmp

Demo To install the Software for demo purpose or as a try out.

Production To install the Software in the production environment.

Destination Directory for Installation

By default, Freelance software programs are installed in directory

C:\Program Files\ABB Industrial IT\ Freelance 

A detailed description on each of the Setup types can be obtained by clicking on 
the Help icon provided on the top right side of the screen. 

The destination folder for the installation can be changed using the Browse 
button.

The default destination directory for the installation in Production mode is 
E:\Program Files\ABB Industrial IT\Freelance 

For Production we recommended that Freelance Software is installed on a 
partition separate from the one where the Operating System is installed
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(for Demo)

or

E:\Program Files\ABB Industrial IT\ Freelance 

(for Production)

The following subdirectories are created below the installation directory:

...\bitmaps Bitmap files for the hardware devices in the DigiVis 
system display

...\bpr Operation logs

...\curv Trend archives

...\ddesrv DDE Server

...\dmsapi Application interface

...\doc Project documentation

...\eprom FLD files for EPROM updates

...\exe dll and exe files for Control Builder F

...\export Exported project files or program sections

...\ff Files from FOUNDATION Fieldbus Standard

...\gsd Profibus device master data files

...\macros Macros for the graphic editor

...\opcsrv OPC Server

...\OPCTunnel Installation folder for OPC Tunnel Server

...\proj Default for Project files 

...\proj\BDM Default for Bulk Data Manager Templates and files 

...\reports Default for Excel reports

...\sap Disturbance course logs

...\setctrl Setup control

...\setups Setup history

...\sfp Signal sequence logs

...\ucurv Reserved

...\VisHelp Online Help for DigiVis (High resolution and low reso-
lution)

...\wave Wave files for alarm messages in DigiVis
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Workplace Type DEMO Mode

Selecting this mode will install the software on the system for a try-out. No license 
is needed and all functionalities of the software are available to the user. The validity 
of this mode is however limited to 100 days 

Selecting the setup type Demo from the Setup type screen and clicking on Next will 
display the “Workplace Type” screen.

tb500_2.bmp

The default selection for the Demo mode is shown in the screen shot above, 
However the user can choose any one of the workplace types that are listed on the 
screen. The Custom workplace type is describen in the chapter CUSTOM Workplac 
Type Option on page 55.

Clicking on next brings up the “Ready to install” dialog. Refer to Ready to install 
dialog. on page 59.

A detailed description of each of the workplace types can be obtained by clicking 
on the Help icon provided on the top right side of the screen 

The Detail button can be used to view the feature tree showing the components 
that will be installed for the workplace type that is selected, in the chosen mode. 
This is just a view of the feature tree and the user cannot select or deselect the 
components in this view.
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Workplace Type PRODUCTION Mode

Selecting the setup type Production from the Setup type screen and clicking on 
Next will display the “Workplace Type” screen.

tb500_8.bmp

The default selection for the production mode is shown in the screenshot above. 
However the user can choose any one of the workplace types that are listed on the 
screen. The Custom workplace type is describen in the chapter CUSTOM Workplac 
Type Option on page 55.

This mode will modify the setting on the PC besides installing the Software. 
License keys should be provided for installing the selected components.

A detailed description of each of the workplace types can be obtained by clicking 
on the Help icon provided on the top right side of the screen 

The Detail button can be used to view the feature tree showing the components 
that will be installed for the workplace type that is selected, in the chosen mode. 
This is just a view of the feature tree and the user cannot select or deselect the 
components in this view.
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Clicking on Next brings up the “Ready to install” dialog. Refer to Ready to install 
dialog. on page 59

CUSTOM Workplac Type Option

This Option is recommended for advanced users of the Freelance software. It gives 
the user most flexibility in terms of selecting or deselecting the components to be 
installed. On selecting the Custom option in the “Workplace type” screen and 
clicking on Next the “feature tree” is displayed.

tb500_9.bmp

Select Software Packages to Be Installed

In the features tree dialog box, select the software packages that are to be installed 
on the PC by clicking on the checkbox in front of the Component.

Click on a component name in the feature tree and a brief description of that 
component will be displayed on the right side.

The space required on the drive as shown in the screen above does not include the 
requirements for FDT-shared components/base container, DTM for S800/S900, 
CBF viewer, Hardkey, CBF/DigiVis Help.
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The Freelance software features are listed in a tree structure in the dialog. The check 
box in front of each feature indicates the state of that component on the PC. 

(blank) The component will not be installed.

(checked) The component will be installed

(checked and grayed) The component is a dependency for some 
other component that is selected and is automatically selected and 
installed together with that component.

Clicking on Next brings up the “Ready to install” dialog. Refer to Ready to install 
dialog. on page 59

Freelance Base Software Packages

The following software packages can be installed with this setup:

Freelance Software

• Engineering Station

– Control Builder F

Software package for configuring and commissioning process, 
gateway and operator stations for Freelance projects

– CBF Help

Online Help for Control Builder F

– Profibus FDT Library

Software for Configuring PROFIBUS installations with the help of 
FDT/DTM interfaces, version FDT 1.2 in Control Builder F 
projects

- FDT1.2

- FDT1.2 Components
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To configure the field devices in Control Builder F using DTMs, you 
have to install these additional software components in addition to 
the FDT libraries.

 - FDT Shared Components

- FDT Base container 

-DTM for S800

-DTM for S900

– Foundation Field Bus 

Software for configuring FOUNDATION Fieldbus devices

– Bonus Pack

- Controller Emulator

This software package can be used to emulate process stations. A 
project configuration can be tested in the absence of any existing 
hardware.

- Bulk Data Manager

Freelance Bulk Data Manager is a tool that allows manipulation of 
large data sets during engineering with Control Builder F with the 
help of Microsoft Excel. Functionality provided comprises Import / 
Export of tag and variable lists, multiplying of typical application 
solutions and parameter change for complete sets of function 
blocks.

• Operator Station

– DigiVis 

Software for an operator station for operating and observing the 
processes configured using Control Builder F

– DigiVis Help

The newly introduced bonus features viz. S800/S900 Function Blocks, S800 
Modbus Function Block, 3D library, S700 Template etc., are installed during the 
Setup and do not appear as options in the Feature Tree.
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Online help for the DigiVis operator station software

– DigiBrowse

Software package for viewing archived trends and logs

• Servers and Gateways

– OPC Gateway

Gateway for interfacing Freelance projects with other application 
programs via an OPC server. should be installed on a Connectivity 
Station.

– Trend Server

The Trend Server is a special OPC Server that supports user defined 
trend displays. Only one Trend Server is allowed in a Freelance 
system and should be installed on an Operator Station or a 
dedicated Connectivity Station.

– DDE

DDE server for interfacing Freelance projects with other 
application programs through a DDE interface.

– Application Programming Interface (API)

– OPC Tunnel

Used to link OPC server / Trend server with DigiVis. Install this on 
the machine running OPC server or Trend server

• CBF viewer

Used to view real-time data in DigiVis for the application programs 
(FBD, SFC etc.) from Control Builder F.

• Security Lock

Access control for Control Builder F and Digivis 

DDE is supported with Freelance Systems running on Windows XP and not 
supported with Freelance Systems running on Windows 7.
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Ready to install dialog.

tb500_11.bmp

Clicking on the Install button will install the selected components.

The installation process takes some time. The time needed for installation 
depends on the number of components selected.
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Installation of HBGina.

HBGINA.jpg

After the installation of the software packages the setup continues with the data 
import of previous versions.

Import Data from Previous Versions

The dialog Freelance Software Setup / Import directory will be displayed when 
the installation has been completed.

If you had installed a previous Freelance version and now want to install the 
software in a different directory than before you can use this dialog to copy all 
project and archive data into the new Freelance installation directory.

Freelance uses its own dll (HBGina.dll) for Graphical identification and 
authentication in Windows XP.

If during the installation a conflict with the installed authentication is detected on 
the PC, a warning message is displayed. Continuing the installation will install 
the HBGina.dll of the Freelance software. As a result, certain related 
functionality of other applications might be impacted.

In 

In Windows 7 Professional, HBGina.dll is not used.
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tb500_14.bmp

If the project data are to be copied into the new directory, activate checkbox Import 
subdirectories of a previous Freelance version and Browse to the directory name 
of the previously used Freelance version.

Clicking the Next button copies the data from the previous version, if so desired. 
The configuration screen is displayed thereafter.

Modify initial Installation Settings

The Configure dialog can be used to customize the installation to your computer 
and requirements. The settings can be modified retroactively after the installation 
has been completed without having to carry out the installation again.

For a detailed description of the configuration dialog refer to chapter Modify 
Installation Settings on page 66.

Click OK on the “Configuration screen” to end this installation part. A screen 
indicating the completion of the installation is displayed as follows.
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Finishing the Installation

tb500_31.bmp

Choose the desired boot action:

Yes To restart computer now.

No Install the additional Freelance products, then restart the computer 
once after completing all installation procedures.

The Finish button is used to complete the installation.

If relevant, a message informing the user that the computer must be rebooted is 
displayed. If you want to install additional Freelance products on this computer it is 
sufficient to restart the computer once after completing all installation procedures.

In case you have installed the CBF viewer you need to call it up once in order to 
start the CBF viewer configuration wizard. For details please refer to installation 
guide of the CBF viewer which has been installed together with the software.
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Maintenance mode
If the setup program is started on a PC where one or more Freelance components of 
the same version are already installed on the System, then setup goes into 
Maintenance mode.

tb500_12.bmp
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Modify option

This option can be used to add or remove components of the Freelance software. 
Choosing this option and clicking Next will bring up the “feature-tree” dialog.

tb500_16.bmp

The components that are already installed on the System will appear with a check 
mark against them, all other components will be unchecked. 

If you want to uninstall a component that is already installed on the System, then 
uncheck that component from the list. 

Check the components that are to be installed and click on Next.

The Setup makes the required modification and displays the “Maintenance 
complete” screen. Click on Finish to complete the installation.

Repair option

This option is used to reinstall components that have already been installed on the 
System, in order to repair files or settings that may have been overwritten. 

The repair option will overwrite the content of the Hot Fixes, Roll ups and all 
manual changes to setup files. All Hot Fixes and Roll ups have to be manually 
reinstalled.
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If any file, registry key or content of any installed component is corrupted in the 
system, choosing this option will repair or put back the contents of the components. 
Setup replaces or repairs and verifies files and registry keys contained in the 
Freelance software components.

Select the Repair option and click on Next, the Setup makes the necessary repairs.

The configuration screen is displayed when the repair process is completed. Modify 
the settings if required. The settings can be modified retroactively after the 
installation has been completed without having to carry out the installation again. 
For a detailed description refer to chapter Modify Installation Settings on page 66.

Click on OK and the Maintenance complete screen is displayed. There is an option 
in this dialog to choose between restarting the System right away or later. Choose 
the appropriate option. Click on Finish to complete the repair of the software 
components.

Remove option

This will remove all Freelance components from your System. Choosing this option 
and clicking on Next will remove all installed Freelance components from the 
system.

Select the Remove option in the Maintenance screen and the Setup asks the user to 
confirm the removal of the components. Click on Yes to proceed with the 
uninstallation.

All Freelance software components will be removed from the System. Application 
data like logs, archives, projects and export files will not be removed. These can be 
deleted manually if they are no longer needed. In case a user account was created by 
the setup this user account will also remain.

After the uninstallation the Setup displays the Uninstall complete screen. There is 
an option in this dialog to choose between restarting the System right away or later. 
Choose the appropriate option and click on Finish to complete the removal of the 
software components.

Further information about the unistallation of Freelance is given in Uninstall Before 
a New Installation on page 45
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Modify Installation Settings
The Configure program is provided to accomplish basic configuration and 
maintenance tasks for the Freelance software. It is automatically started at the end 
of the software installation, but can be started manually using the Windows start 
menu as well.

First Freelance Configuration

In the tree structure in the left part of the dialog box, select all entries one by one 
and configure the settings. After the configuration is complete press OK to apply 
the changes and close the dialog.

General Settings

tb500_20.bmp

> Start > All Programs > ABB Industrial IT > Freelance V9.2 SP1
> Configure
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Installation Modes

The Installation mode can be changed from Demo to Production or vice versa in 
this dialog without having to reinstall the Software.

Demo Mode: To install the Software for demo-purpose or for a try-out.

Production Mode:
To install the Software in the production environment.

User account details
The DigiVis-user for the Production Mode in the Autostart mode is 
defined in this dialog. The default User is “Freelancer” and the 
default password is “welcome123#”. This can be changed as 
required.

Time Synchronization
This allows for the synchronization of the Windows computer time 
with the time of the process station.

IP Address The IP address uniquely identifies devices in the network.
Entry of IP address: 172.16.1.x, 
For more information, see Network and IP Address Settings on 
page 36.

Selecting Production Mode will enable DigiVis Autostart. After reboot Windows 
will start DigiVis automatically. This will prevent access to the Operating 
System.

If the “Freelancer” user does not exist, it is created by the setup with 
administrative rights. He is member of the “Administrators” group.

If another user is specified, it must be ensured that he has administrative rights 
and is member of “Administrators” group as well.

This parameter should be set consistently for all computers in a Freelance  
system.

Time synchronization must be activated if DigiVis software and trend displays 
are used in the Freelance system. 
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Subnet Mask Defines whether the addressed device is located in the same 
network or has to be addressed through routers.
Entry: 255.255.240.0

Authorization Key Installation

You should have received an authorization key file from ABB. Enter the drive name 
and/or directory path or select the directory where the authorization key file is 
located, using the browser button.

When the Install button is clicked, the authorization code is transferred to the 
installation directory.

Default Language

If you have installed Freelance Software in more than one language then the 
language for the user interface can be selected by setting the locale in the windows 
control panel to the required setting.

In case you set a locale in the Windows control panel and Freelance is not installed 
in the language of this locale, then with this configuration dialog option you 
determine which language Freelance uses for the user interface.

Example:

You have installed Freelance in English and in French, but have set the Windows 
locale to Russian, then with this configuration dialog option you can specify that the 
Freelance Software should use the English (or French) language for the user 
interface.

There is a choice of the following 

• Control Builder F

• DigiVis

• DigiBrowse

• Security Lock

If you operate your Freelance system in a network with other network 
components, you should contact your network administrator before allocating 
the IP addresses.
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• OPC/Trend Server

A locale can only be chosen, if the relevant packages have been installed on the 
concerned computer.

Settings for Control Builder F

tb500_21.bmp

Resource ID Several software packages can be run at the same time on a PC. To 
enable these software packages to be addressed unambiguously, 
each one must be assigned a unique number, the resource 
identification number.
All the resources within a Control Builder F project must also have 
a unique resource ID.
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Boot EPROM Download

The boot EPROMs of AC 800F, AC 700F controllers, CPU modules of the rack-
based process station as well as the DCP gateway stations are updated.

This requires that the TCP/IP protocol is loaded and that a connection is established 
through the system bus to the AC 800F, AC 700F, process- and gateway stations.

IP Address/Host Name
Enter the IP Address or host name of the station for download.
If you are using a redundant station you should specify both 
addresses (IP address 1 and IP address 2) and/or both host names.

After pressing the Download button, the current version of the boot EPROM is 
loaded to the addressed CPU module or the controller.

If you have more than one AC 800F, AC 700F, process station and/or gateway 
station, you must carry out this procedure for each station.

Load Profibus Module EPROM

The EPROMs in the Profibus modules of connected AC 800F controllers can be 
loaded with the current version.

Once the IP address or host name of a AC 800F controller has been entered, the 
current EPROM version is loaded to all the Profibus modules of the controller 
concerned.

If you are using a redundant station you should specify both addresses (IP address 1 
and IP address 2) and/or both host names.

Load HSE Module EPROM

The EPROMs in the HSE modules of connected AC 800F controllers can be loaded 
with the current version.

The process station cold-starts after loading the boot EPROMs.

Redundancy for the AC 700F controller is not supported in this version.
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Once the IP address or host name of a AC 800F controller has been entered, the 
current EPROM version is loaded to all the HSE modules of the controller 
concerned.

If you are using a redundant station you should specify both addresses (IP address 1 
and IP address 2) and/or both host names.

I/O EPROM Import

Current versions of EPROMs for the Rack I/O modules can be imported to the PC 
from a floppy disk or a file directory. 

Enter the drive name and/or directory path or select the directory where the I/O 
EPROM files are located, using the browser button.

When the Import button is clicked all I/O EPROM files are imported from the 
specified directory into the system.

To load the I/O EPROMs into the appropriate modules you must select the I/O 
modules and start the load instance in the commissioning mode of 
Control Builder F.
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Page Layout

tb500_34.bmp

This dialog enables the printed page layout to be specified for the project 
documentation.

Dimension/Message Text

Language

The selection list contains the language abbreviations of the files with the 
dimensioning and message texts, which have already been installed on your PC. 
When these are installed, a file “digit<language>.str”, e.g. digitus.str, is copied into 
the installation directory. A language code should be selected, and the
corresponding file will then be copied to “digitool.str”. The texts of this file are used 
when creating the user program in Control Builder F and when loading the program 
to the operator station.
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Select the language that will be used in the operator station.

Import

The Load button loads all files with the name “digit<language>.str” from the 
specified directory into the installation directory; these files can then be made 
available to Control Builder F through the Language setting dialog.

The default files can be modified using a text editor. The file structure cannot be 
altered.

The texts are defined as follows under the section [PARA]:

DIMENSION_0 = dim_text1
DIMENSION_1 = dim_text2
DIMENSION_2 = dim_text3
...

NOTIFICATION_0 = messagetext1
NOTIFICATION_1 = messagetext2
NOTIFICATION_2 = messagetext3
...

Use this dialog if you have adapted the standard file to your project requirements 
using a text editor.

Selection is only possible, if more than one language is installed.
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Settings for DigiVis

tb500_23.bmp

Resource ID Several software packages can be run at the same time on a PC. To 
enable these software packages to be addressed unambiguously, 
each one must be assigned a unique number, the resource 
identification number.
All the resources within a Control Builder F project must also have 
a unique resource ID.

Recover DigiVis System Security
This is only necessary if the message “DigiVis system security 
corrupted! Please use the Configure tool to recover” appears when 
DigiVis is started, e.g. after network software has been re-installed.
A message is displayed when system security has been successfully 
restored.

DigiVis Autostart

DigiVis can be installed such that it is launched automatically after Windows starts.
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Yes, start DigiVis automatically (Recommended)
PC is restarted, windows logs in automatically with Auto Logon 
user and DigiVis is launched.
Only those applications that have been started before the start of 
DigiVis can be reached by the DigiVis user by means of ALT+TAB 
keys.

No, start DigiVis manually
DigiVis will not be started automatically. DigiVis can be started 
using the Start menu.

Printer Settings

Two printers are supported per operator station. One printer should be used for the 
continuous output of the signal sequence log. The other printer is then available for 
printing the operation logs or disturbance course logs. One of the two printers is also
used for hard copies.

Printer 1 Choose a printer installed under Windows, e.g. for continuous 
stationery.

Printer 2 Choose a printer installed under Windows, e.g. a color printer.

Hardcopy Printer 1 / 2
Choose one of the installed printers to output a hardcopy from the 
operator.

Margins of Printer 1/2 in cm
The page layout for the two installed printers is defined.

Settings for DigiBrowse

The dialog is used to specify whether or not the user can delete archive files within 
Browse.

For hardcopies do not choose a printer which is used for producing signal 
sequence logs.
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Settings for DDE

Resource ID Several software packages can be run at the same time on a PC. To 
enable these software packages to be addressed unambiguously, 
each one must be assigned a unique number, the resource 
identification number.
All the resources within a Control Builder F project must also have 
a unique resource ID.

Settings for OPC Server

tb500_26.bmp

New resource ID
During the installation the OPC-Server software is installed on the 
PC, but no instance is created. Enter the resource ID under which 
the OPC Server shall be executed.

DDE is supported with Freelance Systems running on Windows XP and not 
supported with Freelance Systems running on Windows 7.
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Several software packages can be run at the same time on a PC. To 
enable these software packages to be addressed unambiguously, 
each one must be assigned a unique number, the resource 
identification number.
All the resources within a Control Builder F project must also have 
a unique resource ID.

Add After entering a resource ID, this button is used to create an instance 
of the OPC Server. In this way you can create several OPC Server 
instances on one PC.

Configure Separate Alias ID
In addition to the resource ID which is used for communication 
within a Freelance projects, a second resource ID can be 
configured. To establish a redundant OPC connection for an 
Operate IT Process Portal A operating system, two different 
resource IDs are required. This checkbox must not be selected for 
standard applications.

Existing Resources
The list shows the resource IDs of the OPC Server F instances 
created on this PC.

Configure Allows to run the OPC Server selected in the list with another user 
account.

Remove When a list entry is selected, this instance of the OPC Server F is 
deleted.

Deleting the last instance of the OPC Server F on a computer does not 
automatically delete the OPC Server software.
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Settings for Trend Server 

tb500_28.bmp

Trend-Server Resource ID
During the installation the software is installed on the PC, but no 
instance is created. Enter the resource ID under which the Trend 
Server shall be executed.
Several software packages can be run at the same time on a PC. To 
enable these software packages to be addressed unambiguously, 
each one must be assigned a unique number, the resource 
identification number.
All the resources within a Control Builder F project must also have 
a unique resource ID.

Change ID An instance of the Trend Server is created after entering a resource 
ID. If you want to use the Trend Server under a different resource 
ID, edit the displayed number before once more pressing the 
Change ID button.
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If you want to delete the Trend Server from the local PC, delete the 
displayed number before pressing Change ID.

Configure Allows to run the Trend-Server with another user account.

Confirm Changes

Once all the settings have been made, click OK accept all changes and to finish the 
Configure tool.

Installation Complete
We wish you every success using Freelance to perform your automation tasks. 
Control Builder F will greatly reduce the effort required. Not least because of 
standards such as Windows and IEC 61131-3, this is an innovative product which is 
setting standards in this field through its use of a common database for configuring 
the user programs and for display.

Should you have unexpected problems during installation, please contact your local 
Freelance provider or your local ABB office.

Checking the Installation with Check
The test program Check can be used to check the installation.

> Start > All Programs > ABB Industrial IT > Freelance V9.2SP1
> Tools > Check
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tb005.bmp

Check > All Components initiates a full test of all the installed Freelance  
components. All the files that have been installed are checked.

The Check program can also be started from Control Builder F from the menu item 
Help / Info / System information.

A test log can be output, allowing you to compare the nominal status and the actual 
status. The log can be output to a file or a printer.

OPC Tunnel
The OPC Tunnel is a new feature introduced in Freelance version 9.2. The tunnel 
simplifies the communication and configuration between OPC servers and their 
clients in a distributed environment. This software is used to communicate between 
the DigiVis nodes and OPC/Trend servers as well.
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The OPC Tunnel Software has three major components: OPC Tunnel Client, OPC 
Tunnel Server and OPC Tunnel Configurator.

Tunnel Architecture.bmp 

The OPC Tunnel Client side is integrated into the Control Builder F and DigiVis and 
will start automatically.

The OPC Tunnel Server has a separate configuration tool which is not part of 
Control Builder F or DigiVis.

The OPC Tunnel Configurator is used to setup the communication parameters of the 
tunnel.

Installation of OPC Tunnel Server

The Freelance setup installs the OPC Tunnel if the checkbox against it in the 
“Workplace Type” dialog is selected.

tb500_2.bmp
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Configuration of the OPC Tunnel

To start the OPC Tunnel Configurator:

The following dialog shows up:

Tunnel Configurator.bmp

This dialog is used to specify the Prog ID of the OPC DA and OPC AE servers and 
the port numbers that are used for these services.

The OPC Tunnel server must always be installed on the same PC as the OPC 
server.

> Start > Programs > ABB Industrial IT > Freelance > OPC Tunnel > 
Configurator

The Freelance OPC Server names are:

DA Server: Freelance2000OPCServer.<ResID>
AE Server: Freelance2000OPCAEServer.<ResID>

The last two digits <ResID> of the Prog ID is the unique resource ID assigned to 
the server.

The default port for the Tunnel is 9950. If the user changes this, then the 
corresponding changes have to be made in the OPC Gateway D-GS resource 
configuration (P-Tree).

The Trend Server does not use AE items.
In case of a Trend Server the DA server must be configured and AE server should 
be empty.
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Click on OK to save the values.

Now restart the OPC Tunnel:

OPC Tunnel System Tray

Easy access to the OPC Tunnel configurator is made possible by starting the OPC 
Tunnel System Tray.

The status of the OPC Tunnel is indicated by an icon in the windows tray. The OPC 
Tunnel components can be reached by using the right mouse click on this icon as 
shown below.

Tunnel System Tray.bmp

Diagnostics of the OPC Tunnel

Diagnostic data of the OPC Tunnel can be captured in a log file using this 
functionality of the Advanced Configurator.

If not already running, start the OPC Tunnel System Tray with

> Start > All Programs > ABB Industrial IT > Freelance > OPC tunnel > 
System Tray

In the task bar tray right click the OPC Tunnel System Tray icon.

Select Restart Server

It is necessary that the OPC Tunnel must be restarted when there is a change in 
the tunnel configuration.

Start > All Programs > ABB Industrial IT > Freelance > OPC tunnel > 
System Tray

Start > All Programs > ABB Industrial IT > Freelance > OPC tunnel > 
Advanced Configurator
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Tunnel Diagnostics.bmp

FTP Server
DigiVis and ControlBuilder F have built-in FTP Clients. For some features like 
automatic archiving an FTP server can be used. This chapter explains the basic 
installation of an FTP server.

The recommended FTP server to use together with Freelance is the Microsoft FTP 
server. It is delivered with certain versions of Windows and can be installed via the 
Windows “Add or Remove Programs” control panel. It runs as a service process and 
uses the maintenance infrastructure of the internet information server.

This functionality is recommended to be used only by L3/L4 support personnel 
or by advanced users of the system.

The log files (E.g. Trace.txt) are first created in the path <Freelance_Installation_ 
Folder>\OPCTunnel and the paths for the same are specified in the Diagnostics 
Window.



Section 2  Freelance Installation FTP Server

3BDD012560R0503_Getting_Started 85

 

E
n

g
lis

h
D

eu
ts

ch

For data safety reasons, it is recommended to run the FTP server on a separate 
machine within the controller network. A typical network setup could look like this:

FTP Scenerio.bmp

The following chapters about FTP server installation and configuration are kept as 
simple as possible. The intention is to give a working starting point that can be 
customized as required.

For security reasons use a specific FTP login user with limited rights for FTP 
server login. For example create a Windows user called “FreelancerFTP” for that 
purpose on the machine that hosts the FTP server.

Use a unique password for FTP operations.

It is not necessary to create this Windows user on the FTP client machines.

The FTP user must have all access rights to the FTP server root directory and all 
subdirectories on file system level. Otherwise it may not be possible to read or 
write files.

In the described basic configuration FTP passwords are transmitted as clear text 
over the network.

Clarify a secure FTP setup with the network and system administrators.
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FTP Server under Windows XP

FTP Server Installation 

The FTP server is installed now.

> Start > Control Panel > Add or Remove Programs
Click on the Add/Remove Windows Components icon
Select the Internet Information Services (IIS)
Click on the Details... button
Check File Transfer Protocol (FTP) Service
Ensure that the Internet Information Services Snap-In is checked as well
Click OK
Click Next
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FTP Server Configuration

FTP WinXP Default FTP Site.bmp

Right-click Default FTP Site and select Properties. The configuration dialog for 
the FTP server is displayed now.

> Start > Control Panel > Administrative Tools
Double-click Computer Management
Expand Services and Applications > Internet Information Services > FTP 
Sites > Default FTP Site.
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FTP WinXP FTP Security.bmp

Click the Security Accounts tab.
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Clear the check box Allow Anonymous Connections to disallow anonymous 
access.

FTP WinXP Default FTP Site Properties.bmp

Click the Home Directory tab.

Select an appropriate FTP Site Directory directory.

Check all three access levels Read, Write and Log visits.

Click OK to finish the FTP server setup. The basic FTP server configuration is 
complete now.

The FTP login user - e.g. “FreelancerFTP” - must have the necessary access 
rights to the FTP site directory - here “D:\FTP” - and subdirectories on file 
system level. Otherwise he might not be able to read or write files, even if the 
server allows it.
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FTP Server under Windows 7

FTP Server Installation.

FTP Server Win7 Windows Features.bmp

The FTP server is installed now

> Start > Control Panel > Programs > Programs and Features 
Click Turn Windows features on or off in the left navigation bar.
The Windows Features are displayed.
Expand Internet Information Services > FTP Server and Select FTP Server
Expand Internet Information Services > Web Management Tools and select 
IIS Management Console
Click OK
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FTP Server Configuration

The IIS Management Console is displayed. It has a left tree area named 
“Connections”, a right area called “Actions” and context dependent area in 
the middle..

A wizard to configure an FTP site opens.

FTP Add FTP Site us.bmp

Enter the FTP site properties:

> Start > Control Panel > System and Security > Administrative Tools
Double-click Computer Management
Expand Services and Applications > Internet Information Services

> In the Connections tree, expand the root node
> Select Sites
> Right-click on Sites and then select Add FTP Site....
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FTP site name:
Enter a free choosable name your site, e.g. “Default FTP Site”.

Content Directory:
Select a root directory path for the FTP site. Below this directory all 
content of the FTP site is stored.

Click Next.

The Bindings and SSL Settings can be configured now. 

FTP Binding and SSL figure us.bmp

Select No SSL instead of Require SSL.

Click Next to continue the wizard.
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The Authentication and Authorization Information page is shown.

FTP Basic Authentication us.bmp

Enable Basic Authentication.

Under Authorization, select All users from the Allow access list.

Under Permissions, select both Read, Write.

Click Finish. The basic FTP server configuration is complete now..

Enable FTP Firewall Rules

When the FTP server is installed the Windows Firewall with Advanced Security will 
still block all external FTP traffic. To prepare external access, the FTP server 

The FTP login user - e.g. “FreelancerFTP” - must have the necessary access 
rights to the FTP site directory - here “D:\FTP” - and subdirectories on file 
system level. Otherwise he might not be able to read or write files, even if the 
server allows it.
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installer has added 5 preconfigured firewall rules, 3 inbound and 2 outbound, which 
need to be enabled.

Open the configuration dialog of the Windows Firewall with Advanced Security.

Enable the following inbound rules:

1. FTP Server(FTP-In)

2. FTP Server Passive(FTP Passive Traffic-In)

3. FTP ServerSecure(FTP SSL Traffic-In)

FTP Inbound FTP Rules Windows 7.bmp

Enable the follwoing outbound rules:

1. FTP server(FTP Traffic-Out)

2. FTP Server Secure(FTP SSL Traffic-Out)

> Start > Control Panel > Administrative Tools > Windows Firewall with 
Advanced Security

> Select Inbound Rules

> Select Outbound Rules
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FTP Outbound FTP Rules Windows 7.bmp

Restart the Windows service Microsoft FTP Service:

The FTP server is now restarted and the firewall will use the exception rules now.

Testing the FTP Server

To test the FTP server functionality:

Logon with an FTP client (e.g. the Windows ftp command line client or FileZilla), 
from another windows PC using the created limited user (e.g. “FreelancerFTP”) for 
login.

Upload a file.

Download a file.

Now the FTP based functionality in Control Builder F and DigiVis can be 
configured and used.

If the FTP server is initially installed, the firewall still blocks the traffic until the 
service of the FTP server is restarted.

> Start > Control Panel > System and Security > Administrative Tools
> Double-click Services
> Select Microsoft FTP Service
> Click Restart the Service
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Java Installation
Java is used to display Applets in a Web-Browser. It is necessary, if the following 
advanced functionality is needed:

• Using the Telnet-Applet in the controller web interface (e.g. AC800F)

• Using the Java GUI of the controller emulator

Preconditions

Internet Explorer 8

Installation

Java 6 Update 20 or higher is recommended.

Download the Java Runtime Environment (JRE) from the website, www.java.com 
and install it.

Test Java

To Test the Java installation one can utilize the controller emulator. Start the Internet 
Explorer and open the Controller Emulator Manager. If the controller emulator is 
running on the local machine it can be found at http://localhost:8888.

Start a controller emulator station and click the GUI Window of the station to view 
the Java GUI.

Accessing the controller emulator manager or the web interface of a process 
station may fail, if an internet proxy is configured.

To exclude specific IP addresses from being accessed via the proxy;

Start the Internet Explorer

> Tools > Internet Options > Connections > LAN settings

Press the Advanced button.

Enter the IP addresses or IP address patterns that shall not be accessed via an 
internet proxy.
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Section 3  Initial Steps

General Notes
Once you have carried out the installation of Control Builder F as described in the 
preceding section, you can immediately begin to set up a project.

Use the Start menu to launch Control Builder F.

If your hard key is not attached, or if you have not installed a license file, a message 
will be displayed to that effect. Correct the cause of the problem and relaunch the 
program.

The version details of the installed software are displayed in the “About Control 
Builder F” window. Confirm this dialog using the OK button.

Creating a Project File
Choose New from the Project menu and specify a file name for saving your project 
on the hard disk. The default directory used is <Freelance_Installation_Directory 
>\proj, but you may choose a different directory if you wish.

Once you have specified a unique file name a further dialog appears, allowing you 
to enter general project data such as project number, person in charge, customer etc. 
This data can also be entered or modified at any time in the future. When this dialog 
is confirmed with the OK button an empty project file is created.

The first step of the configuration process involves setting up the software view for 
the project. This means that tags, variables and the functions to be calculated are 
defined.

In a second step this configuration is assigned to the existing hardware, that is the 
process stations and I/O units.
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Step 1: Configuring the Software View of the Project
Once you have defined the general project data you can choose the Configuration! 
menu or use the corresponding tool bar button to reach the software view of the 
configuration, the project tree.

The project tree displays the functions of a project in a clear format. The individual 
elements or objects, generally known as project elements, are structured in 
accordance with IEC 61131-3. To develop a project tree, select a node in the tree 
and choose Insert next level / Insert below or  Insert above from the menu, or use 
the insertion options directly from the context menu. According to which node is 
selected in the project tree, you will be presented with a list of objects which can be 
inserted at that position in the tree.

The uppermost element in a project is the Configuration CONF, which is the sum 
total of all the project elements in a Freelance system. 

The first structural level below the configuration is formed by the resources, which 
represent the various different stations in a project. For the processing of the process 
itself there are the D-PS (process station) resources, for operation and observation 
of the process there are the D-OS (operator station) resources, for interfacing to 
external systems there are the D-GS (gateway station) resources, and for 
integrating data from external systems there is the OPC-S (OPC server) resource.

Insert a process station below the configuration node. One can choose between a 
redundant (D-PS/RED) or non-redundant (D-PS) process station to add. Further 
specification, e.g. whether a rack-based station or an AC 800F is used, is performed 
later in the hardware structure.

Insert a D-PS process station now and name it “PS”.

Once a name has been assigned to the resource, its basic structure is added to the 
project tree. Below the resource node, system functions and user-defined functions 
are organized in the two task lists <Res-Name>.SYSTask and <Res-
Name>.USRTask.

Configuration of the system task provides an opportunity to define the response of 
the process station to specific situations such as cold start, warm start and 
redundancy transfer.
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Below the node USRTask the user defined functions are specified which are to be 
executed in the process station. These functions can be executed in different tasks. A 
task is represented as a separate node in the project tree.

A Default Task can be set up. This task is always executed when none of the other 
tasks is being calculated. Besides the Default Tasks other tasks can be created. 
Typically each task is processed repeatedly in Interval Mode with a configured 
time interval -the task Cycle time.

Now create a Task.

PL programs (program lists) and SFC programs (sequential function chart 
programs) are specified below each task. The actual functions in programs are 
configured below a program list.

Create a program list with an IL (instruction list) program below it. For example, 
enter the following program (creation of a saw-tooth curve):
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first01us.bmp

While you are entering data you will prompted to define the variables being used. 
You should define the variables Init and UP with data type BOOL, and Counter 
with data type INT.

To check the program choose IL program > Check from the menu. Any errors that 
may be detected are shown in a list. Double-clicking on an error message will take 
you automatically to the place where the error has been detected. Correct the 
error(s) and run the plausibility check again.

Clicking Back will return you to the project tree. Another program should now be 
used to monitor the current count and generate an alarm message if required.
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Add another FBD (function block diagram) program below the IL program. Double-
click on the program or click on Edit to move to the FBD editor.

Select an analog monitoring function block M_ANA from the Function Blocks 
menu and define Parameters for it by specifying a name, setting the scaling from -
100.0 to 100.0 (in accordance with the counter in the IL program), and define up 
to 4 limit values. Example of a completed parameter mask:

first02us.bmp

Place a variable in the FBD sheet. To do so, choose FBD elements > Variable read 
from the menu (the variable Counter should be read and linked with the input IN of 
the monitoring block). You can enter the variable name directly in the parameter 
mask, or use the F2 key to choose it from a list. Before linking the variable Counter 
with the function block’s input pin IN, its data type must first be converted from 
integer to REAL. This is done by choosing the converter block TO_RE (to REAL) 
from the menu: Blocks > Converter > Data type to REAL.

Draw a line from the variable to the converter’s input and from the converter’s 
output to the function block’s input IN: Context menu > Draw lines. 

The processing sequence is shown in the lower right corner of the function blocks. It 
is not correct and needs to be adjusted. Open the parameter mask for the analog 
monitoring block (Right click > Parameters...) and change the sequence from 
1 to 2. The processing sequence for the converter block will be automatically 
adjusted to 1.
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Your program could then look something like this:

first03us.bmp

Choose FBD program > Check from the menu to validate the plausibility of the 
program. 

Now Save the program and Exit the FBD editor. After exiting the FBD editor you 
will return to the project tree view. 

Now check the plausibility of the project tree. Selecte the top most node and click 
Project > Check All.

Any errors that may be detected are shown in a list. Double-clicking on an error 
message will take you automatically to the place where the error has been detected. 
Correct the errors and check the project for plausibility again.

 Step 2: Configuring the Hardware Assignment
To configure the hardware in the project, choose Hardware structure from the 
System menu or click the relevant button on the tool bar. 

The hardware editor shows two representations of the hardware in the project. In the 
left-hand section of the screen all the hardware is represented in a tree view, while 
the right-hand section contains a graphical view of the currently-selected object.

A project with no hardware configuration is displayed as follows:
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first10us.bmp

The computer displayed represents the configuration PC (Control Builder F), and 
cannot be modified. The yellow line represents the system bus. Portrayed below the 
system bus are the process stations, while above the bus - adjacent to the 
configuration PC - are the configured operator- and gateway stations.

The project hardware is configured as follows:

• Select object in the tree structure and choose Insert... from the Edit menu

or

• Select object in the tree structure and choose Insert... from the context menu

or

• Click on an unoccupied position in the graphic view (your selection will be 
indicated by a dashed red border) and double-click the left mouse button.

The following dialog presents a list of objects which can be inserted at the selected 
position.

Now insert a process station in accordance with the available hardware.
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The hardware and software components of the project are integrated by selecting the 
hardware and the choose Resource allocation... from the Edit menu to assign a 
resource.

Now select the process station and assign the “PS” resource from the project tree.

The network configuration dialog (Menu: Hardware structure > Network) allows 
the stations’ resource ID and IP address to be defined. Select the process station and 
click Edit. Enter a unique resource ID for your station and its IP address. Close the 
network configuration with OK.

Usually no changes to the default boot parameters of the process station are 
necessary. If you need to edit them nevertheless, select the process station in the 
hardware manager. Then select Edit > Parameters.... The Boot Parameters of a 
process station can now be modified. Close the hardware parameters dialog.

To validate the plausibility of the hardware configuration select Hardware 
structure > Check all. No errors should be shown in the Plausibility check error 
list.

Now save the changes with Hardware structure > Save and exit the hardware 
manager with Hardware structure > Exit. 

Select the uppermost node in the project tree and check the plausibility of all project 
data. When the Project > Check all menu item is chosen, all objects below the 
selected node are checked. The menu item Project > Check leads to only those 
objects being checked which are displayed with a pink node.

Step 3: Commissioning
Once any errors that the plausibility check reported have been rectified, the project 
can be commissioned. Choose Project > Commissioning to switch from 
configuration to commissioning mode.

When switching to commissioning mode, Control Builder F attempts to establish a 
communication link with all the configured stations. As well as the resource nodes, 
the current states of the connections are indicated in the project tree.

In a newly-installed system the boot EPROM will have been loaded into the process 
station in the course of the installation process. If the IP addresses and subnet masks 
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have been configured correctly, then the project tree node for the process station will 
be labeled “No operating system”. Other states include:

• “Running”: Operating system or configuration has been loaded.

• “Version error”: The configuration in the process station belongs to another 
project or is outdated.

• “Wrong DMS version”: The version of communication software in the 
process station is different from the Control Builder F version. With the 
configuration tool “Configure”, the current boot EPROM must be loaded into 
the process station first.

An arrow before the node indicates that the data for the node is not yet available on 
the associated hardware and still needs to be loaded.

Select the resource node of the process station and open the context menu. If 
commissioning for the first time, choose Load > Whole station. Changes and 
enhancements to the configuration can be loaded into the process station 
retrospectively with Load > Changed objects.

If the load operation has concluded successfully, the nodes in the project tree will 
appear green and the load arrows will be removed.

Step 4: Testing the Configuration
In commissioning mode there are various different options in Control Builder F for 
testing and checking the current project configuration. Select an object and double-
click on it to open it. As in the configuration phase, the relevant editor is then 
opened. It is not possible to modify the configuration here, but the current values 
can be checked and to a certain extent influenced.

IL Program

If an IL program has been loaded into a process station and executed there, then the 
IL editor can be opened in Control Builder F commissioning mode. For each step in 
the calculation, the current values for variables are displayed before the comment 
column. Boolean variables are displayed as F for FALSE and T for TRUE.
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FBD Program

If an FBD program has been loaded into a process station and executed there, then 
the FBD editor can be opened in Control Builder F commissioning mode. The 
current value can be read from the connecting lines.

Lines for data of type BOOL are solid for the value TRUE and dashed for the value 
FALSE.

The cursor can be moved to all other lines. The current value is shown in the form of 
a data tip.

The current values for a function block pin are shown when the cursor is moved to 
it.

Value Window

The value window can be used to provide a lasting display of a value. Another 
window is displayed. Choose Windows > Show value window to open the value 
window.

Once a variable, a data flow line or a function block pin has been selected in an 
editor or a list, Enter variable... can be chosen from the context menu or the 
Windows menu. The format for displaying the value is chosen in another dialog. 
After this dialog has been confirmed, the variable will appear in the value window. 
The value displayed is updated once per second.

Step 5: Saving the Project Data
The Control Builder F project data can be saved in the binary format (Control 
Builder F project file, PRO) or as text file (comma separated values, CSV). The 
standard format is binary. For data exchange purposes projects can be exported as 
csv-text file.

To save a project:

• In the project overview: Project > Save

• In the project tree: Project > Save

To export a project:
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• In the project overview: Project > Export...
A file name for the csv file must be entered then.

Archived and exported projects provide additional data safety and recovery options. 
Export files are needed for the product upgrade procedure.

Step 6: Configuring an Operator Station
The DigiVis software must be installed on a computer connected to the Control 
Builder F through a network. The DigiVis software can also be installed along with 
the Control Builder F software on the same PC.

To create an operator station in Control Builder F, switch back to configuration 
mode and to the project tree view. Select the process station node. Choose Edit > 
Insert below to display the list of possible resource types. Choose Operator 
station D-OS and specify a name.

Move to the hardware structure and select the uppermost node in the tree. Choose 
Edit > Insert to display the list of possible resource types. Choose VIS Operator 
station and click OK. Specify a name and the mounting position for the new 
hardware. The predefined values can be accepted with the OK button.

Select the new resource in the tree or in the graphic view, then choose Edit > 
Resource allocation.... Select the software resource that you defined previously and 
assign it to the hardware.

As with the process station, the IP address or host name and the resource ID must be 
configured for the operator station. In the Hardware structure > Network dialog 
enter the IP address or hostname and the resource ID you defined when installing 
the DigiVis software. Click OK to apply you changes.

Check the hardware plausibility by selecting the topmost hardware node and then 
Hardware structure > Check.

Save your changes and exit the hardware manager. Back in the project tree view 
select the uppermost node in the project tree and check the plausibility of the project 
data with Project > Check.
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Step 7: Commissioning the Operator Station
Once any errors that the plausibility check reported have been rectified, the project 
can be commissioned. Choose Project > Commissioning to switch from 
configuration to commissioning mode.

As well as the resource nodes, the current states of the connections are indicated in 
the project tree. If not already done, start DigiVis now on the operator station PC.

The process station should be flagged with the connection status running, and the 
operator station with Version error. If the DigiVis software is running or not 
reachable via the network, then No connection will be reported for the operator 
station.

Select the node for the process station and choose Load > Changed objects; then 
select the node for the operator station and choose Load > Whole station.

Switch to running DigiVis on the operator station. Choose Display > Faceplates. 
The Tag-List is displayed. The name of the M_ANA function block is displayed in a 
list. Select the name of the function block to display its faceplate.

In the M_ANA faceplate the increasing and decreasing value (saw tooth) is 
visualized with a green bar. Alarms are listed in the Message list! along with their 
current time stamps, when the value reaches the defined limits.

You have mastered the first steps with Freelance. You have learned how how to 
write a simple program, run it on a process station, visualize its state and display 
alarms. Congratulations.

Step 8: Working with Tag Types and OPC Items
This step is only for those users who would like to create and use Tag Types with 
OPC Items in their projects.

Tag Type Library

(1) Create a TagType_Lib (TAG-LIB) Node in the Project Tree under CONF.
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(2) Import the example Tag Type Library.

The Tag_Type_Li00 Library gets added under the Pool node in the project tree. 
Drag and drop it under the CONF node in the project tree below the TagType_Lib 
node. The library may now be used in the project

Alternatively

Create your own tag type library.

OPC Tunnel Configuration

• Select the OPC tunnel configurator. 

• Specify the PROG IDs of DA/AE servers and the port number of the service. 
The default values are as shown below. 

• User may use the default settings or change them as required.

• The last two characters of the PROG ID represents the unique resource ID 
assigned to the OPC server.

OPC Tunnel_configurator.bmp

Edit > Import Block
Browse the file C:\Program Files\ABB Industrial 
IT\Freelance\export\FreelanceSampleTagTypeLib_V1.0.prt
Click Open

If not already done, install the OPC Tunnel on the PC where OPC server is 
installed. Select the OPC Tunnel Server option in the “Workplace type” screen 
while running the Freelance installation. 
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OPC Server Configuration in CBF

Specify the IP address of the PC on which the OPC Tunnel is installed. The port 
number is the same as the one used for the OPC tunnel configuration (9950). 

OPC_First_Steps_OPC_Config.bmp

Project tree > Right-click on CONF (CONF) > Insert next level > Select OPC 
Server OPC-S > Click OK. 

Configuration dialog is displayed.

Enter Name (Eg. OPC1), Location, where OPC server is running.
Double-click the OPCS node
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Browsing and adding items to the OPC Item list

OPC_First_Steps_OPC_Item_List.bmp

Open OPC Item List and click Synchronize. Select the required OPC server from 
the list and click on OK. This will import all the OPC items from the OPC server 
into the OPC Item List.

Project tree > System > OPC Item List
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OPC_Server_Synch.bmp

The OPC Item List is thus populated with items from the OPC server.

OPCitem_browsed.bmp
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Instantiate Tags 

Instantiate Tags using the Instantiate All button in the OPC Item List. This will 
match the OPC Items (the “selector” part of the OPC Item name after the separator) 
in the Item list with that in the Tag Type library and lists the Tags using Tag Type 
selector matching. The list of tags with proposed tag names are listed in a Rename 
dialog as shown below

OPC_Server_Rename.bmp

Specify the Tag names for these OPC items in the New name column and click on 
OK. The tags linked to the corresponding OPC Items are created in the Tag list.

Assign Variables

Select the OPC Items from the OPC item list that are to be used in free graphics/ 
trends and assign variables to them. A new window suggesting variable names for 
the OPC item opens as below.
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OPC_Items_Assign_Variable.bmp

Specify the required “variable name” in the New name column and click on OK. All 
the OPC Items with the suggested name will be assigned as a variable in the 
variable list.

User can configure free graphics and Trend from the Tags and Variables created 
above.
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Hinweise zu diesem Handbuch

Vorsicht-, Achtung-, Information- und Tipp-Symbole
In diesem Dokument werden die folgenden Hinweise verwendet, um für die 
Sicherheit relevante und andere wichtige Informationen hervorzuheben: Vorsicht, 
Achtung und Information. Daneben existieren Tipps, um dem Leser nützliche 
Hinweise zu geben. Die zugehörigen Symbole haben folgende Bedeutung:

Obwohl die mit Vorsicht bezeichneten Gefahren auf mögliche Personenschäden 
hinweisen und die mit Achtung bezeichneten Gefahren auf mögliche Sachschäden 
hinweisen, beachten Sie, dass die Benutzung beschädigter Ausrüstung zu 

Stromschlag-Symbol: Weist auf Gefahren durch Stromschlag hin.

Vorsicht-Symbol: Weist auf Gefahren hin, die zu Personenschäden führen 
können.

Achtung-Symbol: Weist auf wichtige Informationen oder Warnungen in 
Zusammenhang mit dem im Text erläuterten Thema hin. Kann auf Gefahren 
hinweisen, die zu Software-Datenverfälschungen oder Sachschäden führen 
können.

Informations-Symbol: Weist den Leser auf wichtige Fakten und Voraussetzungen 
hin.

Tipp-Symbol: Weist auf Ratschläge hin, z.B. zum Projektentwurf oder zur 
Nutzung einer bestimmten Funktion.
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Personenschäden, d.h. zu Verletzungen und auch zum Tode führen kann. Beachten 
Sie daher unbedingt die mit Vorsicht und Achtung gekennzeichneten Hinweise.

Typographische Konventionen
Texteingaben, Tastenkombinationen, Eingabeaufforderungen, Systemmeldungen, 
Menüeinträge, Bildschirmelemente etc. entsprechen den Microsoft Windows 
Konventionen.

Schreibkonventionen
Zur Unterscheidung der verschiedenen Textelemente dienen in diesem Dokument 
die folgenden Konventionen:

• Die Wörter in Elementen der Benutzeroberfläche (z. B. die Titelleiste von 
Fenstern oder die Feldbezeichnung in einer Dialogbox) beginnen mit 
Großbuchstaben.

• Großbuchstaben werden für die Bezeichnung von Tasten verwendet, wenn 
diese auf der Tastatur benannt sind. Beispiel: Drücken Sie die ESC-Taste.

• Kleinbuchstaben werden für die Bezeichnung von Tasten verwendet, die auf 
der Tastatur nicht benannt sind. Beispiel:  die Leertaste, die Tabulatortaste,  
etc.

• Drücken Sie STRG+C bedeutet, dass Sie die CTRL-Taste gedrückt halten 
müssen, während Sie die Taste C drücken (in diesem Beispiel wird ein 
angewähltes Objekt kopiert).

• Drücken Sie ESC E C bedeutet, dass Sie die angegebenen Tasten nacheinander 
in der angegebenen Reihenfolge drücken müssen.

• Die Bezeichnungen von Schaltflächen bzw. Buttons werden fett 
hervorgehoben. Beispiel: Klicken Sie auf OK.

• Die Bezeichnungen von Menüs und Menüeinträgen werden fett dargestellt. 
Beispiel: das Datei-Menü. 

– Die folgende Darstellungsweise wird für Menüaktionen verwendet: 
MenüName > MenuEintrag > UnterMenüEintrag. Beispiel: Wählen Sie 
Datei > Neu > Typ.
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– Das Start-Menü bezeichnet immer das Start-Menü auf der Windows-
Taskleiste.

• Eingabeaufforderungen und Systemmeldungen werden in der Schriftart 
Courier dargestellt; Eingabe und Antworten des Anwenders werden in der 
Schriftart Courier fett dargestellt. Wenn Sie z. B. eine Eingabe machen, die 
außerhalb des zulässigen Wertebereichs liegt, wird die folgende Meldung 
angezeigt:

Der eingegebene Wert ist ungültig. Der Wert muss 
zwischen 0 und 300 liegen. 

Oder Sie werden aufgefordert, die Zeichenfolge TIC132 in ein Feld einzugeben. Die 
Zeichenfolge wird wie folgt in der Prozedur dargestellt:

 TIC132

Variablen werden mit Kleinbuchstaben dargestellt.

sequence name

Terminologie
Eine komplette und umfassende Terminologieliste finden Sie am Ende des 
Engineering-Handbuchs Systemkonfiguration. Diese Liste enthält 
Bezeichnungen und Abkürzungen, die ABB-spezifisch sind oder deren Gebrauch 
bzw. Definition von den in der Industrie üblichen Gepflogenheiten abweicht. Bitte 
machen Sie sich damit vertraut.

Zugehörige Dokumentation 
Die folgende Liste ist eine Übersicht über die gesamte Dokumentation zum 
Freelance-System. 

Titel Nummer

Montage- und Installationsanleitung, Control IT, AC 800F 3BDD012501Rxxxx

Montage- und Installationsanleitung, Control IT, AC 700F 2PAA103858Rxxxx

Montage- und Installationsanleitung, Rack-System 3BDD012603Rxxxx



Zugehörige Dokumentation   Hinweise zu diesem Handbuch

12 3BDD012560R0503_Getting_Started

 

E
n

g
lis

h
D

eu
ts

ch

Bediener-Handbuch, DigiVis Leitstation, klassische Oberfläche 3BDD012600Rxxxx

Bediener-Handbuch, DigiVis Leitstation, neue Oberfläche 3BDD011932Rxxxx

Bediener-Handbuch, DigiBrowse 3BDD012601Rxxxx

Neuerungen früherer Versionen 3BDD011933Rxxxx

Engineering-Handbuch, Systemkonfiguration 3BDD012503Rxxxx

Engineering-Handbuch, Konfiguration DigiVis Leitstation 3BDD012518Rxxxx

Engineering-Handbuch, Prozess-Station - AC 800F 3BDD012505Rxxxx

Engineering-Handbuch, Prozess-Station - AC 700F 2PAA103857Rxxxx 

Engineering-Handbuch, Prozess-Station - Rack-System 3BDD012520Rxxxx

Engineering-Handbuch, S700 Module 2PAA105800Rxxxx

Engineering-Handbuch, OPC-Server F 3BDD012511Rxxxx

Engineering-Handbuch, Trend-Server 3BDD012527Rxxxx

Engineering-Handbuch, IEC 61131-3 Programmierung 3BDD012504Rxxxx

Engineering-Handbuch, Integration Process Portal B 3BDD012521Rxxxx

Engineering-Handbuch, Zugriffsberechtigung 3BDD012513Rxxxx

Engineering-Referenzhandbuch, Funktionen und Funktionsbausteine 3BDD012514Rxxxx

Engineering-Referenzhandbuch, Kommunikation und Feldbusse 3BDD012515Rxxxx

Engineering-Referenzhandbuch, Protronic-Anbindung 3BDD012506Rxxxx

Engineering-Referenzhandbuch, DDE32 3BDD012507Rxxxx

Engineering-Referenzhandbuch, Fernwirkbibliothek f. IEC 60870-5 3BDD012509Rxxxx

Engineering-Referenzhandbuch, Interbus Bausteine 3BDD012510Rxxxx

Engineering-Referenzhandbuch, Kopplung Sartorius Waagen 3BDD012512Rxxxx

Referenzhandbuch, DMS / API 3BDD012508Rxxxx

Engineering-Handbuch, Freelance Bulk Data Manager 2PAA105801Rxxxx

Titel Nummer
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Kapitel 1  Lizenzierung

Einleitung
Für die Freelance-Software Version V9.2 SP1 wurde das schon vorhandene E/A-
Lizenzierungsmodell übernommen. 

Control Builder F
Der Control Builder F ist das Programmierwerkzeug für den AC 800F, AC 700F, 
und die klassischen Rack-basierten Controller wie DCP02 und DCP10. Auch das 
Engineering der Bedienkonsole DigiVis ist ein Teil des Control Builder Fs.

Den Control Builder F gibt es in folgenden Paketen:

• Control Builder F Standard

• Control Builder F Professional

Alle Ausbaustufen des Control Builder F unterstützen:

• Konfiguration und Inbetriebnahme der Anwenderprogramme

• IEC61131-3 Programmierung (FBS, AWL, KOP, ST, AS)

• Grafische Hardware-Konfiguration

• Integrierte Feldbus-Konfiguration Profibus, Foundation Fieldbus 

• IEC 61131-3 Datentypen und anwenderdefinierte (strukturierte) Datentypen 

• Projektweite Variablen und Funktionsbausteinliste 

Das Freelance-System 9.2 SP1 unterstützt beim Anschluss an den OPC-Server 
eines Fremdanbieters eine unbegrenzte Anzahl von OPC-Signalen. 

Ab Version 9.2 ist die Integration von OPC-Fremdsystemen kostenfrei. 
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• Online Cross-Reference

• Leistungsfähige Plausibilisierung

• Ausführliche Online-Hilfe 

Außerdem werden Online-Testfunktionen (Debugging) und eine durchgängige 
grafische Dokumentation des gesamten Anwenderprogramms unterstützt. 

Neben den Programmen sind alle Hardware-Komponenten grafisch dargestellt und 
werden zusammen mit der zugeordneten Software plausibilisiert.

Control Builder F Standard

Der Control Builder F Standard unterstützt:

• MSR-Namen mit bis zu16 Zeichen

• Anwenderdefinierte Funktionsbausteine (Runtime-Lizenz)

Control Builder F Professional

Der Control Builder F Professional unterstützt zusätzlich zu den Funktionen des 
Control Builder F Standard folgende Eigenschaften:

• Zugriffsberechtigung (Security Lock)

• Anwenderdefinierte Funktionsbausteine (Entwicklerlizenz)

• FDT/DTM-Support

• Tag Typ Bibliothek

Anders als bei DigiTool kann mit dem Control Builder F allein kein Programm 
erstellt werden, da die Lizenzierung der Funktionsbausteine nicht zum 
Lieferumfang des Control Builder F gehört. Hierfür müssen pro Controller 
zusätzlich Control-Software-Lizenzen erworben werden.
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Freelance Prozess-Stationen
Ab V6.2 ist für jede Prozess-Station eine Control-Software-Lizenz erforderlich. 
Control IT bietet zwei Lizenzarten. Diese unterscheiden sich in der Funktionalität 
und den unterstützten E/As. Die Lizenzarten umfassen:

• Control-Software-Lizenz Basic

• Control-Software-Lizenz Advanced

Diese Lizenzen können für jeden Controller getrennt in der Funktionalität an den 
Erfordernissen ausgerichtet und in Schritten zu jeweils 50 E/As im Umfang skaliert 
werden.  

Eine Control-Software-Lizenz umfasst:

• Die Freischaltung der spezifischen Bausteinbibliotheken für einen Controller

• Die Freischaltung im Control Builder F für eine bestimmte Anzahl von E/A-
Signalen (E/A-Komponenten), die in der Konfiguration des Controllers bzw. 
der Prozess-Station verwendet werden dürfen. 

Control-Software-Lizenz Basic

Die Control-Software-Lizenz Basic enthält folgende Bausteinbibliotheken:

• IEC 61131-3, Binär- und Analogwertverarbeitung

• Regler (ohne Selbsteinstellung)

• Profibus-Integration

• Integration von FOUNDATION Fieldbus (nicht unterstützt von AC 700F)

• DigiVis 

• Basis-E/As

• Serial Package Modbus Master, Modbus Slave 

• Serial Package Sartorius Waageninterface (nicht unterstützt von AC 700F)

Innerhalb eines System müssen alle Controller den gleichen Typ der Control-
Software-Lizenz haben: Die Nutzung von Controllern/Prozess-Stationen mit 
Basic- und Advanced-Control-Software in einem System wird nicht unterstützt. 
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• Serial Package Protronic Kopplung (nicht unterstützt von AC 700F)

• Tune (Selbsteinstellung PID)

• Sequence of Events (nicht unterstützt von AC 700F)

Optionen zur Control-Software-Lizenz Basic

Zusätzlich sind für die Software-Lizenz Basic folgende Optionen erhältlich:

• Batch-Bausteinpaket (PLI, FPX)

• Interbus (nur für Upgrade existierender Interbuskopplungen)

• Fernwirkbibliothek (IEC 60870-5-101)

• Maestro-UX-Kopplung

Control-Software-Lizenz Advanced 

Die Control-Software-Lizenz Advanced ermöglicht den Zugriff auf den Support für 
Process Portal A. Sie enthält zusätzlich zu den Bausteinbibliotheken der Basic-
Lizenz automatisch folgende Bausteinbibliotheken und Funktionalitäten:

• 800xA Operation, Process Portal A Support 

• Serial Package Modbus Master, Modbus Slave

• Serial Package Sartorius Waageninterface (nicht unterstützt von AC 700F)

• Protronic Kopplung (nicht unterstützt von AC 700F)

• Tune (Selbsteinstellung PID)

• Sequence of Events (mit Rack I/O)

• Erweiterte E/As

Optionen zur Control-Software-Lizenz Advanced

Die Mehrzahl der für die Basic-Lizenz zusätzlich erhältlichen Optionen ist in der 
Advanced-Lizenz bereits enthalten. Zusätzlich sind folgende Optionen verfügbar:

Bei einer nachträglichen Lizenzerweiterung von Basic nach Advanced können 
die vorhandenen Optionen zur Basic-Lizenz weiter genutzt werden. Zusätzlich 
stehen alle in der  Advanced-Lizenz enthaltenen Optionen zur Verfügung.
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• Batch-Bausteinpaket (PLI, FPX)

• Interbus (nur für Upgrade existierender Interbuskopplungen)

• Fernwirkbibliothek (IEC 60870-5-101)

• Maestro-UX-Kopplung

Weitere Control-Software-Optionen

Folgende Control-Software-Optionen stehen für die Basic- und die Advanced-
Lizenz zur Verfügung: 

• Open Communication Package (DDE, OPC)

• Trendserver

• Application Programming Interface (API)r

Lizenzierung der verwendeten E/As
Neben der Engineering-Software Control Builder F müssen für jeden Controller 
bzw. jede Prozess-Station sowohl die Anzahl der verwendeten E/As als auch die 
Optionen lizenziert werden.   

 DDE wird nur unterstützt, wenn das Freelance-System auf einem Rechner mit 
dem Betriebssystem Windows XP läuft. Unter Windows 7 steht DDE nicht zur 
Verfügung. 

Die Version Freelance 9.2 SP1 is kompatibel mit dem Betriebssystem Windows 
7. 

Wenn die Anzahl der verwendeten E/As in einem Projekt die Summe aller 
lizenzierten E/As der Prozess-Stationen übersteigt, kann das Projekt nicht mehr 
erfolgreich plausibilisiert werden. Damit kann die SW-Konfiguration nicht mehr 
in die Prozess-Station geladen werden.
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Für die Ermittlung der für die Lizenzierung relevanten Anzahl der E/As gilt, dass 
grundsätzlich nur die verwendeten E/As gezählt werden. Dazu zählen: 

• E/A-Komponenten, die in einem Programm verwendet werden, oder

• E/A-Komponenten, die nicht über ein Programm, aber über ein Gateway 
(OPC- oder DDE-Server) bereitgestellt werden.

Ein-/Ausgangsvariablendefinitionen sind abhängig vom Bus/Feldbus: 

• Rack-I/O (CAN-Bus): 
Jeder in einem Programm oder Gateway verwendete Kanal zählt unabhängig 
vom Datentyp als ein E/A. 

• Profibus: 
Alle E/A-Komponenten, die auf dem Controller vereinbart und in einem 
Programm oder Gateway verwendet werden, zählen jeweils als ein E/A. 

• Foundation Fieldbus:
Jede E/A-Komponente, die zwischen Linking Device und Controller/Prozess-

Mit dem Control Builder F können alle in einem Projekt verwendeten E/A-
Komponenten gezählt und angezeigt werden. Der Control Builder F kann CSV-
Dateien ab Version 8.x verarbeiten. Siehe Engineering Handbuch 
Systemkonfiguration, Lizenzstand-Anzeige. 

Es ist zu beachten, dass zur korrekten Ermittlung der nötigen E/A-Lizenzen auch 
alle Bausteine installiert sein müssen, die E/A-Verbraucher darstellen könnten. 
Zum Beispiel müssen FDT und nötige DTM installiert sein, wenn im Projekt 
DTM verwendet werden.
Generell gilt, dass nur ein fehlerfrei plausibilisiertes Projekt auch die  benötigte 
Anzahl an E/A-Lizenzen korrekt ausweist.

Alle bereits verwendeten E/As in einem geöffneten Projekt lassen sich auch im 
Hardware-Manager anzeigen:

Hardwarestruktur > Verwendete E/As anzeigen 

Wird ein und dieselbe Variable auf beide Arten verwendet, zählt sie dennoch nur 
als eine zu lizenzierende Variable. Mit anderen Worten: wie oft eine Variable 
verwendet wird, geht nicht in die Berechnung der erforderlichen E/A-Lizenzen 
ein. 
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Station übertragen wird und in einem Programm oder Gateway verwendet 
wird, zählt als ein E/A. 

• Modbus:
Alle Boolschen Daten (Coils) oder Register, die von Sende- und 
Empfangsbausteinen verwendet werden, zählen als ein E/A 

Nicht gezählt werden:

• Sende- und Empfangsbausteine

• Diagnosedaten (DP, PA)

• Alarme (FF)

• Parameter (PA, FF)

• Globale Variablen

Basislizenz

Die folgenden Basislizenzen sind erhältlich:

• Control Builder F

• DigiVis

• DigiBrowse

• Kombinierte Arbeitsstation. Eine erweiterte Engineering-Station (Kombination 
von Control Builder + DigiVis)

Optionale Lizenzen

Für DigiVis sind optional erhältlich: 

• WEB-Display Runtime

Mit der Web-Display-Funktion können Sie den lokalen Webbrowser laden. 
Beim Aufrufen des Web-Displays in DigiVis wird dann der Link zu der 
konfigurierten Website aktiviert.

Nur Controller/Prozess-Stationen, die mit der Control-Software-Lizenz 
Advanced lizenziert wurden, können E/As an Process Portal A kommunizieren.
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• Unterstützung von zwei Bildschirmen

Mit Hilfe dieser Option können Sie parallel mit zwei Bildschirmen arbeiten. 
Dazu muss der DigiVis-Rechner mit der entsprechenden Grafikkarte 
ausgestattet und der erforderliche Gerätetreiber installiert sein.

• Control- Aspect-Anzeige (nur Lesezugriff): Anzeige des Control Builder F 
Funktionsbausteindiagramms in DigiVis

• Erweiterte Diagnose

Upgrades von früheren Software-Versionen
• Wechsel von den Versionen V5.x und V6.x zu Version 9.x werden als Step-Up 

gehandhabt. In jeder Industrial IT Software-Lieferung ist automatisch ein 12-
monatiger Automation-Sentinel-Vertrag enthalten.

• Während der Laufzeit des Automation-Sentinel-Vertrags erhält der Nutzer 
automatisch und kostenfrei alle Service-Packs und Upgrades. Dabei wird nicht 
zwischen neuen Haupt- und Unter-Versionen unterschieden. 

.

Beim Step-Up von einer Version < 6.2 auf eine Version > 6.2 (Übergang auf die 
neue Lizenzierung) entscheidet der Anwender, welche Control Builder F Lizenz, 
welche Control-Software Lizenzen und wieviele E/As benötigt werden.

Ein Step-Up erfordert für jede vorhandene Prozess-Stations-Lizenz eine Control-
Software-Lizenz. 

Wenn DigiTool für fünf Prozess-Stationen lizenziert war, müssen für ein Upgrade 
eine Control Builder F Lizenz und fünf Control-Software Lizenzen bestellt 
werden. Wurden z. B. mit DigiTool die anwenderdefinierten Funktionsbausteine 
genutzt, dann ist eine Control Builder F Professional Lizenz erforderlich, um 
neue Bausteine zu definieren. Um die vorhandenen Bausteine zu nutzen, reicht 
eine Control Builder F Lizenz Standard.

Für alle Controller/Prozess-Stationen ist eine geeignete Control-Software-Lizenz 
erforderlich. Soll Operate IT Process Portal B in der Leitebene eingesetzt 
werden, dann muss auf den Controllern/Prozess-Stationen die Control-Software 
Advanced eingesetzt werden!
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Software-Management-Programm Automation-Sentinel für Freelance 

Das Software-Management-Programm Automation-Sentinel bietet die 
Möglichkeit, die installierte Software auf dem jeweils neuesten Stand zu halten und 
ohne Umwege und Verzögerungen direkt von allen Verbesserungen und neuen 
Features zu profitieren. Beim Neukauf einer Freelance-System-Software tritt 
umittelbar nach dem Versand ab Werk ein 12-monatiger Automation-Sentinel-
Vertrag in Kraft. Die Laufzeit von zwölf (12) Monaten verlängert sich um weitere 
sechs (6) Monate, wenn die Kontaktdaten des Kunden, wie im Automation-
Sentinel-Handbuch beschrieben, zugesandt werden. Darüber hinaus sind in dem 
Basisvertrag jetzt auch eine bestimmte Anzahl von Support-Stunden enthalten. 

Der Automation-Sentinel-Vertrag schließt außerdem einen Solution-Bank-
Sentinel-Vertrag ein, der den Nutzer zum Downloaden von Software und 
Produktdokumentation berechtigt.

Vertragsverlängerung:

Um auch nach dem Auslaufen Ihres Automation-Sentinel-Vertrags von Updates und 
Weiterentwicklungen profitieren zu können, sollten Sie eine Vertragsverlängerung 
beantragen. Die neue Vertragslaufzeit von weiteren 12 Monaten beginnt dann, 
sobald Ihr alter Vertrag ausläuft.

Bei einem Step-Up ist in jedem Fall die vorhandene Hardkeynummer anzugeben. 
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Kapitel 2  Installation Freelance

Allgemeine Hinweise

Freelance-Support

Wenn Sie technische Unterstützung benötigen, wenn Sie sich bitte an die lokale 
ABB-Niederlassung.

http://www.abb.com/contacts/.

http://www.abb.com/contacts/
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Empfohlene PC Ausstattung

Control Builder F

DigiVis

Hard Disk für Installation 500 MB freier Speicherplatz

Hard Disk für den Betrieb 10 GB freier Speicherplatz

Betriebssystem Microsoft Windows XP Prof. SP3, 32-Bit

Windows 7 Professional, 32-Bit

CPU-Takt >2 GHz

RAM 3 GB

Ethernet-Karte mit Supp. Interface BNC/AUI/TP

Hard Disk für Installation 500 MB freier Speicherplatz

Hard Disk für den Betrieb > 2 GB freier Speicherplatz

Empfohlen für Archivierung > 80 GB (je nach Konfiguration)

Betriebssystem Microsoft Windows XP Prof. SP3, 32-Bit, de

Windows 7 Professional, 32-Bit, de

Taktrate >2 GHz

RAM 3 GB

Grafik Karte für Dual-Monitor Matrox Millenium P690

Nvidia NVS295

Multi-Display RGU (externe Grafi-
keinheit) für Glasfaser

Matrox Extio F1400

Ethernet Karte mit Supp. Interface BNC/AUI/TP
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OPC-Server F

Die zuvor genannten Spezifikationen der PC Ausstattung sind lediglich 
Empfehlungen. Sie wurden gewählt um eine flüssige Abarbeitung und gute 
Reaktionszeiten zu gewährleisten. Abhängig von der Größe Ihres Projektes können 
Sie auch ein gutes Verhalten mit einem weniger leistungsstarken PC feststellen.

Gemischte Systeme mit Windows XP und Windows 7 Betriebssystem

Es ist möglich, innerhalb desselben Freelance-Systems sowohl PCs mit Windows 
XP als auch PCs mit Windows 7 zu betreiben. In diesem Fall darf die Aktualisierung 

Hard Disk für Installation 500 MB freier Speicherplatz

Hard Disk für den Betrieb > 2 GB freier Speicherplatz

Betriebssystem Microsoft Windows XP Prof. SP3, 32-Bit

Windows 7 Professional, 32-Bit

Microsoft Windows 2003 Server SP2, 32-Bit

Microsoft Windows 2008 Server, 32-Bit

Taktrate >2 GHz

RAM 3 GB

Ethernet Karte mit Supp. Inter-
face

BNC/AUI/TP

E

Für einen ordnungsgemäßen und fehlerfreien Betrieb der Freelance-Software 
wird empfohlen, ausschließlich Freelance-Anwendungen auf dem PC zu 
installieren.

Es wird empfohlen, OPC-Server und Trend-Server immer auf einem eigenen PC 
zu installieren und zu betreiben.

Die Freelance-Software V9.2 SP1 wurde für den Betrieb mit einem 32-Bit 
Windows-Betriebssystem entwickelt. 64-Bit Windows-Betriebssysteme werden 
nicht unterstützt.

Das Freelance Setup-Programm zeigt eine Warnmeldung an, wenn bei der 
Installation ein 64-Bit Betriebssystem erkannt wird.
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von Windows XP auf Windows 7 allerdings nicht in einem Schritt, sondern nur 
sukzessive erfolgen.

Produktoptionen

Bei einer Lizenzerweiterung erhalten Sie einen neuen Autorisierungs-Code, der wie 
folgt eingegeben werden soll:

Optionen und Zusatzmodule

Die Software Control Builder F kann in zwei Lizenzstufen, Standard und 
Professional, mit unterschiedlichen Leistungsmerkmalen erworben werden. Zur 
Verwendung der Prozess-Stationen wird für jede Station zusätzlich die Control 
Software in der Ausprägung Basic oder Advanced benötigt. Die Control Software 
kann in den beiden Leistungsstufen Basic und Advanced eingesetzt werden. 
Weitere Software-Pakete können als Zusatzmodule eingesetzt werden.

Eine detaillierte Beschreibung finden Sie in Kapitel 1, Lizenzierung.

Hardkey

Produkte von Freelance werden über den USB/LPT Anschluss Hardkey und einen 
zugehörigen Autorisierungs-Code geschützt, der nur Produkte freischaltet, die 
offiziell bestellt wurden.

Es gibt folgende Hardkey-Ausführungen:

Ausnahme:

Bei einem gemischten Freelance-System mit Windows XP und Windows 7 
Betriebssystem muss sichergestellt sein, dass der PC der DigiVis-Station für die 
erweiterte Diagnose und der PC, auf dem der Control Builder F installiert ist, 
dasselbe Betriebssystem haben.

Für Freelance benötigen Sie einen Hardkey und eine Autorisierungsdiskette. Sie 
ermöglichen die Arbeit mit Control Builder F und/oder DigiVis in dem von 
Ihnen bestellten Umfang.

> Start > Programme > ABB Industrial IT > Freelance V9.2 > Configure
Baumknoten wählen:
> Allgemeine Einstellungen> Autorisierungs-Code Installation
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• Control Builder F

• DigiVis

• Kombi (Control Builder F und DigiVis)

Wenn Sie die Freelance Software ohne den USB/LPT Anschluss Hardkey starten, 
läuft sie als Demo-Version für 100 Tage. 

Wenn ein Hardkey defekt ist, geht die Software in einen Sicherheitsmodus 
(Emergency-Modus), der wie der Demo-Modus 100 Tage lang läuft. Innerhalb 
dieser 100 Tage kann der Hardkey ausgetauscht werden, ohne dass Lizenzrechte 
verloren gehen.

Wird nach dem Start der Hardkey gezogen, so geht die Software ebenfalls in den 
Sicherheitsmodus.

Erstinstallation der Freelance-Software

Checkliste für die Installation

Ist die aktuelle Autorisierungsdatei vorhanden (nur für den Modus 
Produktion erforderlich)?
Wenn nicht, setzen Sie sich bitte mit Ihrem örtlichen ABB-
Vertriebsbüro in Verbindung.
Siehe Autorisierungs-Code installieren auf Seite 70.

Ist der USB/LPT Anschluss-Hardkey auf die USB/LPT-
Schnittstelle gesteckt?

Ist das Windows Betriebssystem vollständig inklusive Service Pack 
installiert?
Siehe Installation des Windows Betriebssystems auf Seite 29.

Nur Windows 7:
Ist die Benutzerkontensteuerung deaktiviert? 

In den Demo-Modus gelangt man nur, wenn während der Installation kein 
Hardkey auf dem PC gesteckt ist.
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Siehe Manuelle Deaktivierung der Benutzerkontensteuerung auf 
Seite 29.

Ist die Windows-Firewall konfiguriert?
Siehe Windows-Firewall auf Seite 29.

Ist das automatische Update des Windows-Betriebssystems 
deaktiviert?
Siehe Automatische Updates deaktivieren auf Seite 31.

Wurden die Energieoptionen eingestellt? 
Siehe Energieoptionen konfigurieren auf Seite 32.

Ist der Bildschirmschoner deaktiviert?
Siehe Bildschirmschoner deaktivieren auf Seite 33.

Nur bei DigiVis Leitstationen:
Wurde die gewünschte Bildschirmauflösung gewählt?
Siehe Für die Installation von DigiVis: Bildschirmauflösung 
einstellen auf Seite 33.

Nur bei DigiVis Leitstationen:
Ist die Windows Taskleiste entsprechend konfiguriert?
Siehe Für die Installation von DigiVis: Zusätzliche Einstellungen 
für die Zugangssperre zum Betriebssystem auf Seite 35.

Ist als Netzwerkprotokoll das TCP/IP-Protokoll installiert?
Sind die IP-Adressen eingetragen?
Ist die Datei „hosts” korrekt editiert worden?
Siehe Netzwerkeinstellungen und IP-Adressen auf Seite 36.

Ist ein Benutzer mit Passwort als Bediener angelegt worden?
Siehe Benutzerkonto einrichten auf Seite 41.

Wurde vor dem Ausführen des Freelance Setup-Programms der 
Virenscanner deaktiviert?
Ist der Virenscanner so konfiguriert, dass bestimmte Verzeichnisse 
von der Überwachung ausgeschlossen sind?
Siehe Konfiguration des Virenscanner-Programms auf Seite 41.
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Installation des Windows Betriebssystems

Prüfen Sie, ob das Windows Betriebssystem und auch das erforderliche Service 
Pack installiert ist.

Die Angaben zu den erforderlichen Service Packs finden Sie in den Release Notes 
auf der Software Setup-CD. Die Service Packs sind kostenfrei von der Fa. Microsoft 
zu beziehen (auch über Internet unter http://www.microsoft.com).

Manuelle Deaktivierung der Benutzerkontensteuerung

Beim Start erfasst des Freelance Setup-Programm die aktuelle Einstellung der 
Benutzerkontensteuerung und fordert den Anwender auf, die 
Benutzerkontensteuerung zu deaktivieren. Danach muss der PC neu gestartet 
werden. Weitere Informationen siehe Einstellung der Benutzerkontensteuerung in 
Windows 7 auf Seite 50.

Windows-Firewall

Das Windows Betriebssystem verfügt über eine integrierte Firewall. Die Firewall 
kann die Kommunikation zwischen Anwendungen unterbinden.

Windows XP

Beim Betriebssystem Windows XP wird empfohlen, die Firewall zu deaktivieren, 
um sicherzustellen, dass das Freelance-System einwandfrei funktioniert.

Die Benutzerkontensteuerung lässt sich manuell im folgenden Windows-Dialog 
einstellen:

> Start > Systemsteuerung > Benutzerkonten und Jugendschutz
> Benutzerkonten > Einstellungen der Benutzerkontensteuerung ändern

Die empfohlene Einstellung ist „Nie benachrichtigen“.

Führen Sie einen Neustart des Rechners durch.

> Start > Systemsteuerung > Windows-Firewall > Allgemein

Inaktiv (nicht empfohlen) wählen, um die Firewall zu deaktivieren.
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Windows 7

Beim Betriebssystem Windows 7 übernimmt das Freelance Setup-Programm die 
Konfiguration der Firewall. Dabei wird die Firewall so eingestellt, dass die 
Freelance Anwendungen einwandfrei miteinander kommunizieren können. Eine 
spezielle Konfiguration seitens des Anwenders ist nicht erforderlich.
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Während des Installationsvorgangs fügt das Freelance Setup-Programm der 
Firewall-Ausnahmeliste diverse Freelance-Programme hinzu. Sie können diese 
Einträge überprüfen, indem Sie die erweiterte Firewall-Konfiguration aufrufen:

Automatische Updates deaktivieren 

Das automatische Update des Windows-Betriebssystems muss deaktiviert sein:

Windows XP

> Start > Systemsteuerung > System und Sicherheit> Windows-Firewall

Wählen Sie Erweiterte Einstellungen

Das Konfigurationsfenster für die Windows-Firewall mit erweiterter Sicherheit 
wird angezeigt.

Wählen Sie Eingehende Regeln

Nach der erfolgreichen Installation des Freelance-Systems enthält diese Liste 
zahlreiche neue Einträge, die mit „Freelance” beginnen.

Aus Sicherheitsgründen sollten Windows-Updates jedoch von Zeit zu Zeit 
manuell durchgeführt werden. Dies muss in Absprache mit dem 
Systemadministrator und entsprechend den unternehmensspezifischen 
Sicherheitsrichtlinien erfolgen.

Bei automatischen Updates kann es vorkommen, dass der PC automatisch neu 
gestartet wird. Es wird deshalb dringend empfohlen, automatische Updates zu 
deaktivieren.

> Start > Systemsteuerung > Leistung und Wartung > System

Registerkarte Automatische Updates anwählen und die Option Automatische 
Updates deaktivieren aktivieren

Mit OK bestätigen
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Windows 7

Energieoptionen konfigurieren

Es kann vorkommen, dass die Windows-Energieverwaltung den PC entweder ganz 
herunterfährt oder in den Standby-Modus schaltet, um Energie zu sparen. Dies muss 
unbedingt vermieden werden. Die Energiesparfunktionen müssen so konfiguriert 
werden, dass in jedem Fall sichergestellt ist, dass der Rechner an bleibt.

Windows XP

Die typische Voreinstellung, die auch so bleiben kann, ist Heim-
/Büroschreibtisch.

Windows 7

Standardmäßig ist in Windows der Energiesparplan Ausbalanciert eingestellt. Das 
bedeutet, der Rechner schaltet nach 30 Minuten Inaktivität automatisch in den 
Energiesparmodus.

Wählen Sie stattdessen den Energiesparplan „Höchstleistung”.

> Start > Systemsteuerung > System und Sicherheit> Windows-Update

 Einstellungen ändern wählen

 Nie nach Updates suchen aus der Liste auswählen

Mit OK bestätigen

> Start > Systemsteuerung > Leistung und Wartung > Energieoptionen > 
Energieschemas

Standby auf Nie setzen

Festplatten ausschalten auf Nie setzen

> Start > Systemsteuerung > System und Sicherheit> Energieoptionen

Falls nicht alle Energiesparpläne angezeigt werden, die vollständige Liste mit 
Weitere Energiesparpläne einblenden aufrufen

Den Energiesparplan Höchstleistung anwählen.
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Bildschirmschoner deaktivieren

Der Bildschirmschoner muss im Windows Betriebssystem deaktiviert werden.

Bildschirmschoner unter Windows XP deaktivieren

Bildschirmschoner unter Windows 7 deaktivieren

Für die Installation von DigiVis: Bildschirmauflösung einstellen

Die DigiVis-Software unterstützt zwei verschiedene Bedienoberflächen. Welche 
davon verwendet wird, ist abhängig von der Windows-Bildschirmauflösung. 

Beim Start des DigiVis-Programms wird die aktuell am PC eingestellte 
Bildschirmauflösung überprüft und, abhängig davon, DigiVis mit der klassischen 
oder der neuen Bedienoberfläche gestartet.

Die klassische Bedienoberfläche entspricht im Wesentlichen der aus früheren 
Versionen bekannten Darstellung. Für alle Auflösungen, in denen mindestens 
1024 Pixel in der vertikalen Richtung eingestellt sind, wird DigiVis in der neuen 
Oberfläche gestartet. Auf Bildschirmen mit einer Auflösung von weniger als 
1024 Pixeln in vertikaler Richtung wird DigiVis mit der klassischen Oberfläche 
gestartet.

DigiVis unterstützt außerdem den Anschluss zweier Monitore, die auch mit 
unterschiedlicher Auflösung betrieben werden können.

> Start > Systemsteuerung > Darstellung und Designs > Anzeige

Die Eigenschaften von Anzeige  werden angezeigt.

Registerkarte Bildschirmschoner wählen

In der Liste Bildschirmschoner  die Einstellung (Kein) wählen

Mit OK bestätigen

> Start > Systemsteuerung > Darstellung und Anpassung > Anpassung

Rechts auf Bildschirmschoner ändern klicken.

In der Liste Bildschirmschoner  die Einstellung (Kein) wählen

Mit OK bestätigen
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Einstellungen für die neue DigiVis-Bedienoberfläche

Die Standardauflösung für die neue DigiVis-Bedienoberfläche ist 1280 x 1024 
Pixel. Unter Windows XP den Stil „Windows XP” wählen. Unter Windows 7 
„Windows 7-Basis” wählen

Windows XP neue Oberfläche

Windows 7 neue Oberfläche

Einstellungen für die klassische DigiVis-Bedienoberfläche

Für die klassische Bedienoberfläche wird eine Auflösung 1024 x 768 Pixeln 
empfohlen. Unter Windows XP den Stil „Windows -klassisch” wählen. Unter 
Windows 7 “Windows 7-Basis” wählen

> Start > Systemsteuerung > Darstellung und Designs > Anzeige

Darstellung:

> Auf der Registerkarte Stil > die Einstellung Windows XP wählen.

Auflösung:

> Registerkarte Einstellungen > Bildschirmauflösung 1280 x 1024 Pixel wählen

> Start > Systemsteuerung > Darstellung und Anpassung

Darstellung:

> Anpassung > Windows 7-Basis wählen

Auflösung:

> Anzeige > auf  Bildschirmauflösung einstellen klicken > eine Auflösung von 
1280 x 1024 Pixeln einstellen
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Windows XP klassische Oberfläche

Windows 7 klassische Oberfläche

Für die Installation von DigiVis: Zusätzliche Einstellungen für die 
Zugangssperre zum Betriebssystem

Auf den Leitstationen soll der Zugang zum Betriebssystem unterbunden werden. 
Diese Zugangssperre wird vom Freelance-System und insbesondere von DigiVis 
unterstützt. 

Windows XP

Um den Zugang zum Betriebssystem zu unterbinden, sind zusätzliche Einstellungen 
erforderlich:

Die Eigenschaft der Taskleiste “Immer im Vordergrund halten” muss ausgeschaltet 
werden:

> Start > Systemsteuerung > Darstellung und Designs > Anzeige

Darstellung:

> Auf der Registerkarte Stil > die Einstellung Windows - klassisch wählen.

Auflösung:

> Registerkarte Einstellungen > Bildschirmauflösung 1024 x 768 Pixel wählen

> Start > Systemsteuerung > Darstellung und Anpassung

Darstellung:

> Anpassung > Windows 7-Basis wählen

Auflösung:

> Anzeige > > Bildschirmauflösung einstellen > Bildschirmauflösung 
1024 x 768 Pixel wählen

> Rechtsklick auf die Taskleiste

> Eigenschaften

“Immer im Vordergrund halten” ausschalten
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Hintergrundinformationen

Wenn Sie DigiVis im Modus Produktion starten, wird der Start-Button in der 
Windows-Taskleiste deaktiviert. In DigiVis existiert auch kein Button, um DigiVis 
zu minimieren. Dieses Verhalten ist aus Sicherheitsgründen implementiert, damit 
Benutzer nicht zu anderen Anwendungen wechseln können. Der Anwender kann 
nicht aus DigiVis heraus in andere Anwendungen wechseln. Lediglich die 
Applikationen, die vor dem Start von DigiVis gestartet wurden, sind vom DigiVis-
Anwender über die Tastenkombination ALT+TAB erreichbar.

Vom DigiVis-Menü (Extras / System / Betriebssystem) kann nach Passworteingabe 
zum Betriebssystem gewechselt werden. Danach ist der Start-Button aktiviert und 
wird mit Text angezeigt. Solange die Taskleiste im Hintergrund von DigiVis läuft, 
stellt das kein Problem dar. DigiVis kann die Taskleiste nicht in jedem Fall 
unterdrücken. Wird für die Taskleiste die Eigenschaft “Immer im Vordergrund 
halten” eingeschaltet, erscheint die Taskleiste im Vordergrund. Die Eigenschaft der 
Taskleiste “Immer im Vordergrund halten” muss ausgeschaltet sein, um 
sicherzustellen, dass DigiVis-Anwendern der Zugriff auf andere Anwendungen 
versperrt ist.

Netzwerkeinstellungen und IP-Adressen

Das von Freelance verwendete Netzwerkprotokoll ist TCP/IP. Es wird kein 
anderes Protokoll vorausgesetzt. Die Lauffähigkeit mit anderen 
Netzwerkprotokollen wird nicht gewährleistet.

Zur Adressierung der Stationen und Ressourcen eines Projektes können IP-
Adressen und/oder Host-Namen verwendet werden.

Für die angeschlossenen PCs kommen vorzugsweise die IP-Adressen ab 
172.16.1.20 bis 172.16.1.255 zum Einsatz.



Kapitel 2  Installation Freelance Netzwerkeinstellungen und IP-Adressen

3BDD012560R0503_Getting_Started 37

 

3BDD012560R0503_Getting_Started 37

E
n

g
lis

h
D

eu
ts

ch

Einstellung der IP-Adressen

Geben Sie für den Netzwerkadapter eine IP-Adresse und eine Subnet-Maske ein:

IP-Adresse: 172.16.x.x z. B. 172.16.1.20

Subnet-Maske: 255.255.240.0

Subnet-Maske für die Zeitsynchronisierung 

Neben dem Windows-PC benötigt auch die Prozess-Station eine gültige 
Netzwerkeinstellung.

An der Rückseite der CPU-Baugruppe befindet sich ein Kodierschalter, über den die 
Stationsnummer der Prozess-Station eingestellt wird. Für den AC 800F befindet 
sich der Kodierschalter auf dem Ethernet-Modul. Die Stationsnummer ist im 
Standardfall ein Teil der IP-Adresse.

Mit der Kodierschaltereinstellung ungleich Null und einem Wert von 1 bis F wird 
die Subnet-Maske 255.255.240.0 und die IP-Adresse mit 172.16.1.x (x = 1,...,15 
entsprechend der Kodierschaltereinstellung 1,...,F). ) fest vergeben. Wird der 

Windows XP

> Start > Systemsteuerung> Netzwerk- und Internetverbindungen > 
Netzwerkverbindungen

> gewünschten Netzwerkadapter mit der rechten Maustaste anklicken > 
Eigenschaften wählen.

> Internetprotokoll TCP/IP wählen und auf Eigenschaften klicken

Windows 7

> Start > Systemsteuerung > auf Netzwerk und Internet klicken

> auf Netzwerk- und Freigabecenter klicken  > auf Adaptereinstellungen 
ändern klicken

> gewünschten Netzwerkadapter mit der rechten Maustaste anklicken > 
Eigenschaften wählen.

> Internetprotokoll Version 4 (TCP/IPv4) wählen und auf Eigenschaften 
klicken
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Kodierschalter einer Prozess-Station oder eines AC 800F auf 0 (Null) gestellt, so 
können die IP-Adresse und die Subnet-Maske frei vergeben werden.

Um eine Zeitsynchronisation zu ermöglichen, müssen sich alle beteiligten Stationen 
im gleichen Subnetz befinden. D.h., auch bei den frei konfigurierbaren Stationen 
(PCs oder Baugruppen mit Kodierschalter auf 0) müssen die Subnet-Masken 
255.255.240.0 und IP-Adressen 172.16.x.y mit x = 0... 15 und y = 0... 255 
eingestellt werden.

Stationen, die über einen Router verbunden werden, nehmen weder an der normalen 
Zeitsynchronisation noch an der Lateralkommunikation teil. Mit der Funktion “Ext. 
Zeitserver” (siehe Engineering-Handbuch Systemkonfiguration, Projektbaum) 
kann die Zeitsynchronisation für externe Prozess-Stationen realisiert werden. 

Einträge für DNS-Server und WINS 

DNS- und WINS-Einträge sind im Inselbetrieb nicht erforderlich. Die Default-
Einstellungen der Windows XP/7-Installation für das Netzwerk kann für den 
Betrieb eines Freelance-Systems unverändert verwendet werden. TCP/IP-Protokoll 
muss auf allen PCs installiert sein.

Host-Namen verwenden

Bei der Projektkonfiguration können anstelle von IP-Adressen auch symbolische 
Namen für die Rechner und Prozess-Stationen verwendet werden. Die Namen 
werden vom System mit Hilfe der Hosts-Datei in physikalische Adressen 

Werden andere Subnet-Masken als255.255.240.0 verwendet, ist darauf zu achten, 
dass sie aufeinanderfolgend sind. Das Äquivalenz-Bitmuster muss mit Einsen 
beginnen und weitergehen. Es darf sich einmal in Nullen ändern und muss dann 
auch auf Null enden.

Beispiel für ein gültiges Bitmuster:
11111111 11111111 11110000 00000000 = 255.255.240.0
Beispiel für ein ungültiges Bitmuster:
11111111 11111111 11111001 00000000 = 255.255.249.0

Hinweise: In die Windows XP / 7 Eingabemaske lassen sich ungültige Werte gar 
nicht eingeben.
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umgesetzt. Diese Datei muss vorher den Anforderungen entsprechend editiert 
werden.

Mit der Windows-Installation wird eine Beispiel-Datei auf dem Rechner erzeugt:

<Windows-Verzeichnis>\system32\drivers\etc\hosts

Editieren Sie diese Datei Ihren Anforderungen entsprechend. Für jeden Rechner 
und jede Prozess-Station, die nicht über eine IP-Adresse, sondern über einen Namen 
konfiguriert werden soll, ist ein Eintrag erforderlich. (Die Namen können maximal 
14 Zeichen lang sein):

<IP-Adresse> <name>

z. B.:

172.16.1.1 station1
172.16.1.123 opc_gwy

Für die Bearbeitung der Hosts-Datei sind Administratorrechte erforderlich.

Unter Windows 7 können Sie den Text-Editor als Administrator starten oder die 
Benutzer-Zugriffssteuerung deaktivieren.
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Überprüfung der Netzwerk-Konfiguration

Die Netzwerk-Konfigurations zwischen einem Windows-PC und einer Prozess-
Station oder zwischen zwei Windows-PCs kann mit Hilfe eines Ping-Befehls 
überprüft werden. 

Windows 7 Firewall so konfigurieren, das Ping-Befehle zugelassen werden

Um den Verbindungsaufbau zu einem PC mit Windows 7 zu prüfen, müssen auf 
dem Zielrechner die Firewall-Einstellungen angepasst werden.  Standardmäßig 
blockiert die Firewall von Windows 7 Ping-Anforderungen. 

> Start > Ausführen.. > cmd eingeben > [Enter] betätigen

Ein Windows-Konsolenfenster wird geöffnet (mit Eingabeaufforderung).

Geben Sie hier den Ping-Befehle ein, um zu überprüfen, ob eine Verbindung zu 
der Adresse bzw. dem Host-Namen hergestellt werden kann.

Beispiel: Geben Sie ping 172.16.1.20 ein, um zu prüfen, ob eine Verbindung zu 
der Station mit der IP-Adresse 172.16.1.20 hergestellt werden kann.

Bei erfolgreichem Verbindungsaufbau antwortet der angesprochene PC bzw. die 
Station, und ein Zeitwert für die Übertragungsdauer des übertragenen 
Datenpakets wird ausgegeben. Ist der Vebindungsaufbau nicht erfolgreich, wird 
die Meldung Zeitlimit für Anforderung überschritten angezeigt.

Bei Verwendung der DNS-Namensauflösung kann auch diese über den Ping-
Befehl getestet werden. Beispiel: ping opc_gwy eingeben.

Rufen Sie auf dem Zielrechner (nicht auf dem Rechner, von dem aus der Ping-
Befehl gesendet wird) das Konfigurationsfenster für die Firewall mit erweiterter 
Sicherheit auf:

> Start > Systemsteuerung > System und Sicherheit > Verwaltung
> Windows Firewall mit erweiterter Sicherheit. 

Aktivieren Sie die eingehende Regel namens Datei- und Druckerfreigabe 
(Echoanforderung - ICMPv4 eingehend), um Ping-Anforderungen an diesen 
Rechner zuzulassen.
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Benutzerkonto einrichten

Für die Installation der Freelance-Software sind Administratorrechte erforderlich.

Bei der Einrichtung von Benutzern für DigiVis wird der Anwender durch das 
Programm Configure unterstützt (siehe Allgemeine Einstellungen auf Seite 69).

Windows XP

Unter Windows XP können die Rechte der DigiVis-Anwender eingeschränkt 
werden. Dies wird erreicht, indem der Kontotyp des DigiVis-Anwenders von 
Computeradministrator in Eingeschränkt geändert wird. Der Eingeschänkte 
Benutzer ist nur Mitglied der Benutzergruppe Benutzer.

Windows7

Alle Benutzer der Freelance-Anwendungen unter Windows 7 brauchen 
Administratorrechte. Sie sollten der Windows-Benutzergruppe Administratoren 
angehören.

Konfiguration des Virenscanner-Programms

Beim Einsatz einiger Virenscanner-Programme auf einem Freelance-PC können 
sowohl im Control Builder F, z. B. beim Anlegen eines Projektes, als auch in 
DigiVis, z. B. beim Laden des Projektes nach DigiVis, Probleme auftreten.

Um Zugriffsprobleme zu vermeiden, sollten folgende Verzeichnisse von der 
Virenüberwachung ausgeschlossen werden:

1. Das Verzeichnis <Freelance_Installation_Folder>\proj und
2. das Verzeichnis Temp-directory des angemeldeten Benutzers.
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Upgrade einer vorhandenen Version auf die neue Version
Upgrade bedeutet den Wechsel von einer Freelance-Version zu einer neueren. 
Bestehende Projektkonfigurationen können dabei problemlos übernommen werden, 
wenn innerhalb einer Hauptversion (z. B. von V8.1 nach V8.2) oder auch von einer 
Hauptversion zur nächstfolgenden (z. B. von V8 nach V9) gewechselt wird. Ist ein 
Wechsel über mehrere Hauptversionen (z. B. von V6 nach V9) erforderlich, so 
wenden Sie sich an die lokale ABB-Serviceorganisation.

Vor einem Upgrade zu beachten

Checkliste 

Überprüfen Sie, dass alle Projektdateien aus der „alten“ 
Control Builder F oder DigiTool-Version exportiert wurden.

Das Temp-Verzeichnis is abhänging vom angemeldeten Windows-Benutzer. 
Typischerweise liegt das Temp-Verzeichnis des Benutzers „Freelancer” im 
folgenden Verzeichnis:

Windows XP:

"C:\Dokumente und Einstellungen\Freelancer\Lokale Einstellungen\Temp"

Windows 7:

"C:\Benutzer\Freelancer\AppData\Local\Temp".

Es kann erforderlich sein, die Temp-Verzeichnisse aller Freelance-Benutzer von 
der Virenüberwachung auszuschließen.

Virenscanner-Programme können die Installation der Freelance-Software stören. 
Es wird deshalb empfohlen, Virenscanner wie McAfee Antivirus während des 
Installationsvorgangs zu deaktivieren und danach wieder zu aktivieren.

Wird ein Control Builder F Projekt, das unter Windows XP angelegt worden ist, 
unter Windows 7 geöffnet, geht die Zeitzoneneinstellung verloren.

Um die Zeitzone einzustellen, das CBF-Projekt unter Windows 7 öffnen und den 
CPB-Projektbaum aufrufen > Rechtsklick auf den KONF-Knoten > Kopf > 
Zeitzone wählen
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Überprüfen Sie, dass die Parameter der Funktionsbausteine in den 
Projektdateien dokumentiert wurden.

Sichern der Projektdaten aus älteren Versionen

Möchten Sie Ihre bestehenden Projekte älterer Versionen weiterhin bearbeiten, so 
müssen Sie diese in Ihrer alten Control Builder F / DigiTool-Version exportieren 
(*.CSV-Datei erstellen), bevor Sie das neue Setup ausführen.

Vor dem Export der Projektdatei müssen Sie sicherstellen, dass alle durch Eingriffe 
von der Leitstation oder während der Inbetriebnahme geänderten Parameter mit der 
Option KORRIGIEREN in der Projektdatei gespeichert sind. Jeder mit einem 
SCHREIBEN-Befehl geänderte Parameter wird beim Laden der Prozess-Station auf 
seinen Originalwert gesetzt. Mit Laden > Parameter können alle geänderten 
Parameter gespeichert werden.

Funktionsbausteinparameter dokumentieren

Es wird empfohlen, die Parameter der Funktionsbausteine zu dokumentieren. Für 
den Fall von inkompatiblen Änderungen an der Funktionsbausteinbibliothek, die 
vom System nicht automatisch gehandhabt werden können, müssen u. U. Parameter 
erneut eingegeben werden.

Projekt exportieren

Sichern Sie anschließend das Projekt in einer CSV-Datei:

> Control Builder F aufrufen > Projekt öffnen 
> Inbetriebnahme-Modus aufrufen
> Laden > Parameter > nur abweichende > Parameter korrigieren

> Projektdatei exportieren (*.CSV-Format)
> Control Builder F beenden
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Siehe auch Engineering-Handbuch Systemkonfiguration, Projektverwaltung, 
Projekt exportieren. 

Upgrade von V9.1 auf V9.2 SP1

Wird das Setup-Programm auf einem Rechner gestartet, wo bereits die Freelance-
Version 9.1 installiert ist, erscheint das „Upgrade“-Menü .

Setup Upgrade 91 to 92SP1 gr.bmp

In Projekten, die mit Version 3.3 oder früher erstellt wurden, kann derselbe 
Name für Funktionsblöcke (MSR-Stellen) und Variablen benutzt werden. Ab 
Version 4.1 sind Konflikte zwischen den Namen von MSR-Stellen und 
Variablennamen nicht mehr erlaubt und werden stattdessen abgefangen!

Beim Import eines Projekts werden automatisch alle Namenskonflikte entfernt, 
indem die Variablennamen durch  “_var” ergänzt werden. Geänderte 
Variablennamen können in der Variablenliste mit der Suchfunktion ausgewählt 
werden. Mit der Funktion Querverweise lassen sich die Verwendungsstellen 
leicht auffinden und gegebenenfalls verändern.

Sollte auf dem Rechner eine ältere Freelance-Version als V9.1 installiert sein, 
wird eine Warnmeldung angezeigt. Bevor die neue Freelance-Version V9.2 SP1 
installiert werden kann, müssen erst die Vorgängerversion deinstalliert werden.
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Auf Weiter klicken.

Setup Ready to Upgrade gr.bmp

Auf Installieren klicken. Die vorhandenen V9.1 Funktionen werden auf V9.2 SP1 
aktualisiert.

Upgrade von V9.2 auf V9.2 SP1

Wird das Setup-Programm auf einem Rechner gestartet, wo bereits die Freelance-
Version V9.2 installiert ist, erscheint das „Upgrade“-Menü .

Bei einem Upgrade werden nur diejenigen Systemkomponenten aktualisiert, die 
bereits in der V9.1 vorhanden sind. Stellt das Setup-Programm während des 
Upgrades fest, dass bereits ein OPC-Gateway oder Trend-Server auf Ihrem 
Rechner existiert, wird automatisch der OPC-Tunnel installiert. Ist der Control 
Builder F bereits vorhanden, wird der Bulk Data Manager installiert.

Um nach dem erfolgreichen Upgrade weitere Funktionen hinzuzufügen, muss 
das Setup-Programm erneut ausgeführt werden. Das Setup-Programm wechselt 
dann in den Modus Wartung.

Sollte auf dem Rechner eine ältere Freelance-Version als V9.1 installiert sein, 
wird eine Warnmeldung angezeigt. Bevor die neue Freelance-Version V9.2 
installiert werden kann, müssen Sie erst die alte Version deinstallieren.
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Setup Upgrade 92 to 92SP1 gr.bmp

Auf Weiter klicken.

Im nächsten Fenster auf Installieren klicken. Die vorhandenen V9.2 Funktionen 
werden auf V9.2 SP1 aktualisiert.

Deinstallieren vor Neuinstallation

Trifft das vorstehend beschriebene Upgrade-Szenario nicht zu, kann es erforderlich 
sein, die Software zu deinstallieren.

Um nach dem erfolgreichen Upgrade weitere Funktionen hinzuzufügen, muss 
das Setup-Programm erneut ausgeführt werden. Das Setup-Programm wechselt 
dann in den Modus Wartung.

Vor der Deinstallation muss sichergestellt werden, dass sie nicht mehr benötigt 
wird, z. B. zum Exportieren von alten Projekten.
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Freelance-Versionen bis V9.1 lassen sich unter Windows in der Systemsteuerung 
unter Software > Programme ändern oder hinzufügen deinstallieren:

Ab der Version 9.1 ist die Freelance-Software mit einer Funktion zum 
Deinstallieren ausgestattet (siehe Entfernen auf Seite 67):

Nach der Deinstallation kann die neue Software-Version installiert werden. Gehen 
Sie dazu vor, wie nachstehend beschrieben.

Setup starten
Zum Installieren der Freelance-Software die Freelance-Software-CD in das CD-
Laufwerk einlegen. Es wird automatisch der CD-Autoplay-Dialog gestartet, wenn 
in Windows die Autoplay-Funktionalität aktiviert ist. Ist diese deaktiviert, starten 
Sie den Dialog manuell.

Wählen Sie zunächst im Sprachdialog die Sprache aus, in der Sie die Software 
betreiben möchten.

> Start > Systemsteuerung > Software >Programme ändern oder hinzufügen
> Programm wählen das deinstalliert werden soll z. B. Control Builder F / 
Freelance V8.1
>  auf den Button Entfernen klicken

> Installations-CD der installierten Freelance-Version einlegen
> den Windows Explorer starten > das CDROM-Laufwerk anwählen
> die Datei Autoplay.exe öffnen, z. B.E:\Autoplay
> die installierte Sprache wählen > die Freelance-Software wählen> auf OK 
klicken, um die Warnung zu bestätigen
> Entfernen anklicken und warten, bis die Software deinstalliert ist.

Es wird empfohlen, Fremdsoftware wie OPC-Tunnel, S-800 DTM, S900 DTM, 
gemeinsame FDT-Komponenten, FDT-Basiscontainer, CBF Viewer etc., die mit 
dem Freelance Setup-Programm installiert worden sind, über die Setup-Fuktion 
Entfernen zu deinstallieren.

> Den Windows Explorer starten > das CDROM-Laufwerk anwählen
> die Datei Autoplay.exe öffnen, z. B.E:\Autoplay
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Nach der Sprachauswahl erscheint das Inhalt-Fenster. Die Inhalte der CD werden 
angezeigt.

tb499 gr.bmp

Release Notes Mit dieser Auswahl wird Ihnen das Dokument „Release Notes” mit 
den Neuerungen dieser Version zum Lesen geöffnet.

Freelance Software 
Diese Auswahl startet die Installation der Freelance-Software. Hier 
können Sie die Freelance-Software-Pakete zur Installation 
anwählen.

Zurück Sie gelangen zurück zur Sprachauswahl.

Lesen Sie zunächst die Release Notes und wählen Sie dann die Freelance Software 
an, um die Software-Installation, wie folgenden Kapitel beschrieben, zu installieren.

Um das Dokument zu öffnen, benötigen Sie einen PDF-Reader, z. B. den Acrobat 
Reader.
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Freelance -Software installieren

Allgemeiner Hinweis zur Vorgehensweise beim Setup

Buttons in den Dialogboxen:

Weiter Die Installation wird mit dem Aufruf der nächsten Dialogbox 
fortgesetzt. 

Zurück Kehrt in das vorherige Fenster zurück.

Sie können die Installation jederzeit mit Abbrechen beenden.
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Voraussetzungen für die Installation

Einstellung der Benutzerkontensteuerung in Windows 7

Die Benutzerkontensteuerung (UAC) ist eine neue Funktion in Windows 7. Die 
nachfolgenden Hinweise zur Deaktivierung der Benutzerkontensteuerung gelten 
daher nur für Windows 7. Um einen einwandfreien Betrieb des Freelance-Systems 
sicherzustellen, wird empfohlen, bei Rechnern mit Windows 7 die 
Benutzerkontensteuerung zu deaktivieren.

Wenn Sie bereits mit einer früheren Version von Control Builder F oder DigiTool 
gearbeitet haben, beachten Sie unbedingt Folgendes:

Stellen Sie sicher, dass Sie all Ihre Control Builder F oder DigiTool-Projekte mit 
ihrer bisherigen Control Builder F bzw. DigiTool-Version exportiert haben. 
Brechen Sie im Zweifelsfall dieses Setup ab und exportieren Sie Ihre Projekte mit 
Ihrer momentan installierten Control Builder F bzw. DigiTool-Version.

Weiterhin empfehlen wir dringend, die Parameter der Funktionsbausteine in 
Ihren aktuellen Projekten zu dokumentieren. Im Falle von inkompatiblen 
Änderungen der Funktionsbausteinbibliothek, die von den Update-Funktionen 
nicht gehandhabt werden können, müssen Sie diese erneut eingeben.

Siehe auch Upgrade einer vorhandenen Version auf die neue Version auf Seite 42.

Es wird empfohlen, vor dem Starten des Setup-Programms den Virenscanner – z. 
B. McAfee Antivirus – zu deaktivieren.

Falls noch eine frühere Version der Freelance- Software auf Ihrem Rechner 
vorhanden ist, wird eine Warnmeldung angezeigt.

Weitere Informationen finden Sie unter Deinstallieren vor Neuinstallation auf 
Seite 46.
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Handhabung der UAC durch das Freelance Setup-Programm

Das Freelance Setup-Programm erkennt, wenn die Benutzerkontensteuerung nicht 
deaktiviert ist, und zeigt dann die folgende Warnmeldung an:

UAC1 gr.bmp

Um die UAC zu deaktivieren, auf UAC deaktivieren klicken. Das Setup-Programm 
deaktiviert dann die UAC und führt einen Neustart des Rechners durch. Stellen Sie 
sicher, dass alle Arbeitsergebnisse gespeichert sind, und klicken Sie dann auf Ja, um 
einen Rechner-Neustart durchzuführen.

UAC2 gr.bmp

Nach dem Neustart setzt das Freelance Setup-Programm die Installation fort.

Einstellungen der Benutzerkontensteuerung prüfen

Nach der Installation der Freelance-Software kann die UAC-Einstellung geprüft 
werden:

> Start > Systemsteuerung  > Benutzerkonten und Jugendschutz
> Benutzerkonten > Einstellungen der Benutzerkontensteuerung ändern 

Der Schiebebalken muss in der Stellung Nie benachrichtigen stehen.
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Willkommensseite

Die Willkommensseite erinnert den Benutzer an die wichtigen Schritte, die vor der 
Installion durchgeführt werden müssen.

Mit Weiter öffnen Sie das Fenster Lizenzvereinbarung.

Lizenzvereinbarung

tb500 gr.bmp

Um die Lizenzvereinbarung zu akzeptieren, wählen Sie Ja, ich akzeptiere die 
Bedingungen des Lizenzvertrags.

Nach dem Anklicken von Weiter wird der Dialog zum Auswählen der 
Installationsart angezeigt.
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Auswählen der Installationsart

Wählen Sie die Art der Installation aus.

tb501 gr.bmp

Demo Für Test- und Demonstrationszwecke.

Produktion Für die Produktionsumgebung.

Zielverzeichnis für die Installation

Alle Programme der Freelance-Software werden standardmäßig in das Verzeichnis

Durch Anklicken des Hilfe-Symbols (Fragezeichen) oben rechts können Sie zu 
jeder Installationsart eine detaillierte Beschreibung aufrufen. 

Das Zielverzeichnis können Sie mit Hilfe des Navigieren-Buttons ändern.

Das Standard-Zielverzeichnis für die Installation ist: E:\Programme\ABB 
Industrial IT\Freelance. 

Für den Modus Produktion wird empfohlen, das Programm in einer anderen 
Partition zu installieren als das Betriebssystem .
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C:\Programme\ABB Industrial IT\ Freelance 

(im Modus Demo)

oder

E:\Programme\ABB Industrial IT\ Freelance 

(im Modus Produktion) installiert.

Unter dem Installationsverzeichnis werden die folgenden Unterverzeichnisse 
angelegt.

...\bitmaps Bitmap-Dateien für die Hardware im DigiVis 
Systembild

...\bpr Betriebsprotokolle

...\curv Trendarchive

...\ddesrv DDE-Server

...\dmsapi Applikationsschnittstelle

...\doc Projektdokumentation

...\eprom FLD-Datein für EPROM-Updates

...\exe dll- und exe-Dateien für Contol Builder F

...\export Exportierte Projektdateien oder Teile von Programmen

...\ff Dateien aus dem FOUNDATION Fieldbus-Standard

...\gsd Profibus-Gerätestammdaten-Dateien

...\macros Makros für den Grafikeditor

...\opcsrv OPC-Server

...\OPCTunnel Installationsordner für OPC-Tunnel-Server

...\proj Standardverzeichnis für Projektdateien 

...\proj\BDM Standardverzeichnisfür Vorlagen und Dateien des Bulk 
Data Managers 

...\reports Standardsverzeichnis für Excel-Berichte

...\sap Störablaufprotokolle

...\setctrl Setup-Steuerung

...\setups Ablage für Setups

...\sfp Signalfolgeprotokolle

...\ucurv Reserviert

...\VisHelp Online-Hilfe für DigiVis (neue Oberfläche und 
klassische Oberfläche)

...\wave Wave-Dateien für Alarmmeldungen in DigiVis
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Arbeitsstation-Typ im DEMO-Modus

In diesem Modus wird die Freelance-Software auf Ihrem System für 
Demonstrations- und/oder Testzwecke installiert. Für diesen Modus brauchen Sie 
keine Lizenz. Alle Funktionen stehen zur Verfügung, jedoch nur für eine 
Evaluierungsperiode von 100 Tagen. 

Nach der Auswahl von Demo und Klicken auf Weiter wird der Dialog zur Auswahl 
der gewünschten Arbeitsstation angezeigt.

tb500_2 gr.bmp

Der Screenshot zeigt die Standard-Auswahl für den Demo-Modus. Sie können 
jedoch jede beliebige der aufgelisteten Arbeitsstationen auswählen. Die 
benutzerdefinierte Arbeitsstation wird im Kapitel Benutzerdefinierte Arbeitsstation 
auf Seite 57 beschrieben.

Durch Anklicken des Hilfe-Symbols oben rechts können Sie zu jeder 
Arbeitsstation eine detaillierte Beschreibung aufrufen. 

Über den Detail-Button können Sie sich die Baumstruktur der Komponenten 
anzeigen lassen, die für die ausgewählte Arbeitsstation installiert werden. Sie 
können die Komponenten in der Baumstruktur zwar ansehen, die Auswahl aber 
nicht ändern.
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Mit Weiter gelangen Sie zum Dialog „Bereit zu installieren“. Siehe auch Der 
„Bereit zu installieren“-Dialog auf Seite 61.

Arbeitsstation-Typ im Modus PRODUKTION

Nach der Auswahl von Produktion und Klicken auf Weiter wird der Dialog zur 
Auswahl der gewünschten Arbeitsstation angezeigt.

tb500_8 gr.bmp

Die Abbildung zeigt die Standardauswahl für den Modus Produktion. Es kann 
jedoch jeder der angezeigten Arbeitsstation-Typen ausgewählt werden. Die 
benutzerdefinierte Arbeitsstation wird im Kapitel Benutzerdefinierte Arbeitsstation 
auf Seite 57 beschrieben.

Dieser Modus ändert die Systemeinstellungen Ihres PCs während der Installation 
der Softwares. Für den Arbeitsplatz mit den gewählten Optionen ist eine Lizenz 
erforderlich.

Durch Anklicken des Hilfe-Symbols oben rechts können Sie zu jeder 
Arbeitsstation eine detaillierte Beschreibung aufrufen. 
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Mit Weiter gelangen Sie zum Dialog „Bereit zu installieren“. Siehe Der „Bereit zu 
installieren“-Dialog auf Seite 61.

Benutzerdefinierte Arbeitsstation

Diese Option wird für erfahrene Benutzer von Freelance empfohlen. Sie erlaubt die 
manuelle Auswahl der zu installierenden Komponenten. Nach der Auswahl von 
Benutzerdefiniert in der Ansicht „Arbeitsstationstyp“ und Klicken auf Weiter wird 
die Baumstruktur der Systemkomponenten angezeigt.

tb500_9 gr.bmp

Über den Detail-Button können Sie sich die Baumstruktur der Komponenten 
anzeigen lassen, die für die ausgewählte Arbeitsstation installiert werden. Sie 
können die Komponenten in der Baumstruktur zwar ansehen, die Auswahl aber 
nicht ändern.

Klicken Sie auf den Namen einer Komponente in der Baumstruktur, um eine 
Kurzbeschreibung dieser Komponente im rechten Bereich des Dialogfensters 
anzuzeigen.

Der angezeigte Speicherplatzbedarf gilt nur für die Basiskomponenten. Die 
Komponenten FDT -Shared/Base Container, DTM für S800/S900, CBF-Viewer, 
Hardkey und CBF/DigiVis-Hilfe erfordern zusätzlichen Speicherplatz.
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Zu installierende Software-Komponenten auswählen

Im linken Teil des Dialogs werden die Freelance-Software-Komponenten in einer 
Baumstruktur aufgelistet.

In der Checkbox vor jeder Systemkomponenten wird der Status dieser Komponente 
auf dem PC angezeigt. Durch Anwahl dieser Checkbox wählen Sie aus, ob bzw. wie 
die jeweilige Komponente installiert werden soll. 

(leer) Diese Komponente wird nicht installiert.

(Haken) Diese Komponente wird installiert.

(Haken mit grauen Hintergrund) Diese Komponente ist in 
Abhängigkeit von einer anderen ausgewählten Komponente 
selektiert und wird automatisch zusammen mit dieser Komponente 
installiert.

Mit Weiter gelangen Sie zum Dialog „Bereit zu installieren“. Siehe Der „Bereit zu 
installieren“-Dialog auf Seite 61.

Freelance-Basis-Software-Pakete

Die folgenden Softwarepakete können mit diesem Setup installiert werden:

Freelance Software

• Engineering Station

– Control Builder F

Software-Paket zur Konfiguration und Inbetriebnahme von Prozess-
, Gateway- und Leitstationen für Freelance-Projekte

– CBF Help

Online-Hilfe zum Control Builder F

– Profibus FDT-Bibliothek



Kapitel 2  Installation Freelance Arbeitsstation-Typ im Modus PRODUKTION

3BDD012560R0503_Getting_Started 59

 

3BDD012560R0503_Getting_Started 59

E
n

g
lis

h
D

eu
ts

ch

Software zur Konfiguration von PROFIBUS-Installationen mit 
Hilfe von FDT/DTM- Schnittstellen der Version FDT 1.2 in Control 
Builder F-Projekten

- FDT1.2

- FDT1.2 Komponenten

Um Feldgeräte mit Hilfe von DTMs im Control Builder F zu 
konfigurieren, müssen diese Komponenten zusätzlich zu der 
Profibus FDT-Bibliothek installiert werden:

 - FDT Shared Components

- FDT Base Container 

- DTM für S800

- DTM für S900

– Foundation Field Bus 

Software zur Konfiguration von FOUNDATION Fieldbus-Geräten

– Bonus Pack

- Controller Emulator

Mit diesem Software-Paket können Prozess-Stationen emuliert 
werden. Eine Projektkonfiguration kann ohne existierende 
Hardware getestet werden.

Bulk Data Manager

Der Freelance Bulk Data Manager ist ein Tool, mit dem Sie bei der 
Konfiguration im Control Builder F über Microsoft Excel große 
Datenmengen verwalten können. Zu den verfügbaren Funktionen 
zählen der Import und Export von MSR-Stellenlisten und 
Variablenlisten, das Kopieren typischer Applikationslösungen und 
Parameteränderungen für komplette Bausteinsätze.

Die neuen Bonus-Funktionen viz. S800/S900 Bausteine, S800 Modbus Baustein, 
3D-Bibliothek, S700-Template etc. werden beim Setup automatisch installiert. 
Sie werden nicht in der Baumansicht der zu installierenden Features zur Auswahl 
angeboten.
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• Operator Station (Leitstation)

– DigiVis 

Software für eine Leitstation zum Bedienen und Beobachten der mit 
dem Control Builder F konfigurierten Prozesse

– DigivisHelp

Online-Hilfe zur Leitstations-Software DigiVis

– DigiBrowse

Programmpaket zum Ansehen archivierter Trends und Protokolle.

• Server und Gateways

– OPC-Gateway

Auf einer Connectivity-Station sollte ein Gateway zur Anbindung 
von Freelance-Projekten mit anderen Anwendungsprogrammen 
über einen OPC-Server  installiert werden.

– Trend-Server

Spezieller OPC-Server, der benutzerdefinierte Trendbilder 
unterstützt. Pro Freelance-System ist jeweils nur ein Trend-Server 
erlaubt. Er sollte auf einer Leitstation oder einer dafür vorgesehenen 
Connectivity-Station installiert werden.

– DDE

DDE-Server für die Kopplung von Freelance-Projekten mit anderen 
Applikationsprogrammen über eine DDE-Schnittstelle

– Application Programming Interface (API)

– OPC-Tunnel-Server

Zur Anbindung eines OPC-Servers oder Trend-Servers an DigiVis. 
Wird auf der Arbeitsstation installiert, wo der OPC-Server oder 
Trend-Server läuft.

DDE wird nur unterstützt, wenn das Freelance-System auf einem Rechner mit 
dem Betriebssystem Windows XP läuft. Unter Windows 7 steht DDE nicht zur 
Verfügung.
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• CBF Viewer

Zur Anzeige von Echtzeit-Daten für die DigiVis 
Anwendungsprogramme (FBS, AS etc.).

• Security Lock

Zugriffskontrolle für Control Builder F und DigiVis 

Der „Bereit zu installieren“-Dialog

tb500_11 gr.bmp

Klicken Sie auf Installieren, um die ausgewählten Komponenten zu installieren.

Der Installationsvorgang nimmt einige Zeit in Anspruch. Die benötigte 
Installationszeit ist abhängig von der Anzahl der zu installierenden Komponenten.



Datenbestände von früheren Versionen übernehmen Kapitel 2  Installation Freelance

62 3BDD012560R0503_Getting_Started

 

E
n

g
lis

h
D

eu
ts

ch

Installation von HBGina

HBGINA gr.jpg

Nach der Installation der Software-Komponenten wird der Installationsvorgang mit 
dem Import von Datenbeständen aus früheren Versionen fortgesetzt.

Datenbestände von früheren Versionen übernehmen

Nach dem Abschluss der Installation wird der Dialog Freelance Software Setup / 
Verzeichnis importieren angezeigt.

Falls Sie bereits mit einer älteren Freelance-Version gearbeitet haben und nun die 
aktuelle Version in ein anderes Verzeichnis installiert haben, können Sie mit diesem 

Freelance verwendet eine eigene dll(HBGina.dll) zur grafischen Identifikation 
und Authentifikation in Windows XP.

Wird während der Installation ein Konflikt mit der auf dem PC vorhandenen 
Authentifikation erkannt, wird eine Warnmeldung angezeigt. Wird der 
Installationsvorgang fortgesetzt, wird die HBGina.dll der Freelance-Software 
installiert. Dies kann Auswirkungen auf bestimmte Funktionen anderer 
Applikationen haben.

In 

In Windows 7 Professional wird die HBGina.dll nicht verwendet.
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Dialog alle Projekt- und Archivdaten in das neue Freelance-Installationsverzeichnis 
kopieren.

tb507 gr.bmp

Falls Ihre Projektdaten in das neue Verzeichnis kopiert werden sollen, aktivieren Sie 
die Checkbox Unterverzeichnisse importieren und navigieren zum Verzeichnis 
der bisher genutzten Freelance-Version.

Mit Weiter können Sie bei Bedarf die Datenbestände der vorherigen Version 
kopieren. Anschließend wird der Konfigurationsdialog angezeigt.

Installationseinstellungen ändern

Mit dem Configure-Dialog können Sie die Installation an Ihre Rechner und 
Erfordernisse anpassen. Sie können die Einstellungen aber auch später noch ändern, 
nachdem die Installation abgeschlossen ist. Eine Neu-Installation ist dazu nicht 
erforderlich.

Weitere Informationen zum Konfigurationsdialog finden Sie im Kapitel 
Installationseinstellungen anpassen auf Seite 68.

Mit dem OK-Button in dem Konfigurationsdialog beenden Sie diesen Teil der 
Installation. Im folgenden Dialog wird angezeigt, dass die Installation damit 
vollständig ist.
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Installation abschließen

tb500_31 gr.bmp

Wählen Sie die gewünschte Möglichkeit:

Ja Der Rechner wird sofort neu gestartet.

Nein Es werden noch weitere Freelance-Produkte installiert. Der 
Rechner wird erst nach Fertigstellung der Gesamtinstallation neu 
gestartet.

Mit der Taste Fertigstellen können Sie die Installation abschließen.

Es erscheint ggf. der Hinweis, dass der Rechner neu gestartet werden muss. Wenn 
Sie noch weitere Freelance-Produkte auf diesem Rechner installieren wollen, 
genügt es, wenn Sie den Rechner neu starten, nachdem alle Installationsschritte 
abgeschlossen sind.

Falls Sie den CBF-Viewer installiert haben, müssen Sie diesen einmal aufrufen, 
um den Konfigurations-Assistenten für den CBF-Viewer zu starten. Weitere 
Informationen finden Sie in den Installationshinweisen für den CBF Viewer, die 
zusammen mit der Software auf Ihrem Rechner installiert worden sind.
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Wartungsmodus
Wird das Setup-Programm auf einem Rechner gestartet, auf dem bereits eine oder 
mehrere Freelance-Komponenten derselben Version installiert sind, wechselt das 
Setup-Programm in den Wartungsmodus.

tb500_12 gr.bmp
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Ändern

Mit dieser Option können Sie Komponenten der Freelance Software hinzufügen 
oder entfernen. Die Komponenten werden in einer Baumstruktur angezeigt.

tb500_16 gr.bmp

Die Komponenten, die bereits auf Ihrem Rechner installiert sind, sind mit einem 
Haken gekennzeichnet.  Alle anderen Komponenten werden ohne Haken angezeigt. 

Um eine Komponente, die schon auf dem System installiert ist, zu entfernen, 
löschen sie den Haken, indem Sie auf die entsprechende Checkbox klicken. 

Wählen Sie die zu installierenden oder zu deinstallierenden Komponenten und 
klicken Sie auf Weiter.

Das Installationsprogramm führt die erforderlichen Änderungen durch. Klicken Sie 
im nachfolgenden Dialog auf Fertig stellen, um die Installation abzuschließen.
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Reparieren

Mit dieser Option können Sie bereits installierte Komponenten neu installieren, um 
versehentlich überschriebene Dateien oder Einstellungen wieder herzustellen. 

Wenn eine Datei, ein Registry-Key oder der Inhalt einer installierten Komponente 
auf Ihrem PC beschädigt ist, können Sie mit dieser Option die Komponente 
reparieren oder ihren Inhalt wieder herstellen. Das Setup-Programm ersetzt oder 
repariert und prüft die Dateien und Registry-Keys der Freelance-Komponenten.

Wählen Sie Reparieren und dann Weiter, um die erforderlichen Reparaturen 
durchzuführen.

Zum Abschluss wird der Konfigurationsdialog angezeigt. Kontrollieren Sie alle 
Einstellungen und modifizieren Sie sie, falls erforderlich. Sie können die 
Einstellungen aber auch später noch ändern, nachdem die Installation abgeschlossen 
ist. Eine Neu-Installation ist dazu nicht erforderlich. Eine ausführliche 
Beschreibung finden Sie in dem Kapitel Installationseinstellungen anpassen auf 
Seite 68.

Klicken Sie auf Weiter und anschließend auf Fertig stellen, um die Reparatur 
abzuschließen. Das Programm bietet Ihnen die Möglichkeit, Ihren Rechner sofort 
oder später neu zu starten. Wählen Sie die gewünschte Option. Mit Fertigstellen 
schließen Sie die Reparatur der Software-Komponenten ab.

Entfernen

Mit dieser Option können Sie alle Freelance-Komponenten von Ihrem Rechner 
entfernen. Wenn Sie diese Option wählen und anschließend auf Weiter klicken, 
werden alle installierten Freelance-Komponenten von Ihrem Rechner entfernt.

Wählen Sie im Wartungsdialog die Option Entfernen und klicken Sie auf Weiter. 
In dem nachfolgenden Dialog müssen Sie dann bestätigen, dass Sie die Freelance-
Komponenten löschen möchten. Klicken Sie auf Ja, wenn Sie die Deinstallation 
fortsetzen möchten.

Die Option Reparieren berücksichtigt keine eventuell installierte Hotfixe oder 
Rollups. Alle Hotfixe und Rollups müssen Sie nach dem Reparieren erneut von 
Hand installieren.



Installationseinstellungen anpassen Kapitel 2  Installation Freelance

68 3BDD012560R0503_Getting_Started

 

E
n

g
lis

h
D

eu
ts

ch

Alle Freelance-Komponenten werde von Ihrem Rechner entfernt. 
Anwendungsdaten wie Protokolle, Archive, Projekte und Exportdateien bleiben 
hingegen erhalten. Diese können manuell gelöscht werden, falls sie nicht mehr 
benötigt werden. Wenn ein Benutzerkonto angelegt wurde, bleibt auch dieses 
erhalten.

Nach erfolgreicher Deinstallation wird das Fenster Deinstallation abgeschlossen 
angezeigt. Das Programm bietet Ihnen die Möglichkeit, Ihren Rechner sofort oder 
später neu zu starten. Wählen Sie die gewünschte Option und klicken Sie auf 
Fertigstellen, um das Entfernen von Software Komponenten abzuschließen.

Weitere Informationen zur Deinstallation von Freelance finden Sie im Kapitel 
Deinstallieren vor Neuinstallation auf Seite 46.

Installationseinstellungen anpassen
Mit dem Programm Configure können Sie die Freelance-Software konfigurieren 
und warten. Das Programm wird automatisch gestartet, wenn die 
Softwareinstallation abgeschlossen ist; es kann aber auch jederzeit über das 
Windows-Startmenü aufgerufen werden.

Erstkonfiguration der Freelance-Software

Selektieren Sie in der Baumstruktur im linken Dialogteil nacheinander alle Einträge, 
um die Einstellungen vorzunehmen. Sobald die Konfiguration abgeschlossen ist, 
klicken Sie auf OK, um die Änderungen zu übernehmen und den Dialog zu 
schließen.

> Start > Alle Programme > ABB Industrial IT > Freelance V9.2  SP1
> Configure
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Allgemeine Einstellungen

tb500_20 gr.bmp

Modi

Der Installationsmodus (Demo/Produktion) kann in diesem Dialog geändert 
werden, ohne die Software neu zu installieren.

Demo-Modus: Für Test- und Demonstrationszwecke

Produktions-Modus:
Für Produktionsbedingungen

Mit der Einstellung Produktions-Modus wird DigiVis so installiert, dass es nach 
dem Windows-Start automatisch startet. Nach dem Neustart startet Windows 
automatisch die DigiVis-Software. Der Zugriff des DigiVis-Benutzers auf das 
Betriebssystem wird damit unterbunden.
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Benutzer-Account-Daten
In diesem Dialog wird der DigiVis-Benutzer für den Autostart im 
Produktions-Modus wird festgelegt. Die Standardeinstellungen 
„Freelancer” mit dem Passwort „welcome123#” können beliebig 
geändert werden.

Zeitsynchronisation
Hier ist es möglich die Zeit von Prozess-Station und Windows-
Rechner zu synchronisieren.

IP-Adresse Mit der IP-Adresse werden Geräte am Netz eindeutig identifiziert.
Eingabe der IP-Adresse: 172.16.1.x. 
Für weitere Informationen siehe Netzwerkeinstellungen und IP-
Adressen auf Seite 36.

Subnet-Maske Definiert, ob sich das angesprochene Gerät im gleichen Netz 
befindet oder über Router angesprochen werden muss.
Eingabe: 255.255.240.0

Autorisierungs-Code installieren

Mit dem Kauf der Freelance-Software haben Sie eine Autorisierungscode-Datei von 
ABB erhalten. Geben Sie den Laufwerksbuchstaben und/oder Verzeichnispfad ein 

Wenn der Benutzer „Freelancer” noch nicht existiert, wird er während der 
Installation angelegt und mit Administratorrechten versehen. Er gehört der 
Gruppe „Administratoren” an.

Wird ein anderer Benutzer angegeben, muss sichergestellt sein, dass er ebenfalls 
der Gruppe „Administratoren”  angehört.

Diese Einstellung sollte für alle Rechner eines Freelance-Systems einheitlich 
gesetzt werden.

Sie müssen die Zeitsynchronisation dann aktivieren, wenn Sie im Freelance-
System die DigiVis-Software einsetzen und Trendbilder verwenden. 

Sollten Sie Ihr Freelance-System in einem Netzwerk mit anderen 
Netzwerkkomponenten betreiben, sollten Sie sich an Ihren 
Netzwerkbeauftragten wenden, bevor Sie die IP-Adressen vergeben.
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oder wählen Sie das Verzeichnis, in dem sich die Autorisierungsdatei befindet, mit 
Hilfe des Browser-Buttons aus.

Mit dem Button Installieren wird der Autorisierungscode in das 
Installationsverzeichnis übertragen.

Default-Sprache

Wenn Sie die Freelance-Software in mehr als einer Sprache installiert haben, 
können Sie die Sprache der Benutzeroberfläche auswählen, indem Sie in der 
Windows-Systemsteuerung unter Regions- und Sprachoptionen die gewünschte 
Regionale Einstellung wählen.

Wenn Sie eine Regionale Einstellung in Windows gewählt haben, die Freelance-
Software in dieser Sprache aber nicht installiert ist, können Sie mit diesem Dialog 
bestimmen, welche Sprache in der Benutzeroberfläche der Freelance-Software 
verwendet wird.

z. B.:

Sie haben die Freelance-Software auf Englisch und auf Französisch installiert, aber 
in Windows Russisch als Regionale Einstellung ausgewählt. In diesem Fall können 
Sie in diesem Dialog festlegen, ob die Benutzeroberfläche der Freelance-Software 
in Englisch oder Französisch angezeigt werden soll.

Für die Oberfläche der Software-Pakete 

• Control Builder F

• DigiVis

• DigiBrowse

• Security Lock

• OPC-/Trend-Server

Die Auswahl ist nur möglich, wenn die entsprechenden Pakete auf diesem Rechner 
installiert wurden.
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Einstellungen für Control Builder F

tb500_21 gr.bmp

Ressource-ID Auf einem PC können mehrere Software-Pakete gleichzeitig 
betrieben werden. Um diese Pakete eindeutig adressieren zu 
können, muss jedes der Software-Pakete eine eindeutige Nummer, 
die Ressource-Identifikationsnummer, erhalten.
Auch alle Ressourcen innerhalb eines Control Builder F-Projektes 
müssen eine eindeutige Ressource-ID besitzen.

Urladen Boot-EPROM

Die Boot-EPROMs auf AC 800F- und AC 700F-Controllern, den CPU-Baugruppen 
der rackbasierten Prozess-Stationen sowie den DCP-Gateway-Stationen werden 
aktualisiert.

Nach dem Laden des Boot-EPROMs führt die Prozess-Station einen Kaltstart 
durch.
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Voraussetzung dafür ist, dass das TCP/IP-Protokoll geladen und über den 
Systembus eine Verbindung zu den AC 800F-, AC 700F-, Prozess- und Gateway-
Stationen besteht.

IP Address/Host Name
Die IP-Adresse oder den Host-Namen der Station für den 
Download.
Wenn Sie eine redundante Station verwenden, geben Sie beide 
Adressen (IP-Adresse 1 und IP-Adresse 2) bzw. beide Host-Namen 
an.

Nach Betätigung des Buttons Laden wird die aktuelle Version der Boot-EPROMs 
auf die jeweils adressierte CPU-Baugruppe bzw. den Controller geladen.

Wenn Sie mehrere AC 800F, AC 700F, Prozess-Stationen oder Gateway-Stationen 
haben, müssen Sie diesen Vorgang für jede Station durchführen.

Laden Profibus-Modul-EPROM

Die EPROMs der Profibus-Module der angeschlossenen AC 800F-Controller  
können mit der aktuellen Version geladen werden.

Nach Eingabe der IP-Adresse oder des Host-Namens eines AC 800F-Controllers 
wird die aktuelle EPROM-Version auf alle Profibus-Module dieses Controllers 
geladen.

Wenn Sie eine redundante Station verwenden, geben Sie beide Adressen (IP-
Adresse 1 und IP-Adresse 2) bzw. beide Host-Namen an.

Laden HSE-Modul-EPROM

Die EPROMs der HSE-Module der angeschlossenen AC 800F-Controller können 
mit der aktuellen Version geladen werden.

Nach Eingabe der IP-Adresse oder des Host-Namens eines AC 800F-Controllers 
wird die aktuelle EPROM-Version auf alle HSE-Module dieses Controllers geladen.

Wenn Sie eine redundante Station verwenden, geben Sie beide Adressen (IP-
Adresse 1 und IP-Adresse 2) bzw. beide Host-Namen an.

In der aktuellen Version wird die Redundanzfunktion für den AC 700 F nicht 
unterstützt.
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E/A-EPROM-Import

Aktuelle Versionen für die EPROMs der E/A-Baugruppen einer rackbasierten 
Prozess-Station können von einer Diskette oder einem Dateiverzeichnis auf den PC 
importiert werden. 

Geben Sie den Laufwerksbuchstaben und/oder Verzeichnispfad ein oder wählen Sie 
das Verzeichnis, in dem sich die E/A-EPROM-Dateien befinden, mit Hilfe des 
Browser-Buttons aus

Mit dem Button Importieren werden alle E/A-EPROM-Dateien aus dem 
angegebenen Verzeichnis in das System importiert.

Seitenlayout

tb500_34 gr.bmp

Für die Projekt-Dokumentation wird in diesem Dialog das Layout der Druckseiten 
festgelegt.

Zum Laden der E/A-EPROMs in die entsprechenden Baugruppen müssen Sie im 
Inbetriebnahme-Modus des Control Builder F die E/A-Baugruppen anwählen 
und den Ladevorgang starten.
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Dimensions- /Meldungstexte

Spracheinstellung

Die Auswahlliste enthält die Sprachabkürzungen der Dateien für die Dimensions- 
und Meldetexte, die bereits auf ihrem PC installiert wurden. Mit der Installation 
wird eine Datei “digit<sprache>.str”, z. B. digitgr.str, in das Installations-
verzeichnis kopiert. Nach Auswahl der Sprachkennung wird die entsprechende 
Datei nach “digitool.str” kopiert. Die Texte dieser Datei werden bei der Erstellung 
des Anwenderprogramms im Control Builder F verwendet und beim Laden des 
Programms zur Leitstation übertragen.

Bitte wählen Sie die Sprache aus, die Sie später auf der Leitstation verwenden 
wollen.

Import

Mit dem Button Laden werden alle Dateien mit dem Namen “digit<sprache>.str” 
aus dem angegebenen Verzeichnis in das Installationsverzeichnis kopiert; 
anschließend können sie mit dem Dialog Spracheinstellung dem Control Builder F 
verfügbar gemacht werden.

Die Standard-Dateien können mit einem Text-Editor geändert werden. Die Struktur 
der Datei muss beibehalten werden.

Unter der Sektion [PARA] werden die Texte wie folgt definiert:

DIMENSION_0 = dim_text1
DIMENSION_1 = dim_text2
DIMENSION_2 = dim_text3
...

NOTIFICATION_0 = meldetext1
NOTIFICATION_1 = meldetext2
NOTIFICATION_2 = meldetext3
...

Verwenden Sie diesen Dialog, wenn Sie die Standard-Datei mit einem Text-Editor 
an Ihre Projekt-Anforderungen und Bedürfnisse angepasst haben.

Die Auswahl ist nur möglich, wenn mehr als ein Sprache installiert worden ist.
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Einstellungen für DigiVis

tb500_23 gr.bmp

Ressource-ID Auf einem PC können mehrere Software-Pakete gleichzeitig 
betrieben werden. Um diese Pakete eindeutig adressieren zu 
können, muss jedes der Software-Pakete eine eindeutige Nummer, 
die Ressource-Identifikationsnummer, erhalten.
Auch alle Ressourcen innerhalb eines Control Builder F-Projektes 
müssen eine eindeutige Ressource-ID besitzen.

DigiVis-System-Sicherheit wiederherstellen
Nur notwendig, falls beim Start von DigiVis die Meldung „DigiVis 
Sicherheitssystem beschädigt! Zur Wiederherstellung benutzen Sie 
bitte das Konfigurationstool!“ erscheint, z.B. nach der 
Neuinstallation einer Netzsoftware.
Die erfolgreiche Ausführung wird gemeldet.
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Vis Autostart

Es besteht die Möglichkeit, DigiVis so zu installieren, dass es nach dem Windows-
Start automatisch startet.

Ja, DigiVis automatisch starten. (Empfohlen)
Mit dem Einschalten des PCs werden bei einem Benutzer mit 
automatischem Login das Windows-Betriebssystem und 
anschließend DigiVis gestartet.
Lediglich die Applikationen, die vor dem Start von DigiVis 
gestartet wurden, sind vom DigiVis-Anwender über die 
Tastenkombination ALT+TAB erreichbar.

Nein, DigiVis manuell starten
Es erfolgt kein automatischer Start von DigiVis. DigiVis kann über 
das Startmenü gestartet werden.

Druckereinstellungen

Für jede Leitstation werden zwei Drucker unterstützt. Ein Drucker sollte für die 
kontinuierliche Ausgabe des Signalfolgeprotokolls genutzt werden. Der andere 
Drucker steht dann für die Ausgaben von Betriebs- oder Störablaufprotokollen zur 
Verfügung. Einer der beiden Drucker wird zusätzlich für Hardcopies verwendet.

Drucker 1 Auswahl eines unter Windows installierten Druckers, z. B. für 
Endlospapier.

Drucker 2 Auswahl eines unter Windows installierten Druckers, z. B. eines 
Farbdruckers.

Hardcopy Drucker 1 / 2
Auswahl eines der eingetragenen Drucker für die Ausgabe einer 
Hardcopy vom Bediener.

Ränder von Drucker 1 / 2 in cm
Das Seitenlayout für die beiden installierten Drucker wird 
festgelegt.

Wählen Sie für die Hardcopies keinen Drucker aus, auf dem 
Signalfolgeprotokolle ausgegeben werden.
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Einstellungen für DigiBrowse

Mit diesem Dialog wird festgelegt, ob der Anwender innerhalb von Browse 
Archivdateien löschen kann.

Einstellungen für DDE

Ressource-ID Auf einem PC können mehrere Software-Pakete gleichzeitig 
betrieben werden. Um diese Pakete eindeutig adressieren zu 
können, muss jedes der Software-Pakete eine eindeutige Nummer, 
die Ressource-Identifikationsnummer, erhalten.
Auch alle Ressourcen innerhalb eines Control Builder F-Projektes 
müssen eine eindeutige Ressource-ID besitzen.

DDE wird nur unterstützt, wenn das Freelance-System auf einem Rechner mit 
dem Betriebssystem Windows XP läuft. Unter Windows 7 steht DDE nicht zur 
Verfügung.
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Einstellungen für OPC-Server

tb500_26 gr.bmp

Neue Ressource-ID
Bei der Installation wird die OPC-Software auf den PC installiert, 
aber keine Instanz erzeugt. Geben Sie die Ressource-ID an, unter 
welcher der OPC-Server ausgeführt werden soll.
Auf einem PC können mehrere Software-Pakete gleichzeitig 
betrieben werden. Um diese Pakete eindeutig adressieren zu 
können, muss jedes der Software-Pakete eine eindeutige Nummer, 
die Ressource-Identifikationsnummer, erhalten.
Auch alle Ressourcen innerhalb eines Control Builder F-Projektes 
müssen eine eindeutige Ressource-ID besitzen.

Hinzufügen Nach Eingabe einer Ressource-ID wird mit dieser Taste eine 
Instanz des OPC-Server erzeugt. Sie können auf diese Art mehrere 
OPC-Server-Instanzen auf einem PC erzeugen.
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Separate Alias ID konfigurieren
Zusätzlich zu der Ressource-ID, die innerhalb eines Freelance-
Projektes für die Kommunikation verwendet wird, kann eine 
andere, zweite Ressource-ID konfiguriert werden. Zwei 
unterschiedliche Ressource-IDs sind erforderlich, wenn eine 
redundante OPC-Verbindung für ein Bediensystem Operate IT 
Process Portal A aufgebaut werden soll. Für Standard-
Anwendungen darf diese Checkbox nicht angewählt sein.

Vorhandene Ressource-IDs
In der Liste werden die Ressource-IDs der auf diesem PC erzeugten 
OPC-Server F-Instanzen aufgelistet.

Konfigurieren Der in der Liste ausgewählte OPC-Server kann mit einem anderen 
Benutzerkonto ausgeführt werden.

Entfernen Nach Anwahl eines Listeneintrags wird diese Instanz des OPC-
Server F gelöscht.

Durch das Löschen der letzten Instanzen des OPC-Server F auf einem Rechner 
wird nicht automatisch auch die OPC-Server-Software gelöscht.
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Einstellungen für Trend-Server 

tb500_28 gr.bmp

Trend-Server Ressource-ID
Bei der Installation wird die Software auf den PC installiert, aber 
keine Instanz erzeugt. Geben Sie die Ressource-ID an, unter 
welcher der Trendserver ausgeführt werden soll.
Auf einem PC können mehrere Software-Pakete gleichzeitig 
betrieben werden. Um diese Pakete eindeutig adressieren zu 
können, muss jedes der Software-Pakete eine eindeutige Nummer, 
die Ressource-Identifikationsnummer, erhalten.
Auch alle Ressourcen innerhalb eines Control Builder F-Projektes 
müssen eine eindeutige Ressource-ID besitzen.

Ändern Nach Eingabe einer Ressource-ID wird eine Instanz des 
Trendservers erzeugt. Wollen Sie den Trendserver unter einer 
anderen Ressource-ID verwenden, so editieren Sie die angezeigte 
Nummer und drücken Sie erneut den Button Ändern.
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Soll der Trend-Server vom lokalen PC entfernt werden, so löschen 
Sie die angezeigte Nummer und drücken Sie Ändern.

Konfigurieren Der Trend-Server kann mit einem anderen Benutzerkonto 
ausgeführt werden.

Änderungen bestätigen

Wenn alle Einstellungen vorgenommen worden sind, werden sie mit OK bestätigt, 
und das Programm Configure wird beendet.

Installation abgeschlossen
Wir wünschen Ihnen viel Erfolg bei der Umsetzung Ihrer Automatisierungsauf-
gaben mit Freelance. Der Control Builder F wird Ihnen dabei die Arbeit erheblich 
erleichtern. Nicht zuletzt durch Standards wie Windows und den der IEC 61131-3 
handelt es sich hierbei um ein innovatives Produkt, dass durch den Ansatz einer 
gemeinsamen Datenbank für die Konfiguration der Anwenderprogramme und 
Visualisierung in diesem Bereich Maßstäbe setzt.

Sollten Sie wider Erwarten Probleme bei der Installation haben, so wenden Sie sich 
bitte an Ihren Freelance-Lieferanten oder an Ihre ABB-Vertretung vor Ort.

Überprüfen der Installation mit Check
Mit dem Testprogramm Check kann die Installation überprüft werden.

> Start > Alle Programme > ABB Industrial IT > Freelance V9.2 
> Tools > Check
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Mit Check > All Components wird ein kompletter Test aller installierten 
Freelance-Komponenten gestartet. Überprüft werden alle installierten Dateien.

Das Check-Programm kann auch aus dem Control Builder F über Hilfe > Info > 
System Informationen gestartet werden.

Es kann ein Testprotokoll ausgegeben werden, das es Ihnen ermöglicht, den Soll- 
und Ist-Stand zu vergleichen. Die Ausgabe erfolgt wahlweise in Datei oder auf 
einen Drucker.

OPC-Tunnel
Der OPC Tunnel ist eine neue Software, die ab der Version 9.2 im Freelance-System 
zu Verfügung steht. Der OPC-Tunnel vereinfacht die Kommunikation und 
Konfiguration zwischen OPC-Servern und ihren Clients in einer dezentralen 
Umgebung. Diese Software dient auch zur Kommunikation zwischen DigiVis-
Knoten und OPC/Trend-Servern.
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Die OPC-Tunnel-Software besteht aus drei Hauptkomponenten: OPC Tunnel Client, 
OPC Tunnel Server und OPC Tunnel Configurator.

Tunnel Architecture gr.bmp 

Die OPC Tunnel Client-Seite ist sowohl in den Control Builder F als auch in 
DigiVis integriert und wird automatisch gestartet.

Der OPC Tunnel Server verfügt über ein separates Konfigurationsprogramm, das 
nicht Bestandteil vom Control Builder F oder von DigiVis ist.

Der OPC Tunnel Konfigurator dient zum Einstellen der Kommunikationsparameter 
für den Tunnel.

OPC-Tunnel-Server installieren

Das Freelance Setup-Programm installiert den OPC-Tunnel, wenn die 
entsprechende Checkbox im Dialog „Arbeitsstationtyp“ aktiviert ist.

tb500_2 gr.bmp
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Konfiguration des OPC-Tunnels

OPC-Tunnel-Konfigurator starten:

Der folgende Dialog erscheint:

Tunnel Configurator gr.bmp

In diesem Dialog werden die PROG-IDs des OPC-DA-Servers und des OPC-AE-
Servers sowie die Portnummern für diese Dienste angegeben.

Der OPC-Tunnel-Server muss immer auf dem gleichen Rechner installiert sein 
wie der OPC-Server.

Start > Programme > ABB Industrial IT > Freelance > OPC Tunnel > 
Konfigurator

Die Bezeichnungen der Freelance OPC-Server lauten:

DA Server: Freelance2000OPCServer.<ResID>
AE Server: Freelance2000OPCAEServer.<ResID>

Die letzten beiden Stellen <ResID> der Prog-ID bilden die eindeutige Ressource-
ID des Servers.

Der Standard-Port für den Tunnel ist 9950. Sollte der Benutzer diesen Port 
ändern, müssen die enstprechenden Änderungen auch bei der Ressource-
Konfiguration des OPC-Gateways D-GS (im Projektbaum) vorgenommen 
werden.

Die AE-Elemente werden nicht für einen Trend-Server verwendet.
Bei einem Trend-Server wird nur der DA-Server konfiguriert, während das Feld 
für den AE-Server leer bleibt.
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Klicken Sie auf OK, um die Werte zu speichern.

Führen Sie nun einen Neustart des OPC-Tunnels durch:

OPC-Tunnel-System-Tray

Durch Starten des System-Trays in der Taskleiste lässt sich das Aufrufen des 
Konfigurators für den OPC-Tunnel vereinfachen.

Der jeweilige Status des OPC-Tunnels wird durch ein Icon in der Windows 
Taskleiste angezeigt. Durch einen rechten Mausklick auf dieses Icon können Sie das 
folgende Menü aufrufen.

Tunnel System Tray gr.bmp

Diagnose des OPC-Tunnels

Die Diagnosedaten für den OPC-Tunnel können in einer Protokolldatei erfasst 
werden. Dazu wird der erweiterte Konfigurator gestartet.

Falls das OPC Tunnel System Tray noch nicht läuft, starten Sie es mit:

Start > Alle Programme > ABB Industrial IT > Freelance > OPC-Tunnel > 
System-Tray

In der Taskleiste mit der rechten Maustaste auf das Icon für das OPC-Tunnel-
System-Tray klicken.

 Restart Server wählen

Bei einer Änderung der Tunnelkonfiguration muss der OPC-Tunnel neu gestartet 
werden.

Start > Alle Programme > ABB Industrial IT > Freelance > OPC-Tunnel 
> System-Tray

Start > Alle Programme > ABB Industrial IT > Freelance > OPC-Tunnel 
> Erweiterter Konfigurator
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Tunnel Diagnostics gr.bmp

FTP-Server
DigiVis und der ControlBuilder F haben integrierte FTP-Clients. Für einige 
Funktionen wie die automatische Archivierung kann ein FTP-Server verwendet 
werden. Diese Kapitel beschreibt die grundsätzliche Vorgehensweise bei der 
Installation eines FTP-Servers.

Es wird empfohlen, in Verbindung mit dem Freelance-System den Microsoft FTP-
Server zu verwenden. Er wird mit einigen Versionen des Windows-Betriebssystems 
ausgeliefert und kann über die Windows-Systemsteuerung mit “Programme ändern 

Diese Funktion sollte ausschließlich von L3/L4-Supportpersonal oder von sehr 
erfahrenen Systemanwendern benutzt werden.

Die Protokolldateien (z.B. Trace.txt) werden im Pfad <Freelance-
Installationsverzeichnis>\OPCTunnel angelegt. 
Der Pfad wird dann in das Diagnosefenster eingegeben.
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oder hinzufügen” installiert werden. Er wird als Service-Prozess ausgeführt und 
verwendet die Wartungs-Infrastruktur des Internet-Informationsservers.

Aus Gründen der Datensicherheit wird empfohlen, den FTP-Server auf einem 
separaten Rechner innerhalb des Prozess-Stationen-Netzwerks auszuführen. Ein 
typisches Netzwerk ist folgendermaßen aufgebaut:

FTP Scenerio gr.bmp

Aus Sicherheitsgründen sollte für das Einloggen in den FTP-Server ein spezieller 
FTP-Login-Benutzer mit eingeschränkten Rechten angelegt werden. Sie können 
zu diesem Zweck beispielsweise einen Windows-Benutzer namens 
„FreelancerFTP” auf dem Rechner mit dem FTP-Server anlegen.

Für den FTP-Betrieb sollten Sie ein eindeutiges Passwort verwenden.

Es ist nicht erforderlich, den Windows-Benutzer auch auf den Rechnern mit den 
FTP-Clients anzulegen.

Der FTP-Benutzer muss berechtigt sein, auf alle Stammverzeichnisse des FTP-
Servers und auf alle Unterverzeichnisse auf Dateisystemebene zuzugreifen. 
Andernfalls können möglicherweise Dateien nicht gelesen oder geschrieben 
werden.
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Die folgenden Kapitel zur FTP-Server-Installation und -Konfiguration sind so 
einfach wie möglich gehalten. Ziel ist es, Ihnen einen Einstieg zu vermitteln, von 
dem aus die Installation dann nach Bedarf an Ihre Anforderungen angepasst werden 
kann.

FTP-Server unter Windows XP

FTP-Server installieren 

Der FTP-Server wird installiert.

Bei der beschriebenen Basiskonfiguration werden die FTP-Passwörter als 
Klartext über das Netzwerk übertragen.

Mit den Netzwerk- und Systemadministratoren muss deshalb eine Strategie für 
eine sichere FTP-Installation erarbeitet werden.

> Start > Systemsteuerung  > Programme hinzufügen oder entfernen
> auf Windows-Komponenten hinzufügen/entfernen klicken
> Internet-Informationsdienste (IIS) anwählen > auf den Button Details... 
klicken FFTP-Dienst (File Transfer Protocol) aktivieren 
> prüfen, ob Snap-In Internet-Informationsdienste ebenfalls angewählt ist 
> auf OK klicken > auf Weiter klicken
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FTP-Server konfigurieren

FTP WinXP Default FTP Site gr.bmp

Mit der rechten Maustaste auf Standard-FTP-Site klicken und Eigenschaften 
wählen. Der Konfigurationsdialog für den FTP-Server wird angezeigt.

> Start > Systemsteuerung > Verwaltung
> Doppelklick auf Computerverwaltung >
Dienste und Anwendungen aufklappen > Internetinformationsdienste > FTP-
Sites > Standard-FTP-Site.
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FTP WinXP FTP Security gr.bmp

Auf die Registerkarte Sicherheitskonten klicken.
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Die Checkbox Nur anonyme Verbindungen zulassen deaktivieren, um den 
anonymen Zugang zu unterbinden.

FTP WinXP Default FTP Site Properties gr.bmp

Klicken Sie auf die Registerkarte Basisverzeichnis.

Wählen Sie das geeignete Verzeichnis der FTP-Site.

Aktivieren Sie die Checkboxen der drei Zugangsmöglichkeiten Lesen, Schreiben 
und Besuche protokollieren.

Klicken Sie auf OK, um die Konfiguration des FTP-Servers abzuschließen. Die 
Basiskonfiguration des FTP-Servers ist damit fertiggestellt.

Der FTP Login-Benutzer - z. B. “FreelancerFTP” - ,muss die erforderlichen 
Zugriffsrechte für das Verzeichnis der FTP-Site - hier “D:\FTP” - und für alle 
Unterverzeichnisse auf Dateisystemebene haben. Andernfalls kann er 
möglicherweise keine Dateien lesen oder schreiben, auch wenn der Server dies 
zulässt.
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FTP Server unter Windows 7

FTP-Server installieren 

FTP Server Win7 Windows Features gr.bmp

Der FTP-Server wird installiert.

> Start > Systemsteuerung > Programme > Programme und Funktionen >
links in der Navigationsleiste auf Windows-Funktionen aktivieren oder 
deaktivieren klicken.
Die Windows-Funktionen werden angezeigt.
Internetinformationsdienste > FTP Server erweitern und FTP-Server 
aufrufen > Internetinformationsdienste > Webverwaltungstools aufrufen und 
IIS Verwaltungskonsole wählen > auf OK klicken
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FTP-Server konfigurieren

Die IIS-Verwaltungskonsole wird angezeigt. Sie besteht aus einer linken 
Baumansicht namens „Verbindungen”, einem rechten Bereich namens 
„Aktionen” und einem kontextabhängigen Bereich in der Mitte.

Ein Assistent zur Konfiguration der FTP-Site erscheint.

FTP Add FTP Site gr.bmp

Geben Sie die Eigenschaften für die FTP-Site ein:

FTP-Sitename:
Geben Sie einen frei definierbaren Namen für Ihre Site ein, 
beispielsweise „Default FTP Site”.

> Start > Systemsteuerung > System und Sicherheit > Verwaltung
> Doppelklick auf Computerverwaltung 
Dienste und Anwendungen aufklappen > Internetinformationsdienste

> In der Baumansicht Verbindungen den Stammknoten öffnen
> Sites wählen > Rechtsklick auf Sites und dann FTP Site hinzufügen... wählen.
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Physikalischer Pfad:
Wählen Sie einen Stammverzeichnispfad für die FTP-Site. Unter 
diesem Verzeichnispfad wird dann der Inhalt der FTP-Site abgelegt.

Klicken Sie auf Weiter.

Nun können Sie die Bindungs- und SSL-Einstellungen konfigurieren. 

FTP Binding and SSL figure gr.bmp

Wählen Sie Kein anstelle von SSL.

Klicken Sie auf Weiter, um mit dem Assistenten fortzufahren.
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Die Authentifizierungs- und Autorisierungsinformationen werden angezeigt.

FTP Basic Authentication gr.bmp

Aktivieren Sie die Authentifizierung Standard.

Wählen Sie in der Liste unter Autorisierung, den Eintrag Alle Benutzer aus.

Wählen Sie unter Berechtigungen sowohl Lesen als auch Schreiben.

Klicken Sie auf Fertig. Die Basiskonfiguration des FTP-Servers ist damit 
fertiggestellt.

Firewall-Regeln für FTP aktivieren

Nachdem der FTP-Server installiert worden ist, blockiert die Windows Firewall mit 
erweiterter Sicherheit zunächst jeglichen externen FTP-Datenverkehr. Um den 
Zugriff von/nach außen vorzubereiten, hat das Installationsprogramm des FTP-

Der FTP Login-Benutzer - z. B. “FreelancerFTP” - ,muss die erforderlichen 
Zugriffsrechte für das Verzeichnis der FTP-Site - hier “D:\FTP” - und für alle 
Unterverzeichnisse auf Dateisystemebene haben. Andernfalls kann er 
möglicherweise keine Dateien lesen oder schreiben, auch wenn der Server dies 
zulässt.
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Servers bereits fünf vorkonfigurierte Firewall-Regeln angelegt, drei eingehende und 
zwei ausgehende, die nur noch aktiviert werden müssen.

Öffnen Sie den Konfigurationsdialog für die Windows-Firewall mit erweiterter 
Sicherheit.

Aktivieren Sie die folgenden eingehenden Regeln:

1. FTP Server(Eingehender FTP-Datenverkehr)

2. FTP Server Passive(FTP Passive Traffic-In)

3. FTP ServerSecure(FTP SSL Traffic-In)

FTP Inbound FTP Rules Windows 7 gr.bmp

Aktivieren Sie die folgenden ausgehenden Regeln:

1. FTP server(FTP Traffic-Out)

2. FTP Server Secure(FTP SSL Traffic-Out)

> Start > Systemsteuerung > Verwaltung> Windows-Firewall mit 
erweiterter Sicherheit

> Eingehende Regeln wählen

> Ausgehende Regeln wählen
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FTP Outbound FTP Rules Windows 7 gr.bmp

Führen Sie im Windows-System einen Neustart des Microsoft-FTP-Services 

durch:

Der FTP-Server wird neu gestartet und die Firewall verwendet ab jetzt die 
Ausnahmeregeln.

FTP-Server testen

Gehen Sie folgendermaßen, um den FTP-Server auf korrekte Funktion zu testen:

Loggen Sie sich mit einem FTP-Client (z. B. dem Windows Kommandozeilen-FTP-
Client oder FileZilla) von einem anderen Windows-Rechner aus ein; verwenden Sie 
dazu den zuvor angelegten Benutzer mit eingeschränkten Rechten (z. B. 
“FreelancerFTP”).

Laden Sie eine Datei auf den Zielrechner hoch.

Laden Sie eine Datei vom Zielrechner herunter.

Sie können nun mit den FTP-basierten Funktionen im Control Builder F und in 
DigiVis arbeiten.

Wurde der FTP-Server erstmalig installiert, blockiert die Firewall weiterhin den 
externen Datenverkehr, und zwar so lange, bis der FTP-Server neu gestartet wird.

> Start > Systemsteuerung > System und Sicherheit > Verwaltung
> Doppelklick auf Dienste
> Microsoft-FTP-Service wählen > auf Dienst neu starten klicken
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Java Installation
Java wird dazu verwendet, Applets in einem  Web-Browser anzuzeigen. Dies ist 
dann erforderlich, wenn die folgenden erweiterten Funktionen benötigt werden:

• Einsatz des Telnet-Applets im Webinterface der Prozess-Station (z. B. 
AC800F)

• Einsatz der Java-GUI für den Controller-Emulator

Voraussetzungen

Internet Explorer 8

Installation

Java 6 Update 20 oder höher empfohlen.

Laden Sie das Java Runtime Environment (JRE) von der Website www.java.com 
herunter und installieren Sie es.

Java testen

Zum Testen der Java-Installation können Sie den Controller-Emulator verwenden. 
Starten Sie den Internet Explorer und öffnen Sie den Controller-Emulator-Manager. 
Wenn der Controller-Emulator lokal auf Ihrem Rechner läuft, finden Sie ihn unter 
http://localhost:8888.
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Starten Sie die Controll-Emulator-Station und klicken Sie das GUI-Fenster der 
Station an, deren Java-GUI sie ansehen wollen.

Der Zugriff auf den Controller-Emulator-Manager oder das Webinterface einer 
Prozess-Station kann fehlschlagen, wenn dort ein Internetproxy konfiguriert ist.

Um zu verhindern, dass bestimmte IP-Adressen über den Proxy erreicht werden 
können:

Internet Explorer starten

> Tools > Internetoptionen > Verbindungen > LAN-Einstellungen

> den Button Erweitert betätigen.

Die IP-Adressen oder IP-Adressenmuster eingeben, die nicht über den 
Internetproxy zugänglich sein sollen.
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Kapitel 3  Erste Schritte

Allgemeine Hinweise
Nachdem Sie die Installation des Control Builder F, wie im vorherigen Kapitel 
beschrieben, ausgeführt haben, können Sie sofort mit der Erstellung eines Projekts 
beginnen.

Starten Sie den Control Builder F über das Startmenü.

Sollte Ihr Hardkey nicht gesteckt sein, oder falls Sie keine Lizenzierungsdatei 
installiert haben, erhalten Sie einen Hinweis. Beheben Sie die Fehlerursache und 
starten Sie das Programm erneut.

In dem Fenster „About Control Builder F” wird Ihnen die installierte Software-
Version angezeigt. Bestätigen Sie den Dialog mit dem OK-Button.

Erstellung einer Projektdatei
Wählen Sie im Menü Projekt > Neu und definieren Sie einen Dateinamen, unter 
dem Ihr Projekt auf der Festplatte gespeichert werden soll. Als Standardverzeichnis 
wird <Freelance_Installationsverzeichnis>\proj verwendet, Sie können aber auch 
ein anderes Verzeichnis auswählen.

Nachdem Sie einen eindeutigen Dateinamen definiert haben, können in dem 
folgenden Dialog allgemeine Daten zum Projekt, wie Projektnummer, Bearbeiter, 
Kunde usw., eingegeben werden. Diese Eingaben können auch später zu jedem 
beliebigen Zeitpunkt eingegeben oder verändert werden. Durch Bestätigung des 
Dialogs mit dem OK-Button wird eine leere Projektdatei angelegt.

Im ersten Konfigurationsschritt wird die Software-Sicht des Projektes erstellt. Das 
bedeutet, es werden MSR-Stellen, Variablen und die zu rechnenden Funktionen 
definiert.
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In einem zweiten Schritt wird diese Konfiguration der existierenden Hardware, also 
den Prozess-Stationen und E/A-Einheiten, zugeordnet.

1. Schritt: Konfiguration der Software-Sicht des Projekts
Nachdem Sie die allgemeinen Projektdaten festgelegt haben, gelangen Sie über die 
Menüauswahl Konfiguration! oder den entsprechenden Toolbar-Button zur 
Software-Sicht der Konfiguration, dem Projektbaum.

Mit dem Projektbaum werden die Funktionen eines Projektes übersichtlich 
dargestellt. Die einzelnen Elemente bzw. Objekte, allgemein als Projektelemente 
bezeichnet, sind nach IEC 61131-3 strukturiert. Zum Erstellen eines Projektbaums 
selektieren Sie jeweils einen Knoten des Baumes und wählen aus dem Menü 
Bearbeiten > Einfügen nächste Ebene / Einfügen drunter oder Einfügen drüber 
oder die Einfügemöglichkeiten direkt aus dem Kontextmenü. Abhängig von dem 
selektierten Knoten des Projektbaumes bekommen Sie jeweils die Objekte 
angeboten, die an der entsprechenden Position eingefügt werden können.

Das oberste Element eines Projekts ist die  Konfiguration KONF, die alle 
Projektelemente eines Freelance-Systems zusammenfasst. 

Die erste Strukturierungsebene unterhalb der Konfiguration wird durch die 
Ressourcen gebildet, welche die verschiedenen Stationen eines Projektes 
repräsentieren. Für die eigentliche Prozessverarbeitung existieren die Ressourcen 
D-PS (Prozess-Station), für die Bedienung und Beobachtung des Prozesses die 
Ressourcen D-LS (Leitstation), für die Anbindung an Fremdsysteme die 
Ressourcen D-GS (Gateway-Station) und zur Einbindung von Daten fremder 
Systeme die Ressource OPC-S (OPC-Server).

Fügen Sie unterhalb des Konfigurationsknotens eine Prozess-Station ein. Sie 
können auswählen, ob Sie eine redundante (D-PS/RED) oder nicht-redundante (D-
PS) Prozess-Station einfügen wollen. Die weitere Spezifizierung, ob z. B. eine 
Rack-basierte Station oder ein AC 800F verwendet wird, wird zu einem späteren 
Zeitpunkt in der Hardware-Struktur vorgenommen.

Fügen Sie nun eine Prozess-Station D-PS ein und nennen Sie sie „PS”.

Nachdem ein Name für die Ressource vergeben wurde, wird im Projektbaum die 
Grundstruktur für die Ressource eingefügt. Unterhalb des Ressource-Knotens 
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werden Systemfunktionen und anwenderdefinierte Funktionen in den beiden 
Tasklisten <Res-Name>.SYSTask und <Res-Name>.USRTask verwaltet.

Durch Konfiguration der Systemtasks können Sie das Verhalten der Prozess-Station 
für spezielle Situationen wie z. B. Kaltstart, Warmstart oder 
Redundanzumschaltung festlegen.

Unterhalb des Knotens USRTask werden die anwenderdefinierten Funktionen 
festgelegt, die in der Prozess-Station ausgeführt werden sollen. Diese Funktionen 
können in verschiedenen Tasks ausgeführt werden. Eine Task wird als eigener 
Knoten im Projektbaum dargestellt.

Es ist auch möglich, eine Default-Task anzulegen. Diese Task wird immer dann 
ausgeführt, wenn keine der anderen Tasks berechnet wird. Neben der Default-Task 
können auch noch andere Tasks angelegt werden. Normalerweise wird jede Task 
wiederholt im Intervall-Modus ausgeführt, und zwar mit einem konfigurierten 
Intervall, der Taskzykluszeit.

Erstellen Sie nun eine Task.

Unterhalb jeder Task werden PL-Programme (Programmlisten) und AS-Programme 
(Programme der Ablaufsprache) spezifiziert. Unterhalb einer Programmliste wird 
die eigentliche Funktionalität in Programmen konfiguriert.

Legen Sie eine Programmliste mit einem darunter liegenden AL-Programm 
(Anweisungsliste) an. Geben Sie z. B. folgendes Programm ein (Erzeugung einer 
Sägezahnkurve):
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first01gr.bmp

Während der Eingabe werden Sie nach der Definition der verwendeten Variablen 
gefragt. Definieren Sie die Variablen Init und UP mit dem Datentyp BOOL und 
Zähler mit dem Datentyp INT.

Um das Programm zu überprüfen, wählen Sie AL-Programm > Plausibilisieren 
aus dem Menü. Eventuelle Fehler werden in einer Liste angezeigt. Durch 
Doppelklick auf eine Fehlermeldung gelangen Sie automatisch an die Stelle, an der 
dieser Fehler erkannt wurde. Korrigieren Sie die Fehler und plausibilisieren Sie 
erneut.

Über Zurück gelangen Sie wieder in den Projektbaum. In einem weiteren 
Programm soll nun der aktuelle Zählerstand überwacht und ggf. eine Alarmmeldung 
erzeugt werden.
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Fügen Sie unterhalb des AWL-Programms ein weiteres Programm vom Typ FBS-
Programm (Funktionsbausteinsprache) ein. Mit einem Doppelklick oder über 
Bearbeiten gelangen Sie in den FBS-Editor.

Wählen Sie aus dem Funktionsbaustein-Menü einen Analogüberwacher-Baustein 
M_ANA und parametrieren Sie diesen, indem Sie einen Namen vergeben, die 
Skalierung von –100.0 bis 100.0 (entsprechend dem Zähler im AWL-Programm 
setzen) setzen und bis zu 4 Grenzwerte definieren. Beispiel einer ausgefüllten 
Parametriermaske:

first02gr.bmp

Positionieren Sie eine Variable in dem FBS-Blatt. Wählen Sie dazu FBS-Elemente 
> Variable, lesend aus dem Menü (die Variable Zaehler soll gelesen und mit dem 
Eingang IN des Überwacherbausteins verbunden werden). In die Parametriermaske 
können Sie den Variablennamen direkt eintragen oder mit der Taste F2 aus einer 
Liste aussuchen. Um die Variable Zaehler mit dem Eingangspin IN des Bausteins zu 
verbinden, muss vorher der Datentyp von INTEGER in REAL gewandelt werden. 
Wählen sie dazu den Wandler-Baustein TO_RE (nach REAL) aus dem Menü aus: 
Blöcke > Wandler > Datentyp nach REAL.

Ziehen Sie eine Verbindungslinie von der Variablen zum Eingang des Wandlers und 
vom Ausgang des Wandlers zum Eingang IN des Bausteins. Kontextmenü > 
Linien zeichnen. 

Die Abarbeitungsreihenfolge wird unten rechts in den Funktionsbausteinen 
angezeigt. Sie ist nicht korrekt und muss angepasst werden. Öffnen Sie die 
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Parametermaske für den Baustein Analogüberwachung (Rechtsklick > 
Parameter...) und ändern Sie den Ablauf von 1 in 2. Die Abarbeitungsreihenfolge 
für den Wandlerbaustein wird dabei automatisch auf 2 angepasst.

Ihr Programm könnte dann etwa so aussehen:

first03gr.bmp

Wählen Sie im Menü FBS-Programm > Plausibilisieren aus, um die Plausibilität 
des Programms zu prüfen. 

Danach müssen Sie das Programm Speichern und den FBS-Editor Beenden. Nach 
Beenden des FBS-Editors gelangen Sie zurück in die Ansicht des Projektbaums. 

Prüfen Sie anschließend die Plausibilität des Projektbaums. Selektieren Sie dazu 
den obersten Knoten und wählen Sie Projekt > Alles plausibilisieren.

Eventuelle Fehler werden in einer Liste angezeigt. Durch Doppelklick auf eine 
Fehlermeldung gelangen Sie automatisch an die Stelle, an der dieser Fehler erkannt 
wurde. Korrigieren Sie die Fehler und plausibilisieren Sie das Projekt erneut.

 2. Schritt: Konfiguration der Hardware-Zuordnung
Zur Konfiguration der Hardware des Projektes wählen Sie im Menü System > 
Hardware-Struktur oder den entsprechenden Toolbar-Button. 

Mit dem Hardware-Editor werden zwei Darstellungen der Projekt-Hardware 
angezeigt. Im linken Bildschirmteil wird die komplette Hardware in einer 
Baumansicht dargestellt, im rechten Teil des Bildschirms ist eine grafische Ansicht 
des jeweils selektierten Objektes zu sehen.

Ein Projekt ohne Hardware-Konfiguration wird folgendermaßen angezeigt:
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first10gr.bmp

Die Rechnerdarstellung zeigt den Konfigurations-PC (Control Builder F) und kann 
nicht verändert werden. Die gelbe Linie visualisiert den Systembus. Unterhalb des 
Systembusses werden die Prozess-Stationen dargestellt, oberhalb des Busses – 
neben dem Konfigurations-PC – die konfigurierten Leit- und Gateway-Stationen.

Die Projekt-Hardware wird folgendermaßen konfiguriert:

• Wählen Sie aus der Baumstruktur ein Objekt aus und klicken Sie dann im 
Menü Bearbeiten auf Einfügen....

oder

• Wählen Sie aus der Baumstruktur ein Objekt aus und klicken Sie dann im 
Kontextmenü auf Einfügen....

oder

• Wählen Sie einen freien Platz in der Grafikansicht aus (Auswahl wird durch 
einen roten gestrichelten Rahmen angezeigt) und doppelklicken Sie mit der 
linken Maustaste.

In dem folgenden Dialog werden die Objekte aufgelistet, die in der gewählten 
Position eingefügt werden können.
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Fügen Sie nun entsprechend der verfügbaren Hardware eine Prozess-Station ein.

Zur Integration der Hardware- und Software-Komponenten des Projekts wählen Sie 
dann die entsprechende Hardware aus und klicken im Menü Bearbeiten auf 
Zuordnung einer Ressource....

Wählen Sie nun die Prozess-Station und weisen Sie im Projektbaum die Ressource 
„PS” zu.

Mit dem Dialog zur Netzwerk-Konfiguration (Menü: Hardware-Struktur > 
Netzwerk) werden die Ressource-IDs und IP-Adressen der Stationen definiert. 
Wählen Sie die Prozess-Station aus und klicken Sie auf Bearbeiten. Geben Sie für 
Ihre Station eine eindeutige Ressource-ID und die IP-Adresse ein. Beenden Sie die 
Netzwerkeinstellung mit OK.

Normalerweise ist es nicht erforderlich, die voreingestellten Boot-Parameter der 
Prozess-Station zu ändern. Wenn Sie sie dennoch ändern wollen, wählen Sie die 
entsprechende Prozess-Station im Hardwaremanager aus. Wählen Sie dann 
Bearbeiten > Parameter.... Die Boot-Parameter der Prozess-Station lassen sich 
nun bearbeiten. Schließen Sie danach den Hardware-Parameter-Dialog. 

Um die Plausibilität der Hardware-Konfiguration zu prüfen, wählen Sie Hardware-
Struktur > Alles plausibilisieren. Die Fehlerliste der Plausibilisierung sollte 
keine Fehler enthalten.

Speichern Sie nun Ihre Änderungen mit Hardware-Struktur > Speichern und 
schließen Sie den Hardwaremanager mit Hardware-Struktur > Beenden. 

Selektieren Sie den obersten Knoten des Projektbaums und plausibilisieren Sie alle 
Projektdaten. Mit dem Menüpunkt Projekt > Alles plausibilisieren werden alle 
Objekte überprüft, die unterhalb des selektierten Knotens existieren; mit dem 
Menüpunkt Projekt > Plausibilisieren werden nur die Objekte überprüft, die mit 
einem rosa Knoten angezeigt werden.

3. Schritt: Schritt: Inbetriebnahme
Wenn alle Fehler, die ggf. beim Plausibilisieren gemeldet wurden, beseitigt wurden, 
kann das Projekt in Betrieb genommen werden. Wechseln Sie von der Konfiguration 
in den Inbetriebnahme-Modus über Projekt > Inbetriebnahme.
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Beim Wechsel in den Inbetriebnahme-Modus versucht der Control Builder F, zu 
allen konfigurierten Stationen eine Kommunikationsverbindung herzustellen. Im 
Projektbaum werden neben den Ressource-Knoten die aktuellen Zustände der 
Verbindungen angezeigt.

Bei einem neu installierten System wurde während der Installation das Boot-
EPROM in die Prozess-Station geladen. Wenn IP-Adressen und Subnetzmasken 
korrekt konfiguriert wurden, wird der Projektbaum-Knoten der Prozess-Station mit 
„kein Betriebssystem“ gekennzeichnet. Weitere Zustände können sein:

• „läuft“: Betriebssystem oder Konfiguration wurde geladen

• „Versionsfehler“: Die Konfiguration in der Prozess-Station gehört entweder 
zu einem anderen Projekt oder ist veraltet.

• „Falsche DMS-Version“: Die Version der Kommunikationssoftware in der 
Prozess-Station entspricht nicht der Version des Control Builder F. Mit dem 
Konfigurationstool „Configure“ muss zuerst das aktuelle Boot-EPROM in die 
Prozess-Station geladen werden.

Mit einem Pfeil vor dem Knoten wird angezeigt, dass die Daten dieses Knotens 
noch nicht auf der zugehörigen Hardware vorhanden sind und noch geladen werden 
müssen.

Wählen Sie den Ressource-Knoten der Prozess-Station und öffnen Sie das Kontext-
Menü. Bei der Erstinbetriebnahme wählen Sie dann Laden > Ganze Station. 
Änderungen und Erweiterungen der Konfiguration können nachträglich mit Laden 
> Geänderte Objekte in die Prozess-Station geladen werden.

Wurde der Ladevorgang erfolgreich durchgeführt, werden die Projektbaum-Knoten 
grün dargestellt und die Ladepfeile entfernt.

4. Test der Konfiguration
Im Inbetriebnahmemodus gibt es im Control Builder F verschiedene Möglichkeiten, 
um die aktuelle Projekt-Konfiguration zu testen und zu überprüfen. Wählen Sie ein 
Objekt an und öffnen Sie es mit einem Doppelklick. Wie in der Konfiguration wird 
der zugehörige Editor geöffnet. Konfigurationsänderungen können hier nicht 
vorgenommen werden, aber die aktuellen Werte können kontrolliert und teilweise 
beeinflusst werden.
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AWL-Programm

Wurde ein AWL-Programm in eine Prozess-Station geladen und wird es dort 
ausgeführt, kann im Inbetriebnahme-Modus des Control Builder F der AWL-Editor 
geöffnet werden. Vor der Kommentar-Spalte werden die aktuellen Werte der 
Variablen für jeden Rechenschritt angezeigt. Boolsche Variablen werden mit F für 
FALSE und T für TRUE dargestellt.

FBS-Programm

Wurde ein FBS-Programm in eine Prozess-Station geladen und wird dort 
ausgeführt, so kann im Inbetriebnahme-Modus des Control Builder F der FBS-
Editor geöffnet werden. An den Verbindungslinien kann der aktuelle Wert abgelesen 
werden.

Linien für Daten des Datentyps BOOL werden für den Wert TRUE durchgezogen 
und für den Wert FALSE gestrichelt gezeichnet.

Alle anderen Linien können mit dem Cursor angefahren werden. Der aktuelle Wert 
wird als Data-Tipp eingeblendet.

Ebenso werden die aktuellen Werte eines Bausteinpins beim Anfahren mit dem 
Cursor eingeblendet.

Wertefenster

Für die dauerhafte Anzeige eines Wertes kann das Wertefenster verwendet werden. 
Ein weiteres Fenster wird angezeigt. Um das Wertefenster aufzurufen, wählen Sie 
Fenster > Wertefenster anzeigen.

Nachdem eine Variable, eine Datenflusslinie oder ein Bausteinpin in einem Editor 
oder einer Liste angewählt wurde, kann im Kontextmenü oder im Menü Fenster der 
Menüpunkt Variable eintragen... gewählt werden. In einem weiteren Dialog wird 
das Format zur Darstellung des Wertes gewählt. Nach Bestätigung dieses Dialogs 
erscheint diese Variable im Wertefenster. Der angezeigte Wert wird einmal pro 
Sekunde aktualisiert.
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5. Schritt: Sichern der Projektdaten
Die Control Builder F Projektdaten können als Binärdatei (Control Builder F 
Projektdatei, PRO) oder als Textdatei (Werte durch Kommata getrennt, CSV) 
gespeichert werden. Standardmäßig werden die Daten in einer Binärdatei abgelegt. 
Für den Datenaustausch kann ein Projekt auch als CSV-Datei exportiert werden.

Gehen Sie folgendermaßen vor, um ein Projekt zu speichern:

• In der Projektübersicht: Projekt > Speichern

• Im Projektbaum: Projekt > Speichern

Um ein Projekt zu exportieren, gehen Sie folgendermaßen vor:

• In der Projektübersicht: Projekt > Export...
 Geben Sie dann einen Dateinamen für die CSV-Datei ein.

Das Archivieren und Exportieren von Projekten bietet zusätzliche Möglichkeiten 
zur Datensicherung und -wiederherstellung. Darüber hinaus benötigen Sie die 
Exportdateien auch bei einem Upgrade auf eine höhere Software-Version.

6. Schritt: Konfiguration einer Leitstation
Auf einem PC, der über ein Netzwerk an den Control Builder F-PC angeschlossen 
ist, muss die DigiVis-Software installiert werden. Die DigiVis-Software kann auch 
mit der Control Builder F-Software zusammen auf dem selben PC eingesetzt 
werden.

Um im Control Builder F eine Leitstation anzulegen, wechseln Sie zunächst in den 
Bearbeitungsmodus Konfiguration und dort in die Projektbaum-Ansicht. 
Selektieren Sie den Knoten der Prozess-Station. Mit Bearbeiten > Einfügen 
drunter erhalten Sie die Liste der möglichen Ressource-Typen. Wählen Sie 
Leitstation D-LS und vergeben Sie einen Namen.

Wechseln Sie in die Hardware-Struktur und selektieren Sie den obersten Knoten im 
Baum. Mit Bearbeiten > Einfügen erhalten Sie die Liste der möglichen Ressource-
Typen. Wählen Sie VIS Leitstation und klicken Sie auf OK. Geben Sie einen 
Namen und den Installationsort der neuen Hardware ein. Die vorgegebenen Werte 
können mit dem OK-Button übernommen werden.
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Selektieren Sie die neue Ressource in der Baumansicht oder Grafikansicht. Wählen 
Sie dann Bearbeiten > Zuordnung einer Ressource.... Selektieren Sie die vorher 
definierte Software-Ressource und ordnen Sie sie der Hardware zu.

Wie bei der Prozess-Station, müssen für die Leitstation IP-Adresse oder Hostname 
und Ressource-ID konfiguriert werden. Geben Sie in dem Dialog Hardware-
Struktur > Netzwerk die IP-Adresse oder den Hostnamen und die Ressource-ID 
ein, unter der Sie die DigiVis-Software installiert haben. Bestätigen Sie Ihre 
Änderungen mit OK.

Plausibilisieren Sie dann die Hardware. Selektieren Sie dazu den obersten Knoten 
im Projektbaum und wählen Sie Hardware-Struktur > Plausibilisieren.

Speichern Sie Ihre Änderungen und beenden Sie den Hardwaremanager. Wieder in 
der Projektbaum-Ansicht, selektieren Sie den obersten Knoten des Projektbaums 
und plausibilisieren Sie die Projektdaten mit Projekt > Plausibilisieren.

7. Schritt: Inbetriebnahme der Leitstation
Wenn alle Fehler, die ggf. durch das Plausibilisieren gemeldet wurden, beseitigt 
wurden, kann das Projekt in Betrieb genommen werden. Wechseln Sie von der 
Konfiguration in den Inbetriebnahmemodus über Projekt > Inbetriebnahme.

Im Projektbaum werden neben den Ressource-Knoten die aktuellen Zustände der 
Verbindungen angezeigt. Falls dies noch nicht geschehen ist, starten Sie auf dem PC 
der Leitstation das Bedienprogramm DigiVis. 

Die Prozess-Station sollte mit dem Verbindungsstatus läuft, die Leitstation mit 
Versionsfehler gekennzeichnet sein. Wenn die DigiVis-Software noch nicht läuft 
oder über das Netzwerk kein Zugriff möglich ist, wird für die Leitstation Keine 
Verbindung gemeldet.

Wählen sie den Knoten der Prozess-Station und Laden > geänderte Objekte; 
selektieren Sie anschließend den Knoten der Leitstation und wählen Laden > 
Ganze Station.

Wechseln Sie zu der Leitstation mit der laufenden DigiVis-Software. Wählen Sie im 
Menü Bild > Einblendbilder. Die MSR-Stellenliste erscheint In einer Liste wird 
der Name des Bausteins M_ANA angezeigt. Nach Anwahl des Namens wird das 
Einblendbild dieses Baustein angezeigt.
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In dem Einblendbild M_ANA werden die steigenden und fallenden Werte mit einem 
grünen Balken dargestellt (Sägezahnkurve). Alarme werden in der Meldeliste! 
aufgelistet, zusammen mit ihrem aktuellen Zeitstempel bei Erreichen der definierten 
Grenzwerte.

Damit haben Sie die ersten Schritte bei der Bedienung von Freelance erfolgreich 
gemeistert. Sie haben gelernt, wie man ein einfaches Programm schreibt und auf 
einer Prozess-Station ausführt, dessen Status visualisiert und Alarme anzeigen lässt. 
Weiterhin viel Erfolg.

8. Schritt: Mit Tag-Typen und OPC-Elementen arbeiten
Diesen Schritt müssen nur diejenigen Benutzer ausführen, die in ihrem Projekt 
MSR-Stellenarten und OPC-Elemente anlegen und verwenden wollen.

Tag Typ-Bibliothek anlegen

(1) Legen Sie im Projektbaum unter KONF einen Knoten namens TagType_Lib 
(TAG-LIB) an.

(2) Importieren Sie die Beispiel-Bibliothek Tag Type Library.

Die Bibliothek Tag_Type_Li00 wird im Projektbaum unter dem Knoten POOL 
erstellt. Verschieben Sie sie im Projektbaum unter den Knoten TagType_Lib. Nun 
können Sie die Bibliothek in Ihrem Projekt verwenden.

Alternativ können Sie auch 

Ihre eigene MSR-Stellenarten-Bibliothek anlegen.

Bearbeiten > Block importieren
Nach der Datei C:\Programmdateien\ABB Industrial 
IT\Freelance\export\FreelanceSampleTagTypeLib_V1.0.prt
 durchsuchen 
Auf Öffnen klicken

Falls dies noch nicht geschehen ist, installieren Sie den OPC-Tunnel auf dem 
gleichen Rechner, wo bereits der OPC-Server installiert ist. Aktivieren Sie dann 
bei der Freelance-Installation im Fenster „Arbeitsstationstyp” die Option ABB 
OPC Tunnel Server. 
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OPC-Tunnel konfigurieren

• Rufen Sie den OPC-Tunnel-Konfigurator auf. 

• Geben Sie die PROG-IDs der DA/AE-Server und die Port-Nummer des 
Dienstes an. Das nachstehende Bild zeigt die Standardeinstellungen. 

• Sie können die Standardeinstellungen unverändert verwenden oder sie bei 
Bedarf ändern.

• Die letzten beiden Stellen der PROG-ID bilden die eindeutige Ressource-ID, 
die dem OPC-Server zugeordnet ist.

OPCTunnel_configurator gr.bmp

OPC-Server im CBF konfigurieren

Geben Sie die IP-Adresse des Rechners ein, auf dem der OPC-Tunnel installiert ist. 
Die Port-Nummer ist identisch mit der, die für die OPC-Tunnelkonfiguration 
verwendet worden ist (9950). 

Projektbaum  > Rechtsklick auf KONF  > Nächste Ebene einfügen > OPC 
Server OPC-S  wählen > auf OK klicken. 

Der Konfigurationsdialog wird angezeigt.

Geben Sie einen Namen (z. B. OPC1) ein und den Ort, wo der OPC-Server 
ausgeführt wird.
Doppelklicken Sie auf den Knoten OPCS.
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OPC_First_Steps_OPC_Config gr.bmp
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Durchsuchen und Elemente zur OPC-Itemliste hinzufügen

OPC_First_Steps_OPC_Item_List gr.bmp

Öffnen Sie die OPC Itemliste und klicken Sie auf Synchronisieren. Wählen Sie 
aus der Liste den gewünschten OPC-Server aus und klicken Sie dann auf OK. Alle 
OPC-Elemente vom OPC-Server werden in die OPC-Itemliste kopiert.

Projektbaum > System > OPC-Itemliste
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First_Steps_Synchronize gr.bmp

Die OPC-Itemliste wird also mit Elementen vom OPC-Server gefüllt.

OPCitem_browsed gr.bmp
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MSR-Stellen instanziieren 

Über die Schaltfläche Alle instanziieren in der OPC-Elementliste können Sie MSR-
Stellen instanziieren. Auf diese Weise werden die OPC-Elemente (der “Selektor-
Teil” des OPC-Elementnamens hinter dem Separator) in der Elementliste mit denen 
in der MSR-Stellenbibliothek abgeglichen und die MSR-Stellen entsprechend der 
MSR-Stellenarten aufgelistet. Die MSR-Stellenliste mit den vorgeschlagenen MSR-
Stellennamen wird in dem unten dargestellten Umbenennen-Dialog angezeigt.

OPC_Server_Rename gr.bmp

Geben Sie in die Spalte Neuer Name die MSR-Stellennamen für die OPC-Elemente 
ein und klicken Sie auf OK. In der MSR-Stellenliste erscheinen die Namen der 
MSR-Stellen, die mit den entsprechenden OPC-Elementen verknüpft sind.

Variablen zuordnen

Wählen Sie diejenigen OPC-Elemente, die in freien Grafiken oder 
Trenddarstellungen verwendet werden sollen, aus der OPC-Elementliste aus und 
ordnen Sie ihnen Variablen zu. Es erscheint ein neues Fenster mit Vorschlägen für 
die Variablennamen der OPC-Elemente (siehe nachstehende Abbildung).



Kapitel 3  Erste Schritte 8. Schritt: Mit Tag-Typen und OPC-Elementen arbeiten

3BDD012560R0503_Getting_Started 119

 

3BDD012560R0503_Getting_Started 119

E
ng

lis
h

D
eu

ts
ch

OPC_Items_Assign_Variable gr.bmp

Geben Sie in die Spalte Neuer Name den erforderlichen Variablennamen ein und 
klicken Sie auf OK. Allen OPC-Elementen mit dem angegebenen Namen werden 
Variablen in der Variablenliste zugeordnet.

Sie können nun mit Hilfe der MSR-Stellen und Variablen, die Sie wie oben 
beschrieben angelegt haben, freie Grafiken und Trenddarstellungen konfigurieren.
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